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Introduction

This section provides the general information for the Teledyne Paradise Datacom line of controllers. While previous models
of the controllers were specifically built to handle a certain type of system, the new system controllers with the touchscreen
display can be configured to handle a variety of system types without the need for special hardware modifications.

Legacy controllers include:

• RCP2-1100 for 1:1 redundant systems;
• RCP2-1200 for 1:2 redundant systems;
• FPRC-1100 for 1:1 phase combined systems;
• FPRC-1200 for 1:2 phase combined systems;
• RCP2-SWITCH for use as a maintenance switch controller;
• RCP2-1000-CO as a remote control panel for a remote Compact Outdoor SSPA.

All of the configurations listed above may now be controlled by the system controller with touchscreen. Any mention of RCP,
FPRC or RCP2 throughout this manual refers to the new line of system controllers with touchscreen display.

This section describes the supplied equipment and safety precautions.



Description

The controller is used to monitor and control amplifiers configured in 1:1 and 1:2 redundant systems, 1:1 and 1:2 phase
combined systems, as a maintenance switch controller, or as a remote control panel for a single remote amplifier. The
controller can be configured provide control of one, two, or three amplifiers and any corresponding transfer switch.

  Note: The RCP2-1000-CO is programmed with a different firmware set than the other controllers. It can
only act as a RCP2-1000-CO remote control panel.

The controller can be used in LNA, LNB, and SSPA systems as well as frequency converter systems. A RF Signal Path
Display on the front panel indicates the RF path and the fault status of the equipment. User interface and control is provided
in several forms:

• Front panel, local control via touchscreen
• 37-pin parallel control port with contact closures and opto-isolated inputs
• Serial data control via RS232 or RS485 (2 or 4-wire)
• 10/100 Base-T Ethernet interface. Ethernet control options include embedded web page, SNMP interface and

propriety IP interface to connect over Paradise Universal M&C software

Additional features include:

• User-friendly front panel touchscreen display for local monitor & control;
• Universal input, power factor corrected power supply;
• Dual AC mains entries with removable power supplies.



Equipment Supplied

The following equipment is supplied with each unit:

• System Controller
• (2) IEC Line Cord Sets

Optional equipment includes:

• Rack Slides
• 100 ft. (30 m ) Control Cable
• Switch Plate Mating Connector
• DC Operation



Specifications

Refer to the specification sheet for complete specifications on the RCP2/FPRC Redundant System Controllers.

Outline Drawing

Figure 1 shows an outline drawing of an redundant controller.

Figure 1: Outline Drawing, Typical Redundant System Controller Unit

The system controller is also available with 24/48VDC input, or with a high output power option (-HP), both of which have
removable power supply assemblies of the respective type.
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Safety Considerations

Potential safety hazards exist unless proper precautions are observed when working with this unit. To ensure safe operation,
the user must follow the information, cautions and warnings provided in this manual as well as the warning labels placed on
the unit.

High Voltage Hazards

High Voltage for the purpose of this section is any voltage in excess of 30 volts. Voltages above this value can be hazardous
and even lethal under certain circumstances. Care should be taken when working with devices that operate at high voltage.

  All probes and tools that contact the equipment should be properly insulated to prevent the operator
from coming in contact with the voltage.

  The work area should be secure and free from non-essential items.

  Operators should never work alone on high voltage devices. There should always be another person
present in the same work area to assist in the event of an emergency.

  Operators should be familiar with procedures to employ in the event of an emergency, i.e., remove all
power, CPR, etc.

  An AC powered unit will have 115 VAC or 230 VAC entering through the AC power connector. Caution is
required when working near this connector, the AC circuit breaker, or the internal power supply.

High Current Hazards

Many high power devices are capable of producing large surges of current. This is true at all voltages, but needs to be
emphasized for low voltage devices. Low voltage devices provide security from high voltage hazards, but also require higher
current to provide the same power. High current can cause injury from burns and explosion. The following precautions should
be taken on devices capable of discharging high current:

  Remove all conductive personal items (rings, watches, medals, etc.)

  The work area should be secure and free of non-essential items.

  Wear safety glasses and protective clothing.

  Operators should never work alone on high risk devices. There should always be another person present
in the work area to assist in the event of an emergency.



  Operators should be familiar with procedures to employ in the event of an emergency, i.e., remove all
power, CPR, etc.

Electrical Discharge Hazards

A spark can not only create ESD reliability problems, it can also cause serious safety hazards. The following precautions
should be taken when there is risk of electrical discharge:

  Follow all ESD guidelines

  Remove all flammable material and solvents from the area.

  All probes and tools that contact the equipment should be properly insulated to prevent electrical
discharge.

  The work area should be secure and free from non-essential items.

  Operators should never work alone on hazardous equipment. There should always be another person
present in the same work area to assist in the event of an emergency.

  Operators should be familiar with procedures to employ in the event of an emergency, i.e., remove all
power, CPR, etc.

Keep in mind that ground potential on both ends of long cable runs may be significantly different due to various factors.
These ground potentials equalized by a cable ground signal line. Hence, it always a good practice to make
connect/disconnect interface connectors when the equipment on both ends of a long cable run is powered down. This
practice will minimize risk of damage of electrical interfaces due to unbalanced ground potentials.
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Introduction

This section provides information for the initial inspection, installation, and external connections for the RCP controller.



Inspection

When the unit is received, an initial inspection should be completed. First ensure that the shipping container is not damaged.
If it is, have a representative from the shipping company present when the container is opened. Perform a visual inspection
of the equipment to make sure that all items on the packing list are enclosed. If any damage has occurred or if items are
missing, contact:

Teledyne Paradise Datacom
11361 Sunrise Park Drive
Rancho Cordova, CA 95742 USA
Phone: +1 (814) 238-3450



Mounting

The Teledyne Paradise Datacom RCP controller is designed to be mounted in a standard EIA 19 inch equipment rack. The
depth of the chassis, excluding rear panel connectors, is 13.19 inches (335 mm). The height of the chassis is 1.7 inches (44
mm) or 1 rack unit.

Optional 22 inch (559 mm) rack slides with extensions are available.



Storage and Shipment

To protect the controller during storage or shipping, use high quality commercial packing methods. Reliable commercial
packing and shipping companies have the facilities and materials to adequately repack the equipment.



Cable Connections

The controller has a wide range of I/O interconnections available at the rear panel. The controller rear panel is shown in
Figure 1.

Figure 1: Rear Panel, System Controller

Control Cable Connector (J3) - MS3112E16-23S

The primary connection between the controller and the LNA/LNB (Low Noise Amplifier/Low Noise Block Converter) switch
plate or SSPA (Solid State Power Amplifier) switch assembly is through J3. The connector is a 23-pin circular connector, type
MS3112E16-23S (See Figure 2 and Table 1). For external waveguide switches, a standard 100 ft. (30m) cable, L201061
should be used.

Figure 2: Control Cable Connector (J3)

Table 1: Switch Connector (J3) Pin-Outs

Pin Description

L Power Supply #1; +13-17 VDC, 900mA; or, +24V, 1.5A (-HP version only)

J Power Supply #2 +13-17 VDC, 900mA; or, +24V, 1.5A (-HP version only)

G Power Supply #3 +13-17 VDC, 900mA; or +24V, 1.5A (-HP version only)

E Switch Common, +26 VDC, 5A max

B AMP Support GND

D Switch Common, +26 VDC, 5A max

W Switch #1, Position 1 (Tx) (primary)

U Switch #1, Position 1 (Tx)

P Switch #1, Position 2 (Tx)

S Switch #1, Position 2 (Tx) (primary)

F Switch Common, +26 VDC, 5A max

H Switch Common, +26 VDC, 5A max

T Switch #2, Position 1 (Rx)

V Switch #2, Position 1 (Rx) (primary)

N Switch #2, Position 2 (Rx)

R Switch #2, Position 2 (Rx) (primary)

A AMP Support GND

C AMP Support GND

K Switch Common, +26 VDC, 5A max

M Switch Common, +26 VDC, 5A max
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  Note: The RCP2-1000-CO remote control panel does not require connection to this port.

Serial Port, Main (J4) - DB9 (F)

The main serial port is for connection with any host computer. This port contains both RS-232 and RS-485 communication in
half duplex. RS-485 interface is compatible with 2- or 4-wire interface connection. As an additional protection measure, this
port features full galvanic isolation from the chassis ground. For convenience, a set of Form C relay contacts are available at
this port as a Service Request. The Service Request is essentially a Summary Alarm for any system faults that occur. The
baud rate and other communication parameters are selectable via the front panel menu.

The pin-out is shown in Table 2. Note that the pin-out is standard DTE; a null modem is not required when connecting to a
standard PC serial port.

Table 2: Serial Port, Main (J4) Pin-Outs

Pin Description Notes

1 RS-485 TX+

2 RS-232 Out or RS-485 TX-

3 RS-232 In or RS-485 RX-

4 RS-485 RX+

5 Signal Ground

6 Service Request 1 Closed on Fault

8 Service Request 2 Open on Fault

7 Service Request Common Form C Common

9 Termination (120 Ohm) Connect to pin 4 to terminate unit on end of bus

Serial Port, Local (J5) - DB9 (M)

The local serial port is used to support special transceiver systems and remote control panels. The baud rate of this port is
fixed at 9600 Baud and cannot be changed. J5 is permanently configured for RS-485 half duplex communication. Table 3
details the local serial port pin-out. Port features full galvanic isolation from chassis ground.

Table 3: Serial Port, Local (J5) Pin-Outs

Pin Description Notes

1 RS-485 RX+

2 RS-485 RX-

3 RS-485 TX-

4 RS-485 TX+

5 Signal Ground

9 Termination (120 Ohm) Connect to pin 1 to terminate unit on end of bus

Service Port (J6) - Mini USB

A 5-contact Mini USB connector is used to provide flash re-programmability for the controller card. In order to reload
controller board firmware, connect this port to a standard PC USB port. See the Fault Analysis and Troubleshooting
section for a description of the firmware upgrade procedure.

Parallel I/O Connector (J7) - DB37 (F)

The controller has a full compliment of parallel monitor and control lines. A 37-pin D sub-style connector is used for the
parallel I/O signals, which are detailed in Table 4.



Table 4: Parallel I/O Port (J7) Pin-Outs

Identification Signal Pin Function Notes

Amp 1 Alarm Output 1 Closed on Fault Relay contacts: 30VDC @ 0.5A

Amp 1 Alarm Output 20 Common

Amp 1 Alarm Output 2 Open on Fault

Amp 2 Alarm Output 21 Closed on Fault Relay contacts: 30VDC @ 0.5A

Amp 2 Alarm Output 3 Common

Amp 2 Alarm Output 22 Open on Fault

Amp 3 Alarm Output 4 Closed on Fault

Amp 3 Alarm Output 23 Common

Amp 3 Alarm Output 5 Open on Fault

Auto/Manual Mode Output 24 Closed on Manual

Auto/Manual Mode Output 6 Common

Auto/Manual Mode Output 25 Closed on Auto

Local/Remote Mode Output 7 Closed on Local

Local/Remote Mode Output 26 Common

Local/Remote Mode Output 8 Closed on Remote

Switch #1 Position Output 27 Switch #1, Position 1

Switch #1 Position Output 9 Common

Switch #1 Position Output 28 Switch #1, Position 2

Switch #2 Position Output 10 Switch #2, Position 1

Switch #2 Position Output 29 Common

Switch #2 Position Output 11 Switch #2, Position 2

Power Supply #1 Alarm Output 30 Closed on Fault

Power Supply #1 Alarm Output 12 Common

Power Supply #1 Alarm Output 31 Open on Fault

Power Supply #2 Alarm Output 13 Closed on Fault

Power Supply #2 Alarm Output 32 Common

Power Supply #2 Alarm Output 14 Open on Fault

Priority Setting Output 33 Closed on Priority 2

Priority Setting Output 15 Common

Priority Setting Output 34 Closed on Priority 1

Fault Clear Input 37 Ground to Activate 5mA max current on all inputs

Priority Select Input 17 Ground to Activate Toggle Function

Auto/Manual Input 16 Ground to Activate Toggle Function; Alternate function: External Mute Input

Amp 3 Standby Input 36 Ground to Activate

Amp 2 Standby Input 35 Ground to Activate

Amp 1 Standby Input 18 Ground to Activate

Inputs Ground (isolated) Common 19

Ten Form-C relays are used for converter, switch position, and mode control. Each Form-C contact has a rating of 30 VDC @
0.5 A, 110 VDC @ 0.3 A, and 125 VAC @ 0.5 A. The inputs and ground pins are isolated from the rest of the unit's circuitry.
Inputs are activated by pulling it down to the isolated ground pin. In order to fully utilize the built-in inputs protection, it is
recommended to keep the input's ground isolated from the chassis ground.

See the External mode description in the Touchscreen Operation section for instructions on how to use the Auto/Manual
Input (Pin 16) as an External Mute Input.



  Note: The RCP2-1000-CO remote control panel does not require connection to this port.

External Alarm Port (J8) - DB9 (F)

An external alarm port is provided to allow maximum flexibility of configurations. This allows the user to interface with the
alarm output of other equipment into the controller. Inputs are protected against ESD of ±15 kV using the Human Body
model; against ESD of ±8kV using the Contact Discharge method specified in IEC1000-4-2; and against ESD of ±15 kV
using the Air Gap method described in IEC1000-4-2. Table 5 shows the external alarm pin-out.

Table 5: External Alarm Port (J8) Pin-Outs

Function Pin Notes

External Alarm 1 1 Closure to Ground, 5mA max short circuit current, 5 VDC open circuit voltage

External Alarm 2 2 Closure to Ground, 5mA max short circuit current, 5 VDC open circuit voltage

External Alarm 3 3 Closure to Ground, 5mA max short circuit current, 5 VDC open circuit voltage

Ground 4,8,9

Auxiliary Alarm 1 5 Closure to Ground, 5mA max short circuit current, 5 VDC open circuit voltage

Auxiliary Alarm 2 6 Closure to Ground, 5mA max short circuit current, 5 VDC open circuit voltage

Auxiliary Alarm 3 7 Closure to Ground, 5mA max short circuit current, 5 VDC open circuit voltage

  Note: The RCP2-1000-CO remote control panel does not require connection to this port.

Ethernet Port (J9) - RJ45 (F)

This is a RJ45 connector with integrated magnetics and LEDs. This port becomes the primary remote control interface when
the Interface option is selected to "IPNet" or SNMP interface as described in the Communication > Interface description of
the Touchscreen Operation section.

This feature allows the user to connect the controller to a 10/100 Base-T office Local Area Network and have full-featured
Monitor & Control functions through a web interface. See Table 6.

Table 6: Ethernet Port (J9) Pin-Outs

Pin Function

1 TX+

2 TX-

3 RX+

6 RX-

4,5,7,8 Ground

  Note: IP address, Gateway address, Subnet mask, IP port and IP Lock address need to be properly
selected prior to first use.

LED lamps on the connector indicate network status. A steady Green light indicates a valid Ethernet link; a flashing Yellow
LED indicates data transfer activity (on either the Transmit and Receive paths). Starting with firmware version 6.00, the
controller can support multiple remote control interfaces. See the Remote Control Interface section for details.



Prime Power Connection (J1, J2)

Two separate removable power supplies are provided for fully redundant operation. Either of the two supplies is capable of
operating the system and its associated switches. Two AC power connectors are provided on the rear panel (J1,J2).



Removable Power Supply Modules

The unit has a redundant power supply array consisting of two modules. A failed power supply module may be removed from
the chassis by loosening the two captured thumbscrews and sliding the module out of the chassis, then unplugging the
quick-disconnect power pole connectors.

24V Power Supply Module

Figure 3 shows an outline drawing of a power supply module.

Figure 3: Outline Drawing, 24V Power Supply Module

The following list comprises the specifications for the standard power supply module:

Plug: IEC, 250V, 10A, Male plug with wire-form AC Cable Clamp
Fuse: 2 Amp 5x20mm
Power Supply: 85-264 V input, 28V output, 175W
Connector to chassis: Quick-connect Power pole

See the Fault Analysis and Troubleshooting section for directions on identifying and replacing a failed power supply
module.

24V Power Supply Module, High Power option

Figure 4 shows an outline drawing of a power supply module for units utilizing the High Power (-HP) option.
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Figure 4: Outline Drawing, -HP Option Power Supply Module

The following list comprises the specifications for the -HP option power supply module:

Plug: IEC, 250V, 10A, Male plug
Fuse: 2 Amp 5x20mm
Power Supply: 85-264 V input, 28V output, 175W
Fan: 40mm, 24V, 4.9 CFM
Connector to chassis: Quick-connect Power pole

See the Fault Analysis and Troubleshooting section for directions on identifying and replacing a failed power supply
module.

48V Power Supply Module

Figure 5 shows an outline drawing of a 48V power supply module.

Figure 5: Outline Drawing, 48V Power Supply Module

The following list comprises the specifications for the 48V power supply module:

Plug: MS3112E10-6P Circular MIL connector, 6-pin (MS3116F10-6S mating)
Circuit Breaker: 6 Amp
Power Supply: 48V, 150W
Connector to chassis: Quick-connect Power pole

See the Fault Analysis and Troubleshooting section for directions on identifying and replacing a failed power supply
module.
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Design Philosophy

The redundant controller was designed to achieve a new level in high reliability, maintenance free operation. A tightly
integrated modular assembly approach has been used to realize an extremely versatile controller while maintaining its user
friendly operator interface. Four basic building blocks are combined in the redundant system controller:

1. Redundant Power Supplies
2. Digital Core Board Assembly
3. I/O Board Assembly
4. Touchscreen Display

Redundant Power Supplies

A block diagram of the controller is shown in Figure 6. Two power supplies are provided in the controller. These supplies can
be connected to two independent AC sources for absolute system redundancy. Either supply is capable of operating the
controller and its associated transfer switches. Both power supplies have universal input capability operating over an input
voltage range of 85 to 265 VAC and line frequencies of 47 to 63 Hz. The power supplies have a power factor of 0.93
ensuring minimum line harmonic products. Each power supply produces +26 VDC.

Figure 6: Block Diagram, Power Supply Configuration

The controller provides three channel power outputs for connecting external LNA/LNB units. In standard configuration, each
LNA/LNB channel can be selected to supply 13V or 17V with up to 900 mA DC current output. Output voltage is user-
selectable either from the front panel menu or over the remote control interface. The -HP model provides an additional 24V
1500 mA output option for use with higher power external equipment.

All channels are protected from overload and will reduce output if the maximum power output capacity is exceeded by an
external load.

  Note for 24V 1500 mA channel output: In order to provide an equal load to both internal AC/DC supplies,
channels derive their power asymmetrically: Channel 1 from PS2, Channel 3 from PS1; and Channel 2 from
either PS2 or PS1. See Figure 6. This configuration allows default standby Channel 2 to power up in case
one of the AC/DC power supplies fails. In order to conserve power from the remaining power supply, the
LNA/LNB channel will reduce its power output to 13V, 900 mA.

Digital Core Board
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The Digital Core Board is operated by a microcontroller unit. All digital I/O lines feature transient absorbing devices and a
ground isolated barrier for extra protection. The power supply lines are protected by current limiting devices. The digital core
board also contains a USB port that allows the controller to be firmware upgradeable in the field.

I/O Board Assembly

The I/O Board Assembly contains the primary parallel (hardware) interface circuitry of the controller. It is physically attached
to the Digital Core Board by a 40-pin header. The I/O Board provides user selectable output voltage: +13, 17 and 24 VDC
supply output for the LNB units.

Each output on a standard unit can supply continuously up to 0.9A and up to 1.5A in peak current. The -HP version can
supply 1.5A continuously. All channels are short circuit protected. The 10 Form C relays and opto isolated inputs for the
parallel I/O interface are included on this board assembly. A series of rugged N-channel enhancement mode MOSFET
devices provide the current sink circuitry to drive either one or two waveguide transfer switches.

Touchscreen Display

Rarely found in redundant controllers, the controller provides a large full-color touchscreen panel. This provides an extremely
user friendly interface. The touchscreen is directly interfaced to the microcontroller via the address and data bus. Virtually all
of the controller's setup and adjustments are accessible from the touchscreen. There is no need to access the interior of the
controller to make any setup changes.

The touchscreen may be configured as a redundant system controller (1:1 or 1:2), as a phase combined controller (1:1 fixed
phase combined or 1:2 phase combined), or as a maintenance switch. A great deal of human engineering has gone into the
design of this membrane panel. A full complement of alarm indicators are provided along with the mimic display which shows
the switch positions of the redundant system. An intuitive menu structure allows the user to easily set the operating
parameters, and monitor and control the connected system. Separate Action Buttons have been provided for frequently used
functions, further enhancing the controller's ease of use. See the Touchscreen Operation section.



Control Cable Considerations

The redundant controller is designed to drive negative 28 VDC latching style transfer switches. Latching means that the
switch has a self cutoff and does not require continuous current consumption. Some commonly used waveguide transfer
switches used in Teledyne Paradise Datacom Redundant Systems are given in Table 7.

Table 7: Commonly Used Waveguide Transfer Switches

Part Number Description Manufacturer Voltage Range Current

75SBOS 10.7-14.5 GHz (Waveguide/Coax) Sector -20 to -30 VDC 0.80 Amps

3NBGS 5.8-6.4 GHz (Waveguide/Coax) Sector -20 to -30 VDC 2 Amps

2SBGS 3.7-4.2 GHz (Waveguide/Coax) Sector -20 to -30 VDC 3 Amps

4BF 1.7-2.6 GHz (Waveguide) Sector -20 to -30 VDC 4 Amps

As Table 7 shows, the switch drive current is dependent on the frequency band which determines the physical size of the
switch motor. Therefore the system designer must consider the resistive cable losses when choosing a control cable length.

Similarly, the system designer must ensure use of the proper cable insulation for the particular installation. Teledyne
Paradise Datacom uses both standard service and burial grade for redundant system control cables. Standard service cable
has a PVC jacket which is ultra violet ray (UV) stable in outdoor use. However, standard service cable should not be
immersed in water or be buried underground for long periods of time. For such applications, burial grade cable should be
installed.

The controller sources a maximum +26 VDC @ 5 Amps to the transfer switch. A typical -28 VDC waveguide switch will
operate over a range of -20 to -30 volts. Therefore, the minimum voltage required at the waveguide switch is -20 VDC. Using
this as a design guideline, the control cable should be sized so that it does not drop more than 6 VDC from the controller to
the switch.

Teledyne Paradise Datacom control cables utilize 20 conductors of #18 AWG stranded wire. The control cable schematic is
shown in Figure 7. The resistance of #18 AWG stranded wire is 6.5 ohms per 1000 feet. The controller switch connector (J3)
allows contacts for two wires per switch connection. Therefore, two conductors can be paralleled for both the source and
return lines for the transfer switch. With a maximum allowable voltage drop of 6 volts, this equates to a 3 volt drop in the
source wires and 3 volt drop in the return wires. This is shown schematically in Figure 7. Using four (4) parallel #18 AWG
conductors gives a resultant cable resistance of 1.6 ohms per 1000 feet, or 0.0016 ohms per foot.

Figure 7: Cable Losses to Transfer Switch

To calculate the maximum cable length that can be accommodated to the transfer switch, first consider the current draw by
the switch either from the manufacturer's data or from Table 7. Next divide this current into 6 volts. This gives the maximum
cable resistance to and from the switch. Finally, divide this cable resistance by 0.0016 ohms/ft. to find the maximum cable
length. This is shown in the following example:

Switch Current draw = 3 Amps
6 V / 3 Amps = 2 ohms (maximum cable resistance)
2 ohms/0.0016 ohms/ft. = 1250 ft.;
maximum cable length using (4) #18 AWG connectors

Table 8 gives the maximum cable length for some popular switches.
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Table 8: Maximum Cable Length for Selected Switches (Single Switch Systems)

Part Number Description Manufacturer Maximum Cable Length

75SBOS 10.7-14.5 GHz (Waveguide/Coax) Sector 4,690 ft. (1,430 m)

3NBGS 5.8-6.4 GHz (Waveguide/Coax) Sector 1,880 ft. (572 m)

2SBGS 3.7-4.2 GHz (Waveguide/Coax) Sector 1,250 ft. (381 m)

4BF 1.7-2.6 GHz (Waveguide) Sector 938 ft. (286 m)
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Introduction

All versions of the system controller are available with a front panel touchscreen, from which the user can control the
connected amplifier system, and obtain information about the operational status of the connected amplifiers.

There are four main areas on the touchscreen display, as shown in Figure 1:

• Menu [1]

• Fault Indicators [2]

• RF Signal Path Display [3]

• Action Buttons [4]

Figure 1: Main Areas of the Touchscreen Front Panel

Menu

This area is where all menu selections are made. See the Local (Front Panel) Menu Structure section below for a
complete description of the menu selections.

Fault Indicators

Up to five fault indicators are shown in the left-most section of the touchscreen display. The Summary fault indicator is
always displayed at the top. The user can select up to four other fault indicators to be displayed. See the Config Faults
section.

By default, in addition to the Summary fault indicator, the following fault indicators are shown:

• Unit 1
• Unit 2
• Unit 3
• Power Supply

If the fault indicator is green, it means there is no fault present for that fault parameter. If the fault indicator is flashing red, a
fault exists for that fault parameter. If the fault indicator is yellow, a communication error with the module exists.

If the System Mode is set to either 1:1 Controller, 1:1 Ph. Comb., or Dual 1:1 mode, the Unit 3 indicator will be black. If the
System Mode is set to Maint. Mode, all three Unit n indicators will be black.

Depending on fault settings, the presence of certain types of faults will also trigger a Summary fault.

RF Signal Path Display

To the right of the fault indicators is the RF Signal Path Display of the selected system type. The display shows the online
and standby units in the system, as well as the switch positions. A dotted green line shows the signal path. Figure 2 shows
an example of a 1:1 Redundant System, with Unit 1 online and Unit 2 on standby.

Figure 2: RF Signal Path Display
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There is a secondary screen available by tapping the indicator (as shown in Figure 3) at the top-right of the RF Signal Path
Display screen. Tapping this indicator opens a screen in the Menu area of the display. This screen shows information (RF
power, DC current and temperature) about the individual units in the system, as well as the RF Power, reflected power (if
enabled) and temperature of the system.

Figure 3: Secondary Menu, Unit/System Information

Tap the indicator at the top-right of the screen to return to the RF Signal Path Display.

Give Away Online Status

The user can tap the outline of the online unit to give away its online status to the standby unit in the system. A confirmation
window will appear. Tap the "OK" button to confirm the state change, or the "Cancel" button to cancel the action. See Figure
4.

Figure 4: Online State Change Confirmation Window

If the online state change was confirmed, the amplifier will display the "Standby" state, and the RF signal path and switch
positions will change to show the RF signal path of the online amplifier. See Figure 5.

Figure 5: New RF Signal Path Display After Online State Change

Note that tapping the outline of an amplifier displaying the "Standby" state will not do anything. Only an amplifier with the
"Online" state can give away its online status.

Action Buttons

Up to two action buttons may appear to the far right of the touchscreen. These buttons are typically used to trigger common
functions without having to navigate through the menu structure.

By default, the Control Mode button is on top, and the Switch Mode button is on the bottom. See Figure 6. The button
selection may be customized by the user. See the Config Buttons section.

Figure 6: Action Buttons

Control Mode Button

The Control Mode button allows the user to switch between Local control or Remote only control of the controller. Tapping
the Control Mode button results in a confirmation window (unless prompts are disabled in the Options > Front Panel >
Confirm Prompt menu) to change the control mode to either Local or Remote mode. A yellow indicator on the button shows
which mode is currently active for the unit. Tap the OK button to change the control mode or the Cancel button. See Figure 7.

Figure 7: Action Button > Control Mode Setting Confirmation

If confirmation prompts are disabled, tapping the Switch Mode button will toggle the control mode between Local and
Remote.
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Note that when the unit is in Remote mode, the user will not be able to access any functions from the touchscreen except the
Local/Remote Action button. A message on the display will indicate "Unit in Remote Mode". See Figure 8.

Figure 8: Display When in Remote Mode

Switch Mode Button

The Switch Mode button allows the user to switch between Auto and Manual switching method used by the system. See the
Methods of Switching section.

Tapping the Switch Mode button results in a confirmation window (unless prompts are disabled in the Options > Front Panel
> Confirm Prompt menu) to change the method of switch control to either Auto or Manual mode. A yellow indicator on the
button shows which mode is currently active for the unit. Tap the OK button to change the switch control mode or the Cancel
button. See Figure 9.

Figure 9: Action Button > Switch Mode Setting Confirmation

If confirmation prompts are disabled, tapping the Control Mode button will toggle the switch control mode between Auto and
Manual.

Attenuation Button

The Attenuation Action button gives the user the ability to alter the gain setting of the connected amplifiers from the
touchscreen. Any adjustments to attenuation using this button are immediately applied to the connected amplifiers.

Tapping the Attenuation button opens the attenuation setting screen. See Figure 10. The current attenuation setting is
displayed in the green window. The user may adjust the ones place and the tenths place by touching the up and down
arrows on the screen. Tap the OK button to accept the attenuation setting.

Figure 10: Action Button > Attenuation Setting

Mute (TX) Button

The Mute (TX) Action button allows the user to quickly mute or unmute all of the amplifiers in the connected system.

Tapping the Mute (TX) button results in a confirmation window (unless prompts are disabled in the Options > Front Panel >
Confirm Prompt menu) to change the mute state of the system amplifiers. Tap the OK button to change the mute state or
the Cancel button to keep the current mute state. See Figure 11.

Figure 11: Action Button > Mute Setting

If confirmation prompts are disabled, tapping the Mute (TX) button will toggle the mute state of the system amplifiers
between muted and unmuted.
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Methods of Switching

There are three methods of switching converters in a redundant system.

• Manual Mode

• Automatic Mode

• Physically Rotating either the Tx or Rx Transfer Switch

Manual Mode

The controller is set to Manual mode by toggling the Switch Mode button so that the yellow indicator shows Manual mode.
Make sure that the Control Mode is set to Local mode so that the Auto/Manual key is operative. Either unit can be selected
online by tapping the amplifier buttons on the RF Signal Path display. The online units are shown by the green background
(and text label 'Online') in the button. The standby unit is shown by the white background (and text label 'Stdby') in the
button.

Auto Mode

Automatic Switch mode is entered by toggling the Switch Mode button until the yellow indicator shows Auto mode. The
online and standby amplifiers can be selected by tapping the appropriate buttons on the RF Signal Path display. This
configuration will remain until a fault condition occurs. Upon failure, the appropriate fault light will illuminate and switchover
will automatically occur.

Physically Rotating Transfer Switch

It is possible to physically rotate the shaft on either the TX or Rx transfer switch to change the online and standby amplifier
positions. This can be done either in manual or automatic mode. When the switch is physically rotated in automatic mode the
controller will attempt to return the switch to it previous position.

The controller will make two attempts to return the switch before accepting the new position. The front panel mimic display
will show the correct switch path settings even when the switch is physically rotated.
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Local (Front Panel) Menu Structure

Figure 12 shows the Main Menu hierarchy.

Figure 12: Main Menu Buttons

There are eight main levels of menu selections.

• Status - System Information menu sublevel

• Communication - All Communication-related settings

• Operation - System operation related settings

• Fault Setup - Fault handling settings

• Redundancy - All settings related to redundant system modes

• Unit Control - Control of connected SSPAs or LNAs

• Options - Miscellaneous settings and functions

• Info - Display of connected unit/controller information and time settings

The user should tap the button of interest to proceed to the next menu level. When navigating the menu, the user can tap the
Home icon to go back to the main menu at any time. There are also icons that may be used to go back to the previous
screen.

Status Menu

Figure 13 shows the Status menu.

Figure 13: Status Menu

The Status menu includes the following buttons:

• Fault Panel

• Fault Info

• SSPA Current

• SSPA RF

• LNA

• Redundancy

• RCP Status

• Custom Status

Fault Panel

Figure 14 shows the Fault Panel.
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Figure 14: Status > Fault Panel

The Fault Panel displays the fault status for various parameters monitored by the unit's controller. A green icon next to the
unit condition title indicates a non-faulted state. A red icon next to the unit condition title indicates a faulted state. A yellow
icon indicates a communication error. A black icon designates a condition not applicable to the unit.

Fault states for the following conditions are displayed: Summary fault, Unit (1, 2 and 3) faults, Power Supply fault, RF Switch
(1 and 2) faults, SSPA (1, 2 and 3) faults, Power Supply Voltage faults, LNA (1, 2 and 3) faults, and Auxiliary faults (main, 1,
2 and 3).

Fault Info Menu

Figure 15 shows the Fault Info menu. This menu can be used for advanced fault analysis.

Figure 15: Status > Fault Info Menu

This menu displays the read-only values of the Last Fault Cause, Fault Tolerance, Fault Monitor, SSPA Fault Logic, SSPA
Input State, Aux Fault Logic and Aux Input State.

The Last Fault Cause section displays the cause of the last condition that triggered a fault. The value is latched to the last
fault occurrence. Use the Clear Fault function to reset. If no cause exists, it will display No Faults. Other values include:
LowRF (Low RF level fault); AuxFlt (Auxiliary fault); BUCFlt (Block Up converter fault); PSFlt (Power Supply fault); ColdSt
(Unit cold start power up detected); N+1Flt (N+1 System Fault); TmpFlt (High temperature fault); RegFlt (Voltage Regulator
fault); CurFlt (Low DC Current fault); HiVSWR (High reflected RF level fault); Other (Unknown fault condition).

Fault Tolerance displays the selected number of faults (none (disabled), one or two) that must occur in an online unit before
switchover occurs. See the Fault Tolerance Menu section.

Fault Monitor displays the selected types of faults monitored by the controller. See the Fault Monitor Menu section.

SSPA Fault Logic displays the selected logic setting for SSPA faults. See the Fault Logic Menu section.

SSPA Input State refers to the controlled state of the SSPA system. This item shows the fault state of each individual SSPA.
If any SSPA faults are present in the system, this item will show them in format ZYX, where X corresponds with HPA1, Y with
HPA2 and Z with HPA3. A 0 indicates normal operation and a 1 indicates a fault condition. For example: if HPA1 is in the
fault condition, the display will indicate "001"; if all three SSPAs are faulted, "111" will be displayed.

Aux Fault Logic displays the selected logic setting for Auxiliary faults. See the Aux (Auxiliary) Fault Menu section.

Aux Input State displays the detected fault state of the Auxiliary Input for each connected unit, based on the Auxiliary Alarm
state at the External Alarm Port (J8). See the External Alarm Port description in the Unit Description section.

If any auxiliary faults are present in the system, this item will show them in format ZYZYX, where X corresponds with
Auxiliary Alarm 1 (J8, pin 5), Y with Auxiliary Alarm 2 (J8, pin 6), and Z with Auxiliary Alarm 3 (J8, pin 7). A 0 indicates
normal (logic low state) operation and a 1 indicates a fault (logic high state) condition. For example, a fault on Auxiliary Alarm
2 would display as 01010; faults on Auxiliary Alarms 1 and 3 would display as 10101.

SSPA Current Menu

Figure 16 shows the SSPA Current Menu.

Figure 16: Status > SSPA Current Menu

This read-only menu displays the baseplate temperature and current draw of each amplifier in the system, as well as the
system mute status (TX Enable) and ambient temperature.

Note that most of the parameters on this screen includes a link to a trendline graph that shows the history of that parameter
since unit power-up or reset of the trendlines. For more information on trendlines, see the Trendlines section.

Trendlines

Figure 17 shows an example of a trendline for the temperature of SSPA1.
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Figure 17: Trendline Example, SSPA1 Temperature

The Y-axis at the left of the screen shows the range encompassing the maximum (top) and minimum (bottom) values of the
currently displayed trendline. The total time of the trendline is displayed at the bottom right of the graph. The last plot value is
shown at the top right of the graph.

The trendline shows up to the last approximately 670 points of the parameter being graphed. Any prior measurements are
dropped off the graph, but minimum and maximum values are saved in the Real-time Statistics block.

The user may reset all trendlines by clicking on the Reset button at the bottom right of the screen. See the Reset Trends
section. To close the trendline, click on the red X at the top right of the screen.

SSPA RF Menu

Figure 18 shows the SSPA RF menu. This menu can be used to identify the RF output of each individual amplifier in the
system, and for advanced fault analysis.

Figure 18: Status > SSPA RF Menu

This read-only menu displays the read-only values of the forward RF power of each SSPA in the system, the attenuation
offset assigned to each amplifier, the system forward RF power and, if the system includes a reflected power monitor, the
system reflected RF power.

SSPA attenuation offsets can be assigned as described in the Attenuation Offset Menu section.

If the system does not include a forward or reflected power monitor, the value for the respective system RF measurement will
display "N/A".

Note that several of the parameters on this screen includes a link to a trendline graph that shows the history of that
parameter since unit power-up or reset of the trendlines. For more information on trendlines, see the Trendlines section.

LNA Menu

Figure 19 shows the LNA menu.

Figure 19: Status > LNA Menu

This read-only menu displays the current draw of each LNA in the system, the calibration point of each LNA, and the fault
window percentage which will trigger a fault should the LNA current measurement be outside the selected window.

LNA calibration points can be assigned as described in the Calibrate LNA Menu section.

If the system does not include an LNA in a given position, the LNA current and calibration values will display "N/A".

Note that several of the parameters on this screen includes a link to a trendline graph that shows the history of that
parameter since unit power-up or reset of the trendlines. For more information on trendlines, see the Trendlines section.

Redundancy Menu

Figure 20 shows the Redundancy menu.

Figure 20: Status > Redundancy Menu

This read-only menu displays the selected system mode, the system type, switch positions, switch mute mode, standby
mode and switching mode.
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The system mode may be selected as described in the System Mode Menu section.

The system type may be selected as described in the System Type Menu section.

The switch mute mode may be selected as described in the Switch Mute Menu section.

The standby mode may be selected as described in the Standby Mode Menu section.

The switching mode may be selected as described in the Switching Mode Menu section.

RCP Status Menu

Figure 21 shows the RCP Status menu.

Figure 21: Status > RCP Status Menu

This read-only menu displays the power supply voltages, LNA voltages and temperature at the controller card of the unit.

Note that each of the parameters on this screen includes a link to a trendline graph that shows the history of that parameter
since unit power-up or reset of the trendlines. For more information on trendlines, see the Trendlines section.

Custom Status Menu

Figure 22 shows the Custom Status menu. This is the default display until the user assigns a set of parameters to be shown
on this screen. See the Config Status section.

Figure 22: Status > Custom Status Menu

Communication Menu

Figure 23 shows the Communication menu.

Figure 23: Communication Menu

The Communication menu includes the following buttons:

• Serial

• IP Setup

• SNMP Setup

• Trap Setup

• System Address

• Interface

Serial Button

Tapping the Serial button opens the Serial menu, from which the user can select the Baud Rate and Serial Protocol used by
the controller. See Figure 24.

Figure 24: Communication > Serial Menu
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Baud Rate Menu

Tapping the Baud Rate button opens the Baud Rate menu. The user may select from the available baud rates. Default baud
rate is 9600. See Figure 25.

Figure 25: Communication > Serial > Baud Rate Menu

Serial Protocol Menu

Tapping the Serial Protocol button opens the Serial Protocol menu. The user may select either Normal or Terminal
communication protocol. See Figure 26.

Figure 26: Communication > Serial > Serial Protocol Menu

IP Setup Button

Tapping the IP Setup button opens the IP Setup menu, from which the user can select the IP address and parameters used
by the controller. See Figure 27.

Figure 27: Communication > IP Setup Menu

IP Address

Tapping the IP Address button opens the IP Address menu, from which the user can enter the IP Address for the controller.
Use the numbered keypad on the screen to enter the numbers for the highlighted selection. Tap each section to enter the
values for that octet. Default IP Address is 192.168.0.9. See Figure 28.

Figure 28: Communication > IP Setup > IP Address Selection

Tap the OK button to accept the entered values and return to the IP Setup Menu.

  Note: Teledyne Paradise Datacom products use IPv4, Class C addressing.

Subnet Mask

Tapping the Subnet Mask button opens the Subnet Mask menu, from which the user can enter the Subnet Mask for the
controller. Use the numbered keypad on the screen to enter the numbers for the highlighted selection. Tap each section to
enter the values for that octet. Default Subnet Mask is 255.255.255.0. See Figure 29.

Figure 29: Communication > IP Setup > Subnet Mask Selection

Tap the OK button to accept the entered values and return to the IP Setup Menu.

Gateway

Tapping the Gateway button opens the Gateway menu, from which the user can enter the Gateway for the controller. Use the
numbered keypad on the screen to enter the numbers for the highlighted selection. Tap each section to enter the values for
that octet. Default Gateway is 192.168.0.1. See Figure 30.
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Figure 30: Communication > IP Setup > Gateway Selection

Tap the OK button to accept the entered values and return to the IP Setup Menu.

Local Port

Tapping the Local Port button opens the Local Port menu, from which the user can enter the Local Port for the controller. Use
the numbered keypad on the screen to enter the numbers for the highlighted selection. Default Local Port is 1007. See
Figure 31.

Figure 31: Communication > IP Setup > Local Port Selection

Tap the OK button to accept the entered values and return to the IP Setup Menu. Tap the Cancel button to revert to the last
saved Local Port and return to the IP Setup Menu.

Lock IP

Tapping the Lock IP button opens the Lock IP menu, from which the user can enter the IP address from which requests will
be accepted by the controller. Use the numbered keypad on the screen to enter the numbers for the highlighted selection.
Tap each section to enter the values for that octet. See Figure 32. Default Subnet Mask is 255.255.255.255.

Figure 32: Communication > IP Setup > Lock IP Selection

Tap the OK button to accept the entered values and return to the IP Setup Menu.

The LockIP selection gives the user the ability to increase the security measure for the IPNet protocol. The controller will
answer a request which comes only from the assigned IP address. For firmware prior to version 6.00, set this address value
to 0.0.0.0 or 255.255.255.255 to disable this feature.

Starting with version 6.00, the Lock IP address function has been updated to allow "Binding" and "Masking" functions.
"Binding" means that the first datagram retrieved for this socket will bind to the source IP address and port number. Once
binding has been completed, the SSPA will answer to the bound IP source until the unit is restarted or reset. Without binding,
the socket accepts datagrams from all source IP addresses.

Address 0.0.0.0 allows all peers, but provides binding to first detected IP source; Address 255.255.255.255 accepts all
peers, without binding. If Lock IP is a multicast address, then the amplifier will accept queries sent from any IP address of
multicast group.

MAC Address

Tapping the MAC Address button opens the read-only MAC Address display. See Figure 33.

Figure 33: Communication > IP Setup > MAC Address Display

Web Password

Tapping the Web Password button opens the Web Password menu, from which the user can enter the web password which
is requested when the user attempts to communicate with the controller over IPNet using a web browser. Use the alpha-
numeric keypad on the screen to enter the value for the web password. When the alphabetic keypad is displayed, Tap the "#"
symbol to switch to the numeric keypad. When the numeric keypad is displayed, tap the "A" to switch to the alphabetic
keypad. Tap the "OK" button to confirm the entered password and return to the IP Setup Menu. Maximum password length is
20 characters. Erase all characters to disable password protection. Default Web Password is paradise. See Figure 34.

http://stc-ppapp-web02/Intranet/xml/216351draft/images/communication-ip-setup-gateway-entry.png
http://stc-ppapp-web02/Intranet/xml/216351draft/images/communication-ip-setup-gateway-entry.png
http://stc-ppapp-web02/Intranet/xml/216351draft/images/communication-ip-setup-local-port-entry.png
http://stc-ppapp-web02/Intranet/xml/216351draft/images/communication-ip-setup-local-port-entry.png
http://stc-ppapp-web02/Intranet/xml/216351draft/images/communication-ip-setup-lock-ip-entry.png
http://stc-ppapp-web02/Intranet/xml/216351draft/images/communication-ip-setup-lock-ip-entry.png
http://stc-ppapp-web02/Intranet/xml/216351draft/images/communication-ip-setup-mac-address-display.png
http://stc-ppapp-web02/Intranet/xml/216351draft/images/communication-ip-setup-mac-address-display.png


Figure 34: Communication > IP Setup > Web Password Selection

Tap the OK button to accept the entered values and return to the IP Setup Menu.

SNMP Setup Button

Tapping the SNMP Setup button opens the SNMP Setup menu, from which the user can select the Community Get and
Community Set passwords, and review the User Info. See Figure 35.

Figure 35: Communication > SNMP Setup Menu

Community Get

Tapping the Community Get button opens the Community Get menu, from which the user can enter the Community Get
password which is requested when the user attempts to communicate with the controller over IPNET using SNMP. Use the
alpha-numeric keypad on the screen to enter the value for the web password. When the alphabetic keypad is displayed, tap
the "#" symbol to switch to the numeric keypad. When the numeric keypad is displayed, tap the "A" to switch to the
alphabetic keypad. Tap the "OK" button to confirm the entered password and return to the IP Setup Menu. Maximum
password length is 20 characters. Erase all characters to disable password protection. See Figure 36. Default Community
Get password is public.

Figure 36: Communication > SNMP Setuip > Community Get Selection

Tap the OK button to accept the entered values and return to the SNMP Setup Menu.

Community Set

Tapping the Community Set button opens the Community Set menu, from which the user can enter the Community Set
password which is requested when the user attempts to communicate with the controller over IPNET using SNMP. Use the
alpha-numeric keypad on the screen to enter the value for the web password. When the alphabetic keypad is displayed, tap
the "#" symbol to switch to the numeric keypad. When the numeric keypad is displayed, tap the "A" to switch to the
alphabetic keypad. Tap the "OK" button to confirm the entered password and return to the IP Setup Menu. Maximum
password length is 20 characters. Erase all characters to disable password protection. See Figure 37. Default Community
Set password is private.

Figure 37: Communication > SNMP Setup > Community Set Selection

Tap the OK button to accept the entered values and return to the SNMP Setup Menu.

User Info

Tapping the User Info button opens the User Info display screen. See Figure 38.

Figure 38: Communication > SNMP Setup > User Info Display

This screen is reserved for future development.

Trap Setup Button
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Tapping the Trap Setup button opens the Trap Setup menu, from which the user can set the various SNMP trap parameters,
and assign the Network Management System (NMS) IP address which will receive the trap notifications. See Figure 39.

Figure 39: Communication > Trap Setup Menu

Send FLT Trap

Tapping the Send FLT Trap button opens the Send FLT Trap menu, from which the user can set the Send FLT Trap
parameter. The value entered equals the number of attempts the unit will make to send all fault information to the assigned
NMS IP address. Use the numbered keypad on the screen to enter the numbers for the highlighted selection. Entering "0"
disables this feature. Tap the "OK" button to set the entered value. See Figure 40.

Figure 40: Communication > Trap Setup > Send FLT Trap Selection

Tap the OK button to accept the entered value and return to the Trap Setup Menu. Tap the Cancel button to revert to the last
saved value and return to the Trap Setup Menu.

Send Cond. Trap

Tapping the Send Cond. Trap button opens the Send Cond. Trap menu, from which the user can set the Send Cond. Trap
parameter. The value entered equals the number of attempts the unit will make to send the selected condition information to
the assigned NMS IP address. Use the numbered keypad on the screen to enter the numbers for the highlighted selection.
Entering "0" disables this feature. Tap the "OK" button to set the entered value. See Figure 41.

Figure 41: Communication > Trap Setup > Send Condition Trap Selection

Tap the OK button to accept the entered value and return to the Trap Setup Menu. Tap the Cancel button to revert to the last
saved value and return to the Trap Setup Menu.

Condition Trap

Tapping the Condition Trap button opens the Condition Trap menu, from which the user can select the controller condition
that will be monitored and trigger a trap notification if it falls outside the upper and lower limits defined by the user. See
Figure 42.

Figure 42: Communication > Trap Setup > Condition Trap Selection

Tick the checkbox beside the controller condition that will be monitored.

Trap Subset

Tapping the Trap Subset button opens the Trap Subset menu, from which the user can set the Trap Subset parameter. This
parameter is required when the trap condition selected has multiple sources, such as multiple power supplies in a unit. The
value entered corresponds to the condition source selected. Use the numbered keypad on the screen to enter the numbers
for the highlighted selection. See Figure 43.

Figure 43: Communication > Trap Setup > Trap Subset Selection

Tap the OK button to accept the entered value and return to the Trap Setup Menu. Tap the Cancel button to revert to the last
saved value and return to the Trap Setup Menu.
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Trap Lower Limit

Tapping the Trap Lower Limit button opens the Trap Lower Limit menu, from which the user can set the lower limit of the
selected condition being monitored. Use the numbered keypad on the screen to enter the numbers for the highlighted
selection. See Figure 44.

Figure 44: Communication > Trap Setup > Trap Lower Limit Selection

Tap the OK button to accept the entered value and return to the Trap Setup Menu. Tap the Cancel button to revert to the last
saved value and return to the Trap Setup Menu.

Trap Upper Limit

Tapping the Trap Upper Limit button opens the Trap Upper Limit menu, from which the user can set the upper limit of the
defined condition being monitored. Use the numbered keypad on the screen to enter the numbers for the highlighted
selection. See Figure 45.

Figure 45: Communication > Trap Setup > Trap Upper Limit Selection

Tap the OK button to accept the entered value and return to the Trap Setup Menu. Tap the Cancel button to revert to the last
saved value and return to the Trap Setup Menu.

TrapNMSIP

Tapping the Trap Setup button opens the Trap Setup menu, from which the user can assign the Network Management
System IP address which will receive the trap notifications. Use the numbered keypad on the screen to enter the numbers for
the highlighted selection. Tap each section to enter the values for that octet. Tap the "OK" button to set the selected address.
The default address is 192.168.0.9. See Figure 46.

Figure 46: Communication > Trap Setup > Trap NMS IP Selection

Tap the OK button to accept the entered values and return to the Trap Setup Menu.

System Address Button

Tapping the System Address button opens the System Address menu, from which the user can set the network address of
the controller if used on a RS-485 network. Use the numbered keypad on the screen to enter the numbers for the highlighted
selection. Valid values are 1 through 255. The factory default address is 0. See Figure 47.

Figure 47: Communication > System Address Selection

Tap the OK button to accept the entered value and return to the Trap Setup Menu. Tap the Cancel button to revert to the last
saved value and return to the Trap Setup Menu.

  Note: Changes in serial communication settings from the front panel are effective immediately. Changes
to these parameters from serial interface require that the unit be reset in order to take effect. The units can
be reset either by cycling power to the unit or by issuing a reset command from the front panel.

Interface Button
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Tapping the Interface button opens the Interface Menu. The user may select between RS232, RS485, IPNet (Ethernet) or
SNMP communication. See Figure 48.

Figure 48: Communication > Interface Menu

Tick the checkbox beside the interface type that will be used for remote communication.

Operation Menu

Figure 49 shows the Operation menu.

Figure 49: Operation Menu

The Operation menu includes the following buttons:

• System Type

• Buzzer

• RF Units

• Control

System Type Menu

Tapping the Sytem Type button opens the System Type menu, from which the user can select the type of unit in the system
to be controlled. Values include None, CO/HPO, Rack Mount, vBUC, SystemX and PowerMAX. The current unit type
selected is checked. See Figure 50.

Figure 50: Operation > System Type Menu

Tick the checkbox beside the system type that will be used in the system.

Buzzer Menu

Tapping the Buzzer button opens the Buzzer menu, from which the user can enable or disable the buzzer alarm that is
triggered whenever a fault condition occurs. The current Buzzer state is checked. See Figure 51.

Figure 51: Operation > Buzzer Menu

Tick the checkbox beside the desired condition of the audible alarm buzzer.

RF Units Menu

Tapping the RF Units button opens the RF Units menu, from which the user can select the type of unit displayed on the
touchscreen. Values are dBm and Watt. The current unit type selected is checked. See Figure 52.

Figure 52: Operation > RF Units Menu

http://stc-ppapp-web02/Intranet/xml/216351draft/images/communication-interface-menu.png
http://stc-ppapp-web02/Intranet/xml/216351draft/images/communication-interface-menu.png
http://stc-ppapp-web02/Intranet/xml/216351draft/images/operation-menu.png
http://stc-ppapp-web02/Intranet/xml/216351draft/images/operation-menu.png
http://stc-ppapp-web02/Intranet/xml/216351draft/216351-3.xml#216351-3.3.3.1
http://stc-ppapp-web02/Intranet/xml/216351draft/216351-3.xml#216351-3.3.3.1
http://stc-ppapp-web02/Intranet/xml/216351draft/216351-3.xml#216351-3.3.3.2
http://stc-ppapp-web02/Intranet/xml/216351draft/216351-3.xml#216351-3.3.3.2
http://stc-ppapp-web02/Intranet/xml/216351draft/216351-3.xml#216351-3.3.3.3
http://stc-ppapp-web02/Intranet/xml/216351draft/216351-3.xml#216351-3.3.3.3
http://stc-ppapp-web02/Intranet/xml/216351draft/216351-3.xml#216351-3.3.3.4
http://stc-ppapp-web02/Intranet/xml/216351draft/216351-3.xml#216351-3.3.3.4
http://stc-ppapp-web02/Intranet/xml/216351draft/images/operation-system-type-menu.png
http://stc-ppapp-web02/Intranet/xml/216351draft/images/operation-system-type-menu.png
http://stc-ppapp-web02/Intranet/xml/216351draft/images/operation-buzzer-menu.png
http://stc-ppapp-web02/Intranet/xml/216351draft/images/operation-buzzer-menu.png
http://stc-ppapp-web02/Intranet/xml/216351draft/images/operation-rf-units-menu.png
http://stc-ppapp-web02/Intranet/xml/216351draft/images/operation-rf-units-menu.png


Tick the checkbox beside the RF unit type that will be displayed.

Control Menu

Tapping the Control button opens the Control Menu, from which the user can select either Local or Remote control of the
unit. The current Control mode is checked. See Figure 53.

Figure 53: Operation > Control Menu

Note that this menu performs the same function as the Control Mode Action button.

Tick the checkbox beside the desired control mode. If Remote is selected, all local control will be disabled, except for the
Control Action Button at the right of the touchscreen display. See Figure 54.

Figure 54: Remote Control Mode Active

Fault Setup Menu

Figure 55 shows the Fault Setup menu.

Figure 55: Fault Setup Menu

The Fault Setup menu allows the user to select the fault monitoring parameters for the controller. These parameters include
the following buttons:

• Fault Monitor

• Aux (Auxiliary) Fault

• Switch Fault

• Fault Logic

• Fault Latch

• Fault Tolerance

Fault Monitor Menu

Tapping the Fault Monitor button opens the Fault Monitor Menu, from which the user can select those inputs that constitute a
major fault and cause switchover. The current Fault Monitor selection is checked. See Figure 56.

Figure 56: Fault Setup > Fault Monitor Menu

If SSPA Only is selected, the (3) external alarm inputs of controller Port J8 are enabled.

If LNA/LNB Only is selected, the current monitoring of the system LNAs/LNBs is enabled.

If Both is selected, both current monitoring and external alarms are enabled.

If SSPA Comms is selected, tracking of a connected HPA fault state is available by reading incoming data over the local
control port. This option can be used in conjunction with the selected HPA subsystem in case the external alarm port is out of
service.
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Tick the checkbox beside the type of fault to be monitored.

Aux (Auxiliary) Fault Menu

Tapping the Aux Fault button opens the Aux Fault Menu, from which the user can select the state of the auxiliary fault input.
When auxiliary faults are enabled, they will always trigger a summary fault. Auxiliary faults can be paired with main system
faults. When pairing mode is enabled, a detected fault will be treated as a fault in one of the units and could initiate
switchover in redundant systems. The current Aux Fault mode is checked. See Figure 57.

Figure 57: Fault Setup > Auxiliary Fault Menu

Tick the checkbox beside the desired Auxiliary Fault Mode.

If Normal is selected, an independent auxiliary fault function is enabled. Fault inputs will not be paired with main fault input
channels and will not cause unit faults or switchover of the unit. Fault logic follows major fault logic.

If Disable is selected, Auxiliary faults are disabled.

If Inverted Logic is selected, this enables an independent auxiliary fault function. Fault inputs will not be paired with main fault
input channels and will not cause unit faults or switchover of the unit. Fault logic is inverted from major fault logic.

If Switched is selected, the auxiliary fault is enabled as a chain redundancy indicator for HPA faults. Each Auxiliary channel
will be paired up with the main fault channel. A detected auxiliary fault will be treated as a fault on the main fault channel and
will lead to a relevant unit fault. Fault logic follows major fault logic.

If Switched/Invert is selected, the auxiliary fault is enabled as a chain redundancy indicator for HPA faults. Each Auxiliary
channel will be paired up with the main fault channel. A detected auxiliary fault will be treated as a fault on the main fault
channel and will lead to a relevant unit fault. Fault logic is inverted from major fault logic.

Switch Fault Menu

Tapping the Switch Fault button opens the Switch Fault Menu, from which the user can select how a failure of a transfer
switch in the system is handled. The current Switch Fault selection is checked. See Figure 58.

Figure 58: Fault Setup > Switch Fault Menu

Tick the checkbox beside the desired action when a switch fault occurs.

If Major Fault is selected, when a switch fault occurs, the Summary alarm will also be triggered, and the controller will initiate
a switchover to a standby amplifier.

If Alert Only is selected, when a switch fault occurs, no Summary alarm is indicated, and no switchover will be initiated.

If Alternate is selected, the controller will function as if Alert Only was selected, but will alternate functions of the parallel I/O
port output for the Switch position indicator form C-relays. Instead of indicating position (either Pos1 or Pos2), the relays will
indicate RF switch fault or normal status. This option was introduced in RCP firmware rev 3.30 for advanced system
integration purposes. This option should not be selected by the customer unless directed by Teledyne Paradise Datacom.

Fault Logic Menu

Tapping the Fault Logic button opens the Fault Logic Menu, from which the user can select the logical state used for fault
reporting. The current Fault Logic selection is checked. See Figure 59.

Figure 59: Fault Setup > Fault Logic Menu

Tick the checkbox beside the desired logical fault state.

The factory default setting is a logic high state for external alarm fault status. This is consistent with (contact open = fault )
logic used in most systems. However, if used in a system that employ reverse logic, this setting can be used to adjust the
controller accordingly.
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Fault Latch Menu

Tapping the Fault Latch button opens the Fault Latch Menu, from which the user can enable or disable fault latching. A
latched alarm will remain indicated on the front panel until the operator clears the alarm. Unlatched alarms will allow the
summary alarm indicator to stop displaying the alarm condition if the circumstance creating the alarm has be cleared or
corrected. The current Fault Latch setting is checked. See Figure 60.

Figure 60: Fault Setup > Fault Latch Menu

Tick the checkbox beside the desired fault latch state.

The factory default state is for fault latching to be enabled. When fault latching is enabled, after a fault has been detected the
controller will continue to indicate an alarm even after the external fault may have been removed. See the Reset Menu
section for details on fault latching.

Fault Tolerance Menu

Tapping the Fault Tolerance button opens the Fault Tolerance Menu, from which the user can select the number of faults that
a unit in the system may exhibit before a switchover to a standby unit occurs (when in Auto Switching mode). The current
Fault Tolerance setting is checked. See Figure 61.

Figure 61: Fault Setup > Fault Tolerance Menu

Tick the checkbox beside the number of faults that will be tolerated in an online amplifier before a switchover occurs.

Redundancy Menu

Figure 62 shows the Redundancy menu.

Figure 62: Redundancy Menu

The Redundancy menu allows the user to assign various redundant mode settings for the system. These settings include the
following buttons:

• System Mode

• Switch Mode

• Standby Mode

• Switch Mute

• Priority Select (1:2 Controller System Mode only)

• Standby Select

• Input Type (1:1 Controller System Mode only)

System Mode Menu

Tapping the System Mode button opens the System Mode Menu, from which the user can select the type of system used
with the controller. The setting must match the actual amplifier configuration for proper operation. See Figure 63.

Figure 63: Redundancy > System Mode Menu
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Select 1:2 Controller mode when using three amplifiers in a 1:2 redundant system configuration, with two amplifiers
transmitting to two outputs (Pol1 and Pol2) and one amplifier in standby.

Select 1:1 Controller mode when using two amplifiers in a 1:1 redundant system configuration, with one amplifiers
transmitting to a single output and one amplifier in standby.

Select 1:1 Ph. Comb. mode when using two amplifiers in a 1:1 phase combined system configuration, with two amplifiers
transmitting to a combined output. Should one amplifier enter a fault condition, the remaining amplifier will continue to
transmit at approximately half the output power of the phase combined system.

Select Dual 1:1 mode when using two transceivers in a dual 1:1 redundant system configuration. The controller will monitor
the Rx unit and Tx unit of the online transceiver system and switch to the standby transceiver system in the case of a failure
of either the Tx or Rx units.

Select Maint. (Maintenance) Mode when using a dummy load with a single amplifier or system. Maint. Mode is typically used
in Manual Switch Mode, and the output is directed to the dummy load during periods of system maintenance.

Select 1:2 Ph. Comb. mode when using three amplifiers in a 1:2 redundant system configuration, with two amplifiers
transmitting to a combined output and one amplifier in standby. Should one of the online amplifiers enters a fault condition,
the controller will switch to the standby amplifier and the system will continue to transmit at the same output power.

Switch Mode Menu

Tapping the Switch Mode button opens the Switch Mode Menu, from which the user can select the method of switching used
by the system. See Figure 64.

Figure 64: Redundancy > Switch Mode Menu

When Manual mode is selected, the user must trigger a switchover from the online amplifier to the standby amplifier. This
can be done either from the touchscreen, by tapping on the triangular amplifier icon in the RF Signal Path display, or
remotely, by sending a command to the online amplifier to change to the Standby mode.

When Auto mode is selected, the controller will automatically switch to the standby amplifier if a fault condition occurs on an
online amplifier. The user may still assign the online amplifer at any time.

If Switch Lock mode is selected, the transfer switches in the system will remain locked in the designated positions,
regardless of the fault condition of the online amplifier. This setting should only be used at the direction of Teledyne Paradise
Datacom.

Standby Mode Menu

Tapping the Standby Mode button opens the Standby Mode Menu, from which the user can select the operational status of
the standby amplifier. See Figure 65.

Figure 65: Redundancy > Standby Mode Menu

When Hot Standby is selected, the standby amplifier operates normally and transmits full output power to the dummy load.
Should the standby amplifier be switched online, it will immediately transmit at full output power. At high RF power levels,
Teledyne Paradise Datacom recommends enabling the Switch Mute function when operating in Hot Standby mode. For
details, see the Switch Mute Menu section.

When Cold Standby is selected, the RF module in the standby amplifier is powered down while the microprocessor and fans
remain operational. Should the standby amplifier be switched online, power will be restored to the RF module and it may take
several moments to achieve full output power.

Switch Mute Menu

Tapping the Switch Mute button opens the Swtich Mute Menu, from which the user can disable or enable various methods of
muting the RF signal whenever the system tranfer switches change position. See Figure 66.
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Figure 66: Redundancy > Switch Mute Menu

The Switch Mute function was introduced into the RCP control setup to overcome a problem with microwave arcing, which
may potentially damage a switching component if switching RF power exceeds 400 Watts. This particular problem becomes
a critical issue if coaxial RF pass switches are used.

In general, all Teledyne Paradise Datacom SSPAs are well protected against high reflected power conditions which may take
place during output microwave switchover. But with certainty, waveguide or coaxial switches will develop an internal electrical
arc during switchover if the output power is significant. Such conditions, will not lead to instant failure, but over time may
diminish some critical RF switch characteristics.

If this option is enabled, the system ability to output RF power will be bonded to the switch position sensing circuitry. This
circuitry consists of the following components: a RCP electronic switch position detector; a wiring harness between the
controller and RF switch; and RF switch position sensors. Failure of the above components will lead to break in transmission.

  Note: In order to enable switch muting, the system sub type must be selected to either CO SSPA, RM
SSPA or vBUC. If the system type set to "None," the switch muting setting will be inhibited. See the
System Type Menu section.

Selecting Disable will disable the switch mute function. All amplifiers in the system will continue to transmit whenever a
switch position changes.

If Internal mode refers to the particular unit itself. If the position of one of the controlled RF switches changes or is about to
change, the controller will mute the SSPA subsystem by issuing a special mute command' over the RS485 serial interface.
When the RF switch position indicator detects that the switch reliably reached Position1 or Position2, a "Mute Off" command
will be issued to the SSPA subsystem over the serial interface. If the switch gets stuck between positions, the system will
remain muted until the situation is resolved or the Switch Mute option is turned off.

External mode may be used when the RCP/SSPA subsystem is part of a larger system. This requires a connection to RCP
Port J7, Pin 16 (Auto/Manual Select), and the Switch Mute setting selected to "External" or "All On". To activate the mute-on-
switch function, generate a pulse to signal ground on RCP Port J7, pin 16 (starting at least 100 mS before the switch position
begins to change). The pulse should continue until switchover is complete. Consult the factory for more information.

If All On mode is selected, the system amplifiers will be muted during any change in switch position.

Selective Muting

Beginning with firmware version 6.15, the controller is capable of selectively muting HPAs on a given polarity during
switchover while operating in 1:2 Mode. If switch muting mode is enabled in 1:2 Controller mode, the controller will
automatically analyze the RF path changes which will occur during switchover. Whenever possible, the controller will mute
only the HPAs along the RF path (polarization) that is disturbed during the switchover process, and will leave the remaining
HPAs connected to the other RF path (polarization) unmuted.

For example, for a controller with a starting configuration of: Unit 1 online on Polarity 1, Unit 3 online on Polarity 2, Unit 2 on
standby; if the system was switched to put Unit 2 online on Polarity 1, only RF Switch 1 (SW1) needs to be rotated to make a
change. The Unit 3 RF path connected to Polarity 2 will be undisturbed by the switchover. In this case, the controller will only
mute Unit 1 and Unit 2 until the switchover process on Polarity 1 is complete, and will leave Unit 3 unmuted on Polarity 2.
See Figure 67.

Figure 67: Switching Unit 2 from Standby to Online on POL 1

However, for a controller with a starting configuration of: Unit 1 on standby, Unit 2 online on Polarity 1, Unit 3 online on
Polarity 2; if the system was switched to put Unit 3 on standby, it will require simultaneous rotation of RF switches 1 (SW1)
and 2 (SW2). Thus, the RF path for all three HPAs will be disturbed and the controller will need to mute the entire system
until the switchover process is complete. See Figure 68.
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Figure 68: Switching Unit 1 from Standby to Online on POL 1

Priority Select Menu

  Note: This button is only active when the System Mode selection is set to 1:2 Controller mode.

Tapping the Priority Select button opens the Priority Select Menu, from which the user can choose the dominant polarity
(POL1 or POL2) to which an online amplifier will transmit should two amplifiers in the system fail. See Figure 69.

Figure 69: Redundancy > Priority Select Menu

If Pol1 is selected, should two amplifiers in the system fail, the remaining amplifier will transmit signal to Polarity 1.

If Pol2 is selected, should two amplifiers in the system fail, the remaining amplifier will transmit signal to Polarity 2.

Standby Select Menu

Tapping the Standby Select button opens the Standby Select Menu, from which the user can assign the standby amplifier in
the connected system. See Figure 70.

Figure 70: Redundancy > Standby Select Menu

  Note that in 1:1 systems, the Amplifier 3 checkbox is disabled.

Tick the checkbox next to the amplifier that should be designated as the standby unit.

Input Type Menu

  Note: This button is only active when the System Mode selection is set to 1:1 Controller mode. This
selection has no effect on system operation, but is simply used to show either a switch or splitter on the
RF Signal Path display.

Tap the Input Type button to open the Input Type Menu, from which the user can select input splitting or input switching to be
displayed on the RF Signal Path display. See Figure 71.

Figure 71: Redundancy > Input Type Menu

Tick the checkbox next to the desired input type that should be displayed on the RF Signal Path display.
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Unit Control Menu

Figure 72 shows the Unit Control menu.

Figure 72: Unit Control Menu

The Unit Control menu allows the user to control the mute state and attenuation settings of a connected amplifier system,
and the power supply source and current fault settings of a connected LNA system.

• Mute

• Attenuation

• Att. (Attenuation) Offset

• Power Supply

• Fault Window

• Calibrate LNA

Mute Menu

Tapping the Mute button opens the Mute Menu, from which the user can mute the system, mute a single polarity of a 1:2
redundant system, or unmute the system. See Figure 73.

Figure 73: Unit Control > Mute Menu

The Mute System and Mute Off selections offer the same function as the Mute (TX) Action Button.

See Switch Mute Menu section for an in-depth description of the mute-on-switch function.

Attenuation Menu

Tapping the Attenuation button opens the Attenuation menu, from which the user can select the amount of attenuation (in dB)
that should be applied to the gain of the amplifier. Use the numbered keypad on the screen to enter the numbers for the
highlighted selection. Tap the "OK" button to set the selected value. See Figure 74.

Figure 74: Unit Control > Attenuation Menu

Enter a value between 0 and 20.0 dB. If Auto Gain is enabled, the system will reserve 5 dB of attenuator range for gain
compensation and attenuation is limited to a value between 0 and 15.0 dB.

Att. (Attenuation) Offset Menu

Tapping the Att. Offset button opens the Attenuation Offset menu, from which the user can select each amplifier unit to
assign an attenuation differential. See Figure 75.

Figure 75: Unit Control > Attenuation Offset Menu

Unit n Menu

Tapping one of the Unit n buttons opens the Unit n attenuation offset menu, from which the user can equalize the individual
SSPA gain differential. See Figure 76.
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Figure 76: Unit Control > Attenuation Offset Unit1 Menu

Enter a value between 0 and 20.0 dB. The selected offset is added to the current level of system attenuation. The sum of the
selected system attenuation and the offset setting is limited to 20 dB maximum.

Power Supply Menu

Tapping the Power Supply button opens the Power Supply menu, from which the user can select the output voltage that will
be provided to a connected LNA/LNB system. See Figure 77.

Figure 77: Unit Control > Power Supply Menu

Tick the checkbox next to the desired output voltage. Maximum average output current in all voltage ranges is 0.9A. Peak
current consumption can be up to 1.5A. Attempts to run a continuous 1.5A on a standard unit may be subject to temperature
de-rating.

An optional high power (-HP) controller is available, which features AC power supply units with forced air cooling, and can
output 1.5A per channel continuously with no temperature de-rating.

Fault Window Menu

Tapping the Fault Window button opens the Fault Window menu, from which the user can select the sensitivity of the
LNA/LNB alarm detection. See Figure 78.

Figure 78: Unit Control > Fault Window Menu

Select from four window settings (8%, 12%, 15% or 20%) which are a percentage of the total current being consumed by the
LNA/LNB. The 8% setting is the most sensitive and 20% is the least sensitive. The factory default setting is 8%.

Calibrate LNA Menu

Tapping the Calibrate LNA button opens the Calibrate LNA menu, from which the user can monitor the current drawn by
each connected LNA and set the calibration point and fault window. See Figure 79.

Figure 79: Unit Control > Calibrate LNA Menu

The current draw for each connected unit is displayed in the green windows. Tap the Cal button below each unit to set the
calibration point to the displayed value. The two white windows immediately above the Cal button will show the upper and
lower current values used to trigger a fault condition, depending on the Fault Window setting.

The Fault Window setting checkboxes at right offer the same selections as those described in the Fault Window Menu
section.

Options Menu

Figure 80 shows the Options menu.

Figure 80: Options Menu
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The Options menu allows the user to select the System backup and restore utilities, Front Panel configuration options, Menu
Lock options, and Trends configurations.

• System

• Front Panel

• Menu Lock

• Config Trends

System Menu

Tapping the System button opens the System menu, from which the user can choose to backup settings, restore settings
from a saved backup, reset the unit, or select the memory mode used by the unit's EEPROM. See Figure 81.

Figure 81: Options > System Menu

Backup Menu

Tapping the Backup button opens the Backup menu, which allows the user to backup all settings to nonvolatile memory.
There are two repositories for saved settings, User 1 and User 2. See Figure 82.

Figure 82: Options > System > Backup Menu

A confirmation window will appear after a button is selected and tapped. Tap the OK button to confirm, or the Cancel button
to cancel the action. See Figure 83.

Figure 83: Options > System > Backup Confirmation

Restore Menu

Tapping the Restore button opens the Restore menu, which allows the user to restore settings from nonvolatile memory.
There are three repositories for saved settings, User 1, User 2, and Factory. Selecting Factory restores all factory default
settings. See Figure 84.

Figure 84: Options > System > Restore Menu

A confirmation window will appear after a button is selected and tapped. Tap the OK button to confirm, or the Cancel button
to cancel the action. See Figure 85.

Figure 85: Options > System > Restore Confirmation

Reset Menu

Tapping the Reset button opens the Reset menu, which allows the user to reset the SSPA controller hardware to activate
certain settings. For example, when the IP Address is modified the SSPA must be reset for it to use the new IP Address. See
Figure 86.
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Figure 86: Options > System > Reset Menu

IO Card -- Resets all hardware on the removable M&C card as well as the embedded cards on all RF modules. The amplifier
will be muted during the reset process, therefore the reset will cause a momentary loss of RF output. All communication links
to remote M&C will be dropped until reset process is complete. The amplifier will use the currently selected communication
parameters (IP address, baud rate, etc);

Module -- Resets only the embedded chips in all RF modules. The I/O card remains operational and maintains a
communication link to remote M&C. The RF module will be muted during the reset process. This function is useful for
clearing latched fault conditions in SSPA units under N+1 system control;

Comms Only -- Resets only communication parameters. If unmuted, the SSPA maintains an unchanged RF output level
during reset. Remote COM links will be dropped and re-enabled with selected parameters;

Clear Faults -- Clears all latched faults and remaining fault history information. SSPA remains fully operational during the
process;

IP Comms -- Resets only IP communication parameters. If unmuted, the SSPA maintains an unchanged RF output level
during reset. Remote COM links will be dropped and re-enabled with selected IP parameters.

When the user selects and taps one of the buttons described above, a confirmation window will appear. See Figure 87. Tap
the OK button to continue the reset function, or the Cancel button to cancel the function.

Figure 87: Options > System > Reset Confirmation

In the case of the Clear Faults button, a different confirmation window will appear. See Figure 88. Tap the OK button to
continue the reset function, or the Cancel button to cancel the function.

Figure 88: Options > System > Clear Faults Confirmation

Memory Mode Menu

Tapping the Memory Mode button opens the Memory Mode menu, from which the user can select options for how the unit
retains settings in memory. See Figure 89.

Figure 89: Options > System > Memory Mode Menu

RAM -- In this mode, the unit will not backup any settings changes to internal EEPROM. This mode is optional and needs to
be set by the user every time the unit endures a power cycle or I/O card reset. This mode is beneficial when the SSPA
application requires frequent changes to the SSPA state (such as mute/unmute or attenuation changes). Since any
EEPROM device has limited write cycles, RAM mode allows the user to execute unlimited settings changes. If the SSPA
experiences a power or reset cycle in RAM mode, it will use the last saved settings setup before RAM was engaged;

EEPROM -- Default mode. Without user intervention, the unit will retain this mode of operation. All changes to settings setup
performed over local or remote interface will be backed up to EEPROM within a 3 second time interval. If the unit
experiences a power cycle or reset, the last saved set of settings will be applied to the unit upon each power up or I/O card
reset. Any EEPROM device has a limited ability to endure write cycles. Maximum write cycles ability for units with firmware
version prior to 6.00 is 150,000. After exceeding this limit, the unit will operate in RAM mode, utilizing a default set of settings
on each power up. Firmware versions above 6.00 allow a minimum of 3,000,000 write cycles before opting out to RAM
mode.

After selecting one of the choices above, a confirmation window will appear. See Figure 90. Tap the OK button to continue
the memory mode selection, or the Cancel button to cancel the selection.
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Figure 90: Options > System > Memory Mode Confirmation

Front Panel Menu

Tapping the Front Panel button opens the Front Panel menu, from which the user can select options for the touchscreen, and
configure the customizable fault display, action buttons, and status display, or reset the screen. See Figure 91.

Figure 91: Options > Front Panel Menu

Confirm Prompt

Tapping the Confirm Prompt button opens the Confirm Prompt menu, from which the user can enable or disable the
confirmation prompts that are generated when certain actions (such as changing Mute Status or initiating a Backup/Restore)
are triggered. The current selection is checked. See Figure 92.

Figure 92: Options > Front Panel > Confirm Prompt Menu

Show Refl. Pwr

  Note: If the amplifier or system does not include a Reflected Power Monitor, the Show Refl Pwr button is
disabled and the following menu is inaccessible.

Tapping the Show Refl. Pwr button opens the Show Refl. Pwr menu, from which the user can enable or disable the display of
the Reflected Power measurement in the RF Signal Path Display. See Figure 93.

Figure 93: Options > Front Panel > Show Reflected Power Menu

Selection Timeout

Tapping the Selection Timeout button opens the Selection Timeout menu, from which the user can select the time interval
that must pass (10 Seconds or 30 Seconds) before most menu screens revert to the previous menu screen if a selection is
not made, or disable all confirmation screens. Default setting is 10 Seconds. See Figure 94.

Figure 94: Options > Front Panel > Selection Timeout Menu

Config Faults

Tapping the Config Faults button opens the Config Faults menu, from which the user can select the fault indicators that are
shown in the Fault Indicator section at the far left of the touchscreen display. The Summary selection is always selected by
default. Other default settings include Power Supply, Temperature, DC Voltage and DC Current. See Figure 95.

Figure 95: Options > Front Panel > Config Faults Menu
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The user may select up to four other options besides the Summary selection to be displayed. Tap the OK button to display
the selected settings. Tap the Cancel button to return to the previous menu. Tap the Default button to return to the default
settings.

Config Buttons

Tapping the Config Buttons button opens the Config Buttons menu, from which the user can select the Action Buttons that
appear on the far right of the touchscreen display. Up to two items may be selected. Control Mode and Switch Mode are
selected by default. See Figure 96.

Figure 96: Options > Front Panel > Config Buttons Menu

The first item selected will appear as the top Action Button. The second item selected will appear as the bottom Action
Button. Tap the Cancel button to return to the previous menu. Tap the Default button to return to the default settings.

  Note: When the unit is set to Remote Only mode, the Control Mode button will appear in the top position
of the Action Buttons area, whether or not it was selected by the user. See Figure 97.

Figure 97: Remote Only Mode

Config Status

Tapping the Config Status button opens the Config Status menu, from which the user can select the items that appear in the
Custom Status menu (Status > Custom Status). Up to eight items may be selected between two screens of parameters that
may be monitored. See Figure 98 and Figure 99.

Figure 98: Options > Front Panel > Config Status Menu Page 1

Tap the More button to get to page 2.

Figure 99: Options > Front Panel > Config Status Menu Page 2

Tap the Back button to return to page 1. Tap the Clear button to remove the checks from all items in both page 1 and page 2.
Tap the Cancel button to return to the previous menu. Tap the OK button to accept the selected parameters.

Screen Reset

Tapping the Screen Reset button results in a confirmation window. See Figure 100. Tap the OK button to continue the reset
function, or the Cancel button to cancel the function.

Figure 100: Options > Front Panel > Reset Screen Confirmation

The Screen Reset function reboots the touchscreen's microcontroller card and resets all trendlines.

Menu Lock Button

http://stc-ppapp-web02/Intranet/xml/216351draft/images/options-front-panel-config-buttons-menu.png
http://stc-ppapp-web02/Intranet/xml/216351draft/images/options-front-panel-config-buttons-menu.png
http://stc-ppapp-web02/Intranet/xml/216351draft/images/unit-in-remote-mode.png
http://stc-ppapp-web02/Intranet/xml/216351draft/images/unit-in-remote-mode.png
http://stc-ppapp-web02/Intranet/xml/216351draft/images/options-front-panel-config-status1-menu.png
http://stc-ppapp-web02/Intranet/xml/216351draft/images/options-front-panel-config-status1-menu.png
http://stc-ppapp-web02/Intranet/xml/216351draft/images/options-front-panel-config-status2-menu.png
http://stc-ppapp-web02/Intranet/xml/216351draft/images/options-front-panel-config-status2-menu.png
http://stc-ppapp-web02/Intranet/xml/216351draft/images/options-front-panel-screen-reset-confirmation.png
http://stc-ppapp-web02/Intranet/xml/216351draft/images/options-front-panel-screen-reset-confirmation.png


Tapping the Menu Lock button opens the Menu Lock menu, from which the user can set the parameters for locking the
touchscreen menu. See Figure 101.

Figure 101: Options > Menu Lock Menu

Password Enable

Tapping the Password Enable button opens the Password Enable menu, from which the user enable or disable password
protection for the touchscreen menu. The current selection is checked. See Figure 102.

Figure 102: Options > Menu Lock > Password Enable Menu

When this function is enabled, the resulting screen returns to the Main Menu, which will show a red "locked" icon over all
buttons that require a password to access. Only the Status and Info menus are not locked. See Figure 103.

Figure 103: Main Menu With Menu Lock Enabled

If the user selects one of the locked buttons, a password entry screen will appear. See Figure 104. By default, the password
is 170.

Figure 104: Enter Password to Unlock Menu

If the correct password is entered, the "locked" icons will disappear, and the user can access all buttons normally, until the
Lock Timer refreshes (based on its setting).

User Password

Tapping the User Password button opens the User Password menu, from which the user set the password for the
touchscreen menu. Use the numbered keypad on the screen to enter the numbers for the highlighted selection. Tap the "OK"
button to set the selected value. The default value is 170. See Figure 105.

Figure 105: Options > Menu Lock > User Password Selection

Lock Timer

Tapping the Lock Timer button opens the Lock Timer menu, from which the user select how often the screen will be
password protected. The current selection is checked. See Figure 106.

Figure 106: Options > Menu Lock > Lock Timer Menu

If One Time is selected, after the user unlocks the screen for the first time since the menu lock was enabled, the menu lock
function will be disabled. Otherwise, the menu lock function will re-establish the touchscreen menu lockdown after the
selected time interval passes.

Config Trends Button
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Tapping the Config Trends button opens the Config Trends menu, from which the user enable or disable the trendlines, set
the time interval between measurements for all trendlines, or reset the trendlines. See Figure 107.

Figure 107: Options > Config Trends Menu

Show Trends

Tapping the Show Trends button opens the Show Trends menu, from which the user may turn on or off all trendlines. The
current selection is checked. See Figure 108.

Figure 108: Options > Config Trends > Show Trends Menu

Time Interval

Tapping the Time Interval button opens the Time Interval menu, from which the user may select the time interval between
measurements for all trendlines. The current selection is checked. See Figure 109.

Figure 109: Options > Config Trends > Time Interval Menu

Reset Trends

Tapping the Reset Trends button results in a confirmation window. See Figure 110. Tap the OK button to continue the reset
function, or the Cancel button to cancel the function.

Figure 110: Options > Config Trends > Reset Trends Confirmation

If the user selects OK, all trendlines will begin tracking measurements anew, using the selected time interval.

Info Menu

Figure 111 shows the Info menu.

Figure 111: Info Menu

The Info menu allows the user to review the serial number and build level of the amplifier, each RF module used in the
amplifier, and the front panel itself; set the date and time; or review how long the amplifier has been running.

• System Info

• Time

• Runtime

• Front Panel

System Info Menu

Tapping the System Info button opens the System Info menu, from which the user can review the controller unit's serial
number, firmware build, circuit board IDs, and the user info. See Figure 112.
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Figure 112: Info > System Info Menu

Tapping any of the buttons on this screen results in a more detailed read-only description. These information screens are not
subject to the screen time-out, and will remain open until the user selects the back or home icons. The information contained
within these menus is critical when calling technical support.

Time Menu

Tapping the Time button opens the Time menu, from which the user can review or edit the date and time. See Figure 113.

Figure 113: Info > Time Menu

Edit Date

Tapping the Edit button next to the displayed Date opens the Edit Date menu, from which the user can change the date
saved to the unit. Use the numbered keypad on the screen to enter the numbers for the highlighted selection. Tap the "OK"
button to set the selected value. See Figure 114.

Figure 114: Info > Time > Edit Date Menu

Edit Time

Tapping the Edit button next to the displayed Time opens the Edit Time menu, from which the user can change the time
saved to the unit. Use the numbered keypad on the screen to enter the numbers for the highlighted selection. Tap the "OK"
button to set the selected value. See Figure 115.

Figure 115: Info > Time > Edit Time Menu

Runtime Menu

Tapping the Runtime button opens the Runtime display, which shows the length of time since the last power-up. This is a
read-only screen. See Figure 116.

Figure 116: Info > Runtime Display

Front Panel Menu

Tapping the Front Panel button opens the Front Panel menu, from which the user can review the touchscreen unit's
microcontroller (MCU) version, graphic user interface (GUI) type, and serial number. See Figure 117.

Figure 117: Info > Front Panel Menu

Tapping any of the buttons on this screen results in a more detailed read-only description. These information screens are not
subject to the screen time-out, and will remain open until the user selects the back or home icons. The information contained
within these menus are critical when calling technical support.
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Introduction

This section describes various redundant system setups utilizing features available with the Teledyne Paradise Datacom
Redundant System Controller.

The controller allows monitor and control of all types of amplifiers, from Low Noise Amplifiers (LNAs), Low Noise Block
Converters (LNBs), Solid State Power Amplifiers (SSPA), or Solid State Power Amplifiers with Block Up Converters (SSPBs).

When purchased with a system, the controller is typically pre-set for operation with the system. The user will need to
configure any Communication settings to operate the controller remotely over a local area network. See the Communication
Menu description in the Touchscreen Operation section.



Operation of 1:1 System

Figure 1 shows the basic block diagram of a 1:1 redundant system. In normal operation one of the Amplifiers, 1 or 2, is
considered the online amplifier and the other is in standby. If a fault condition occurs in the online amplifier the standby unit
can be switched into the circuit by moving the transfer switches on the input and output side of the amplifiers.

Figure 1: Block Diagram, 1:1 Redundant System

LNA/LNB 1:1 System Operation

This section covers the operation of the system controller with a Teledyne Paradise Datacom LNA or LNB Redundant
System. A typical LNA/LNB redundant system consists of an outdoor plate assembly, the indoor controller, and an
interconnecting control cable. Figure 2 shows the major components of a typical 1:1 LNA system.

Figure 2: System Components, 1:1 Redundant System

The LNAs or LNBs are powered by the controller via the control cable. Two power supplies are included in the controller for
total system redundancy. The power supplies are diode connected so that only one supply can operate the system.

The controller supplies +13/17/26 VDC to power the LNA/LNB and +26 VDC to operate the transfer switch. A failure in an
LNA or LNB is typically noted by a change in the DC bias current. The controller has current window comparators that
monitor the current drawn by each unit and will report a fault if the current falls outside of the preset current window. The
nominal current and window width setting are factory preset to the particular LNA/LNB system, however both are easily
adjustable via the front panel control. A typical 1:1 Redundant LNA system is shown in Figure 3.
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Figure 3: Schematic, Typical, 1:1 Redundant LNA System

LNA/LNB Fault Tracking

To set up the controller for LNA/LNB fault tracking perform the following menu selections.

1. Tap the Home icon on the touchscreen;
2. Tap the Fault Setup button;
3. Tap the Fault Monitor button;
4. Tick either the LNA/LNB Only or Both checkbox. This puts the controller in LNA/LNB current monitor mode.

LNA/LNB Current Calibration

After the controller has been put in the LNA/LNB fault tracking mode, the LNA or LNB nominal current should be calibrated
by the controller. To perform the current calibration:

1. Tap the Home icon on the touchscreen;
2. Tap the Unit Control button;
3. Tap the Calibrate LNA button;

Observe the current consupmption displayed in the green boxes for each unit. If the current value displayed is an appropriate
value for normal operation, tap the Cal button to set the upper and lower calibration points (based on the selected Fault
Window percentage ticked at the right of the screen). This calibrates the normal current consumption of the LNA/LNBs.

The 8% Fault Window setting is the most sensitive and 20% is the least sensitive. The factory default setting is 8%.

  Note: Caution should be used when changing Fault Window settings from the factory preset. Current
variations will occur in equipment naturally as a result of changes in operating temperature. Consideration
should be given to environmental conditions and, in particular, to operating temperature extremes.

SSPA 1:1 System Operation

The controller can be configured to accept external fault inputs at connector J8. The external alarm inputs operate with a
closure to ground input. The alarm inputs are opto-isolated inputs, exposing +5 VDC (open circuit voltage) at 5 mA maximum
short circuit current. The external alarm inputs can be driven with an appropriate open collector device or relay contacts.
Solid state power amplifier redundant systems typically use a form C relay summary alarm output to drive the RCP2 external
alarm input. A schematic representation of such a system is shown in Figure 4.
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Figure 4: Schematic, Typical, 1:1 Redundant HPA System

The external alarm inputs are not limited to SSPA systems. Any device with the appropriate alarm output circuitry could be
connected to the external alarm inputs.

  Due to residual losses inherent in 1:1 redundant system configurations (waveguide bends; switch and
coupler losses), reduce the typical output power specification of a single amplifier by approximately 0.2
dB. For example, a single thread 100W amplifier has a typical saturated output power of 50.0 dB (100W).
Placing two of the above amplifiers in a 1:1 redundant system configuration would reduce the typical
system saturated output by 0.2 dB to 49.8 dB (96W). Actual losses will vary based on the system options.

Set External Alarm Tracking

To use the external alarm inputs on the controller, they must first be enabled from the front panel using the following
procedure.

1. Tap the Home icon on the touchscreen;
2. Tap the Fault Setup button;
3. Tap the Fault Monitor button;
4. Tick either the SSPA Only or the Both checkbox. Either setting puts the controller in external alarm monitor mode.

Touchscreen Control of 1:1 Redundant System

In normal 1:1 Redundant System operation, HPA1 is set as the online amplifier and HPA2 is the standby unit. Figure 5 shows
the RF Signal Path Display on the touchscreen for a 1:1 Redundant System. The green dotted line indicates the RF path
through the input switch, to Unit 1 (HPA1) and then through the output switch. The online amplifier is also green to indicate
its online status.

Figure 5: System Mode, 1:1 Controller

To place HPA2 online, the user may touch the Unit 1 button on the RF Signal Path Display. See Figure 6.
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Figure 6: Tap Online Unit Indicator to Give Away Online Status

  Note: Only the on-line amplifier can be switched to standby. Attempting to switch the standby SSPA to
the on-line state by pressing the Unit # button will not work.

If the system is in Auto mode, HPA2 will accept the on-line state only if there is no summary alarm on HPA2. The Unit 2
button for HPA2 will turn green, indicting it is on-line, and the system will rotate the transfer switch to the correct position. The
green dotted line will change to show the RF path passing through the input switch, to Unit 2 (HPA2) and then through the
output switch. See Figure 7. If HPA2 does not accept the online state (due to a fault status), HPA1 will revert to the on-line
state after 1 second.

Figure 7: RF Signal Path Display, Unit 2 Online

In Manual mode, the standby SSPA will always accept the on-line state regardless of its own fault status.

However, in Auto Switch Mode, if the online amplifier enters a Major fault condition, the system will automatically switch the
faulted amplifier to Standby status, and place the standby amplifier on-line.

System Control of Mute and Attenuation

Navigate to the Unit Control menu (Tap Home icon > Tap Unit Control button) to access system Mute and Attenuation
controls. See Figure 8. For more information, see the Using RCP M&C to Control an SSPA System section.

Figure 8: System Mute and Attenuation Control from Unit Control Menu
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Operation of 1:2 System

Figure 9 shows the basic block diagram of a 1:2 redundant system. In normal operation amplifiers 1 and 3 are considered
the online amplifiers while amplifier 2 is in standby. If a fault conditions occurs in either one of the online amplifiers, the
standby unit can be switched into the circuit by moving the transfer switches on the input and output side of the amplifiers.
The amplifiers could be Low Noise Amplifiers (LNAs), Low Noise Block Converters (LNBs), Solid State Power Amplifiers
(SSPA), or Solid State Power Amplifiers with Block Up Converters (SSPBs).

Figure 9: Block Diagram,1:2 Redundant System

A priority can be assigned to either the Polarity 1 or Polarity 2 switch path in the event that both online amplifiers were to fail.
See the Priority Select Menu description in the Touchscreen Operation section.

LNA/LNB 1:2 System Operation

This section covers the operation of the controller with a Teledyne Paradise Datacom LNA or LNB Redundant System. A
typical LNA/LNB redundant system consists of an outdoor plate assembly, the indoor controller, and an interconnecting
control cable. Figure 10 shows the major components of a typical 1:2 LNA system.

Figure 10: System Components, 1:2 Redundant LNA System

The LNAs or LNBs are powered by the controller via the control cable. Two power supplies are included in the controller for
total system redundancy. The power supplies are diode connected so that only one supply can operate the system.

The controller supplies +13/17/26 VDC to power the LNA/LNB and +26 VDC to operate the transfer switches. See the Power
Supply Menu description of the Touchscreen Operation section.

The controller will keep track of the three independent LNA/LNB systems, keeping the link with the most failures in a given
time offline. This is reset each time the user manually overrides the system by selecting one of the units from the front panel.
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A failure in an LNA or LNB is typically noted by a change in the DC bias current. The controller has current window
comparators that monitor the current drawn by each unit and will report a fault if the current falls outside of the preset current
window. The nominal current and window width setting are factory preset to the particular LNA/LNB system, however both
are easily adjustable via the front panel control.

A schematic of a typical 1:2 Redundant LNA System is shown in Figure 11.

Figure 11: Schematic, Typical, 1:2 Redundant LNA System

LNA/LNB Fault Tracking

To set up the controller for LNA/LNB fault tracking perform the following menu selections:

1. Tap the Home icon on the touchscreen;
2. Tap the Fault Setup button;
3. Tap the Fault Monitor button;
4. Tick either the LNA/LNB Only or Both checkbox. This puts the controller in LNA/LNB current monitor mode

LNA/LNB Current Calibration

After the controller has been put in the LNA/LNB fault tracking mode, the LNA or LNB nominal current should be calibrated
by the controller. To perform the current calibration:

1. Tap the Home icon on the touchscreen;
2. Tap the Unit Control button;
3. Tap the Calibrate LNA button;

Observe the current consupmption displayed in the green boxes for each unit. If the current value displayed is an appropriate
value for normal operation, tap the Cal button to set the upper and lower calibration points (based on the selected Fault
Window percentage ticked at the right of the screen). This calibrates the normal current consumption of the LNA/LNBs.

The 8% Fault Window setting is the most sensitive and 20% is the least sensitive. The factory default setting is 8%.

  Note: Caution should be used when changing Fault Window settings from the factory preset. Current
variations will occur in equipment naturally as a result of changes in operating temperature. Consideration
should be given to environmental conditions and, in particular, to operating temperature extremes.

SSPA 1:2 System Operation

The controller can be configured to accept external fault inputs at connector J8. See the External Alarm Port (J8) description
in the Unit Description section.

The external alarm inputs operate with a closure to ground input. The alarm inputs are opto-isolated inputs that expose +5
VDC, open circuit voltage, at 5 mA maximum short circuit current. The external alarm inputs can be driven by an appropriate
open collector device or relay contacts. Redundant systems typically use a form C relay summary alarm output to drive the
RCP2 external alarm input. A typical block diagram representation of such a system is shown in Figure 12.
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Figure 12: Block Diagram, SSPA 1:2 Redundant System

The external alarm inputs are not limited to SSPA systems. Any device with the appropriate alarm output circuitry could be
connected to the external alarm inputs.

  Due to residual losses inherent in 1:2 redundant system configurations (waveguide bends; switch and
coupler losses), reduce the typical output power specification of a single amplifier by approximately 0.4
dB. For example, a single thread 100W amplifier has a typical saturated output power of 50.0 dB (100W).
Placing three of these amplifiers in a 1:2 redundant system configuration would reduce the typical system
saturated output by 0.4 dB to 49.6 dB (91W). Actual losses will vary based on the system options.

External Alarm Tracking

To use the external alarm inputs on the controller they must first be enabled from the front panel using the following
procedure.

1. Tap the Home icon on the touchscreen;
2. Tap the Fault Setup button;
3. Tap the Fault Monitor button;
4. Tick either the SSPA Only or Both checkbox. This puts the controller in external alarm monitor mode.

Touchscreen Control of 1:2 Redundant System

In normal 1:2 Redundant System operation, HPA1 is set as the online amplifier on POL1, HPA3 is assigned as the online
amplifier on POL2, and HPA2 is configured as the standby unit.

Figure 13 shows the RF Signal Path Display for the three (3) amplifiers in a 1:2 Redundant System. The green dotted lines
indicate the RF path through the input switches on POL1 and POL2, to Unit 1 (HPA1) and Unit 3 (HPA3) and then through
the output switches. The online amplifiers are also green to indicate their online status.

Figure 13: System Mode, 1:2 Controller

To place HPA2 online on POL1, the user may tap the Unit 1 button on the RF Signal Path Display. See Figure 14.

Figure 14: Tap Online Unit Indicator to Give Away Online Status
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If the system is in Auto mode, HPA2 will accept the on-line state only if there is no summary alarm on HPA2. The Unit 2
button for HPA2 will turn green, indicting it is on-line, and the system will rotate the transfer switch to the correct position. The
green dotted line will change to show the RF path passing through the POL1 input switch, to Unit 2 (HPA2) and then through
the POL2 output switch. See Figure 15. If HPA2 does not accept the online state (due to a fault status), HPA1 will revert to
the on-line state after 1 second.

Figure 15: RF Signal Path Display, Unit 1 on Standby

In Manual mode, the standby SSPA will always accept the on-line state regardless of its own fault status.

However, in Auto Switch Mode, if the online amplifier enters a Major fault condition, the system will automatically switch the
faulted amplifier to Standby status, and place the standby amplifier on-line.

System Control of Mute and Attenuation

Navigate to the Unit Control menu (Tap Home icon > Tap Unit Control button) to access system Mute and Attenuation
controls. See Figure 16. For more information, see the Using RCP M&C to Control an SSPA System section.

Figure 16: System Mute and Attenuation Control from Unit Control Menu
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1:1 Phase Combined System Operation

The 1:1 Fixed Phase Combined Redundant System is a popular system architecture that enables two Solid State Power
Amplifiers to operate as a normal 1:1 redundant system or a phase combined system. The basic system topology is very
similar to a 1:1 redundant system and is shown in Figure 17.

Figure 17: Block Diagram, 1:1 Fixed Phase Combined System

An additional switch is included which allows either amplifier to be individually routed to the antenna or connect both
amplifiers to a waveguide combiner. The combined system output power is then routed to the antenna. The operation is very
similar to the older generation variable phase ratio combiner (VPRC) techniques.

System designers find that the 1:1 Fixed Phase Combined Amplifier System topology is a cost effective solution to realizing
higher power amplifier systems. For slightly more investment over a traditional 1:1 redundant system, the operator can have
the capability of doubling the individual amplifier output power when conditions may require additional power. This is helpful
when either atmospheric conditions require more power or if additional satellite traffic requires higher power capacity.

The Teledyne Paradise Datacom system controller is specifically designed to handle such an amplifier system. It not only
handles all of the traditional fault monitoring and switching duties but also provides an overall system monitor and control
facility. The controller can adjust the system gain over a 20 dB range without the need to adjust each of the amplifiers
individually. It also provides a convenient display of the overall system output power. Individual amplifier monitor and control
can all be achieved through the controller either locally via the front panel or by remote serial communication.

  Due to the output waveguide and switches, there is always some residual loss in the output of phase
combined HPA systems. This results in slightly less than the ideal 3 dB power addition to the output power
of a single HPA unit. On 1:1 phase combined systems, the typical additive output power is 2.70 dB above
the output power of a single HPA. For example, two 100W amplifiers (each with a standalone Psat of 50.0
dBm) in a 1:1 phase combined configuration would have a typical system saturated output power of 52.7
dBm (186W). Actual losses will vary based on the system options.

Touchscreen Control of 1:1 Phase Combined System

In normal 1:1 Phase Combined System operation, the outputs of HPA1 and HPA2 are phase combined to a single output.

Figure 18 shows the RF Signal Path Display for the two (2) amplifiers in a 1:1 Phase Combined System. The green dotted
lines indicate the RF path through the input switches to Units 1 and 2 and then through the switching/combiner array to the
system output. The online amplifiers are also green to indicate their online status.

Figure 18: System Mode, 1:1 Ph. Comb. (Phase Combined)
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To place HPA2 (Unit 2) on Standby, the user may tap the Unit 2 button on the RF Signal Path Display. See Figure 19. The
switch array will change position to bypass the combiner and send only the Unit 1 signal to the system output.

Figure 19: Tap Unit 2 Indicator to Place Unit 2 on Standby (and Out of Phase Combined Mode)

Tap the Summation button [Σ] to place the system back in Phase Combined mode.

See the Using RCP M&C to Control an SSPA System section for information about mute and attenuation control of the
system amplifiers.
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1:2 Phase Combined System Operation

The 1:2 Fixed Phase Combined Redundant System is a popular system architecture that enables Solid State Power
Amplifiers to achieve higher output power levels while building in a level of redundancy. The basic system topology is similar
to a 1:2 redundant system and is shown in Figure 20.

Figure 20: Block Diagram, 1:2 Fixed Phase Combined System

Amplifiers #1 and #3 are normally online. The outputs of #1 and #3 are directed by the waveguide switches into a fixed
phase combiner such as a waveguide "magic tee" style combiner. In the event of a failure of either on line amplifier, the
standby amplifier, #2, can be switched in place of either #1 or #3 and the system maintains full output power.

System designers find that the 1:2 Fixed Phase Combined Amplifier System topology is a very cost effective solution to
realizing higher power amplifier systems. For example, it is less expensive to configure a 1 kW C-Band redundant system
using (3) 500W Compact Outdoor Amplifiers in a 1:2 Fixed Phase Combined redundant system than it is to use (2) 1 kW
amplifiers in a traditional 1:1 Redundant System.

The FPRC-1200 controller is specifically designed to handle such an amplifier system. It not only handles all traditional fault
monitoring and switching duties but also provides an overall system monitor and control facility. The FPRC-1200 can adjust
the system gain over a 20 dB range without the need to adjust each of the three amplifiers individually. It also provides a
convenient display of the overall system output power. Individual amplifier monitor and control can also be achieved through
the FPRC-1200 either locally via the front panel or by remote serial communication.

  Due to the output waveguide and switches, there is always some residual loss in the output of phase
combined HPA systems. This results in slightly less than the ideal 3 dB power addition to the output power
of a single HPA unit. On 1:2 phase combined systems, the typical additive output power is 2.50 dB above
the output power of a single HPA. For example, three 100W amplifiers (each with a standalone Psat of 50.0
dBm) in a 1:2 phase combined configuration would have a typical system saturated output power of 52.5
dBm (178W). Actual losses will vary based on the system options.

Touchscreen Control of 1:2 Phase Combined System

In normal 1:2 Phase Combined System operation, the outputs of HPA1 and HPA3 are phase combined to a single output,
with HPA2 in standby mode.

Figure 20 shows the RF Signal Path Display for the three (3) amplifiers in a 1:2 Phase Combined System. The green dotted
lines indicate the RF path through the input splitter to Units 1 and 3 and then through the switching/combiner array to the
system output. Unit 2 is in Standby mode. The online amplifiers are also green to indicate their online status.

Figure 21: System Mode, 1:2 Ph. Comb. (Phase Combined)

To place HPA2 (Unit 2) on Standby, the user may tap the Unit 2 button on the RF Signal Path Display. See Figure 21. The
switch array will change position to bypass the combiner and send only the Unit 1 signal to the system output.
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Figure 22: Tap Unit 1 Indicator to Place Unit 1 on Standby

See the Using RCP M&C to Control an SSPA System section for information about mute and attenuation control of the
system amplifiers.
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RCP Remote Control of System SSPAs

RCP units that meet certain conditions are capable of remote control of system SSPAs through the RCP Local Serial Port
(J5).

  Note: The following features are supported only with firmware version 2.2.00 and above. To verify your
unit firmware version browse to the SysID screen on the front panel. If the firmware version is below
2.2.00, the unit's firmware can be upgraded to the proper version by the user.

Systems may contain up to three amplifiers (consisting of the Teledyne Paradise Datacom Compact Outdoor, Rack Mount
SSPAs, or vBUC amplifiers) and a remote RF Power Meter. The SSPAs and RF Power Meter must be connected to the RCP
Local Serial Port (J5) via RS485 4-wire or 2-wire interface. All connected components must utilize Teledyne Paradise
Datacom String Serial Protocol at 9600 Baud.

If properly configured, the RCP will allow the user to remotely change the Mute Status and Attenuation Level of the
connected units, and monitor the Output RF Power. Under such control, all connected units are exclusively controlled by the
RCP unit and any new unit added to the system will be automatically adjusted to the selected Attenuation Level and Mute
State.

Units equipped with firmware version 3.30 or later have extended remote system monitoring features, including the ability to
monitor and display individual unit temperature and ambient temperature (if the system is equipped with a Teledyne Paradise
Datacom remote RF Power Meter). Moreover, the unit has an additional option to mute a sub-system during the period of
switchover. See the Switch Mute Menu description in the Touchscreen Operation section.

  Note: The SSPA fault status is not controlled via the serial line, therefore all controlled SSPA summary
alarm lines still have to be connected to the RCP External Alarms Port (J8). A Teledyne Paradise Datacom
Remote RF Power Meter can be powered up either from the unit (when remote control mode is enabled, the
controller will automatically turn on its LNA/LNB Power supplies) or from an external DC power source
with the following characteristics: Output voltage +13/17/26V; Minimum Output Current 300 mA.

Starting with RCP firmware version 3.40, the controller supports External Reflected Power Monitoring. Monitor unit supports
measurement of overall system Reflected Power within 20 dBm range with ±1 dBm accuracy. The current value of the
Reflected power can be viewed on the first informative screen of subsystem menus or accessed through the remote control
interface. Outside of specified range, the accuracy of measurement is not guaranteed. If the supplied system is not equipped
with this feature, the monitor value of reflected power on the front panel VFD will indicated as "N/A".

Configuring the RCP for Remote Control Mode

The controller has to be configured to support remote control of the system. To do so, perform the following steps:

1. Tap the Home icon on the touchscreen;
2. Tap the Operation button;
3. Tap the System Type button;
4. Tick the appropriate checkbox depending on the type of system being controlled.

Tick the CO/HPO checkbox for control of a system of Compact or High Power Outdoor SSPAs.

Tick the Rack Mount checkbox if you want to control a system of Rack Mount SSPAs.

If controlling a system of vBUC amplifiers, tick the vBUC checkbox.

The System X selection is for custom system configurations, and should only be used at the direction of the factory.

Tick the PowerMAX checkbox if controlling a PowerMAX system.

To disable the remote control feature, select None.

After the unit is configured to control a remote system, make sure the system is correctly wired. See Tables 1 through 6 for
proper wiring.

Table 1: Wiring RCP2 J5 Serial Local for Compact Outdoor SSPA Systems

RCP2 J5 Serial Local SSPA1 M&C J4* SSPA2 M&C J4 SSPA3 M&C J4



1,9 (RX+; 120 Ohm Termination) T (TX+) T (TX+) T (TX+)

2 (RX-) E (TX-) E (TX-) E (TX-)

3 (TX-) F (RX-) F (RX-) F (RX-)

4 (TX+) U (RX+) U (RX+) U (RX+)

5 (Ground) B,V (Mute In, GND) B,V (Mute In, GND) B,V (Mute In, GND)

* If the cable length exceeds 50 ft., a termination resistor of 120 Ohms must be installed between F and U of the SSPA1
M&C J4 connector.

Table 2: Wiring RCP2 J8 External Alarm for Compact Outdoor SSPA Systems

RCP2 J8 Ext. Alarm SSPA1 M&C J4 SSPA2 M&C J4 SSPA3 M&C J4

1 (Ext. Alarm 1) b (Summary open on fault)

2 (Ext. Alarm 2) b (Summary open on fault)

3 (Ext. Alarm 3) b (Summary open on fault)

4 (Ground) a (Summary Common) a (Summary Common) a (Summary Common)

Table 3: Wiring RCP2 J5 Serial Local for Rack Mountable SSPA Systems

RCP2 J5 Serial Local SSPA1 Serial Main J4 SSPA2 Serial Main J4 SSPA3 Serial Main J4

1,9 (RX+; 120 Ohm
Termination) 1 (TX+) 1 (TX+) 1 (TX+)

2 (RX-) 2 (TX-) 2 (TX-) 2 (TX-)

3 (TX-) 3 (RX-) 3 (RX-) 3 (RX-)

4 (TX+) 4,9 (RX+; 120 Ohm
Termination)

4,9 (RX+; 120 Ohm
Termination)

4,9 (RX+; 120 Ohm
Termination)

5 (Ground) 5 (GND) 5 (GND) 5 (GND)

Table 4: Wiring RCP2 J8 External Alarm for Rack Mountable SSPA Systems

RCP2 J8 Ext. Alarm SSPA1 Serial Main J4 SSPA2 Serial Main J4 SSPA3 Serial Main J4

1 (Ext. Alarm 1) 8 (Summary open on fault)

2 (Ext. Alarm 2) 8 (Summary open on fault)

3 (Ext. Alarm 3) 8 (Summary open on fault)

4 (Ground) 7 (Summary Common) 7 (Summary Common) 7 (Summary Common)

Table 5: Wiring RCP2 J5 Serial Local for vBUC Systems

RCP2 J5 Serial Local vBUC1 Serial Main J4* vBUC2 Serial Main J4 vBUC3 Serial Main J4

1,9 (RX+; 120 Ohm
Termination) R (TX+) R (TX+) R (TX+)

2 (RX-) U (TX-) U (TX-) U (TX-)

3 (TX-) U (RX-) U (RX-) U (RX-)

4 (TX+) R (RX+) R (RX+) R (RX+)

5 (Ground) L (Isolated GND); J,K (Ext.
Mute, GND)

L (Isolated GND); J,K (Ext.
Mute, GND)

L (Isolated GND); J,K (Ext.
Mute, GND)

* If the cable length exceeds 50 ft., a termination resistor of 120 Ohms must be installed between R and U of the vBUC1
M&C J4 connector.

Table 6: Wiring RCP2 J8 External Alarm for vBUC Systems

RCP2 J8 Ext. Alarm vBUC1 M&C J4 vBUC2 M&C J4 vBUC3 M&C J4

1 (Ext. Alarm 1) D (Summary open on fault)

2 (Ext. Alarm 2) D (Summary open on fault)



3 (Ext. Alarm 3) D (Summary open on fault)

4 (Ground) F (Summary Common) F (Summary Common) F (Summary Common)

All attached units must be properly configured in order to work under RCP Remote Control. The following parameters must
be set for each unit:

Serial Protocol to "Normal" or "String";
Selected Baud Rate to 9600;
Type of Serial Interface to "RS485";
Unique address selected as follows:

SSPA1 = 1;
SSPA2 = 2;
SSPA3 = 3;
Remote RF Power Meter = 4.

Controlling PowerMAX Systems

Starting with firmware version 6.00, the controller has the capability to remotely control PowerMAX systems. The unit is
capable of simultaneous control of three independent PowerMAX systems. Each PowerMAX system must be configured for
Floating Master Mode (for details on this mode, see the PowerMAX manual).

As with control over an individual HPA, PowerMAX systems have to be configured for a specific Master response serial
address: 1, 2 and 3. Unique HPA chassis in the system must be set outside of the control address range. Recommended
addressing for individual chassis are: 11 to 18 for the first system; 21 to 28 for the second; and 31 to 38 for the third.

Each PowerMAX system will be viewed as single HPA unit and top level parameters will be monitored by the controller.

PowerMAX is essentially a N+1 redundancy system where any HPA chassis can perform the master controller functions. In
order for the controller to automatically connect to the current master unit, a RS-485 connection to all HPAs in the connected
systems must be provided.

Since the total number of connected units may reach 24 units, care must be observed when the RS-485 network is laid out.
Racks need to be daisy chained with 4-wire twisted pair cable and line termination enabled only on the farthest RS-485
node.

PowerMAX control mode is different from regular RM SSPA, therefore selection of the appropriate System Type for system
remote control is important.

1. Tap the Home icon on the touchscreen;
2. Tap the Operation button;
3. Tap the System Type button;
4. Tick the PowerMAX checkbox.

Using RCP M&C to Control an SSPA System

All SSPA control-related functions are grouped on the same menu, the SSPA control menu. To access the SSPA control
menu, tap the Home icon on the touchscreen, then tap the Unit Control button.

SSPA control of the system mute state and attenuation level is available from this menu. See Figure 23.

Figure 23: Unit Control Menu

All of the following steps describe RCP remote operation of an SSPA, and assume the user has already selected the SSPA
control menu.

Change Mute State

To change the overall mute state of a controlled SSPA system from the RCP, tap the Mute button, then tick either the Mute
System or Mute Off checkbox.

Beginning with firmware version 6.15, when the controller's System Mode (Home > Redundancy > System Mode) is set to
1:2 Mode, the following mute selections affect the mute state on each polarity as described below:

http://stc-ppapp-web02/Intranet/xml/216351draft/images/unit-control-menu.png
http://stc-ppapp-web02/Intranet/xml/216351draft/images/unit-control-menu.png


• Mute System - mutes both Polarity 1 (POL1) and Polarity 2 (POL2);
• Mute Off - unmutes both POL1 and POL2;
• Mute Pol 1 (1:2 Only) - mutes POL1 in 1:2 mode (firmware v. 6.15);
• Mute Pol 2 (1:2 Only) - mutes POL2 in 1:2 mode (firmware v. 6.15).

When any other system mode is selected, options Mute Pol 1 and Mute Pol 2 should be unavailable (greyed out). If one of
these options was selected before the System Mode was changed from 1:2 Redundant, the selection will perform the same
function as option Mute System, and will mute both POL1 and POL2.

If mute for the desired polarization is selected, the controller will automatically send a command to the HPA which is currently
connected to the relevant RF switch. Depending on a combination of RF switches and polarity preference settings, it could
be HPA1 or HPA2 for POL1, or HPA2 or HPA 3 for POL2. The controller will continue to sustain the selected mute state for
the chosen polarization even after manual or automatic switchover.

See the Switch Mute Menu description in the Touchscreen Operation section for detailed information about the Switch
Mute function.

Change Attenuation Level

To change the overall attenuation level of a controlled SSPA system from the controller, tap the Attenuation button. Enter the
desired level of attenuation and tap the OK button. The attenuation level will not change until the OK button is tapped.

Note that the user may also configure the Action Buttons to include the Attenuation button, from which changes made to the
attenuation value are immediately applied to the system.

Change RF Units Displayed

This option allows the user to select the RF Power measurement units (measured in either dBm or Watts) reported on the
front panel and remote interface. Both Forward and Reflected RF power sensor measurements will be affected.

1. Tap the Home icon on the touchscreen;
2. Tap the Operation button;
3. Tap the RF Units button;
4. Tick either the dBm or Watt checkbox.



Maintenance Switch Operation

Teledyne Paradise Datacom offers the option of utilizing the redundant system controller as a Maintenance Switch Controller,
which controls the position of a single waveguide switch.

A Maintenance Switch Controller is typically connected to the switch drive via a single cable. With systems using amplifiers
of certain high power levels, the controller could also be connected to the system SSPAs, so that the output of the amplifiers
can be temporarily muted during switchover to prevent arcing in the transmission line.

Operation Modes

The Maintenance Switch Controller controls the position of a switch at the output of the connected amplifier or amplifier
system. The position of the switch determines whether the output signal of the amplifier or amplifier system is directed to a
dummy load (the maintenance position), or to the system output.

Directing Output Signal to System Output

When the Amplfier icon is illuminated green, the green dotted line indicates the RF path passing through the amplifier and
switch to the system output. See Figure 24.

Figure 24: Maintenance Mode, RF Directed to System Output

Directing Output Signal to Dummy Load

Tap the Amplifier icon to signal the controller to change the position of the transfer switch. The Amplifier icon will turn white,
and the green dotted line indicating the RF path will pass through the amplifier and switch to the termination. See Figure 25.

Figure 25: Maintenance Mode, RF Directed to Dummy Load

Application of a Maintenance Switch Controller

Figure 26 shows a typical schematic for a standalone amplifier (HPA 1) utilizing a maintenance switch (SW1) at its output,
and a Maintenance Switch Controller.

Figure 26: Schematic, SSPA Utilizing Maintenance Switch and Controller
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Introduction

The redundant controller has been designed to be maintenance-free. The only user replaceable parts are the AC input fuses
and removable power supplies.



Fuse Replacement

The AC input fuses are 2 Amp Slow Blow style fuses and are accessible at the AC input entry module. Figure 1 shows the
location of the input fuses. The fuse part number is Littlefuse 217002, 2 Amp.

Figure 1: Controller Rear Panel, Fuse Locations
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Troubleshoot Power Supply Failures

A power supply fault is always considered a major fault, and will cause the front panel Summary Alarm and Power Supply
Alarm indicators to flash red. See Figure 1.

Figure 2: Controller Display Showing Power Supply Fault

To identify which power supply module is faulted, follow these steps:

1. Tap the Home icon on the touchscreen;
2. Tap the Status button;
3. Tap the Fault Panel button.

In the example shown in Figure 3, Power Supply 1 (PS1 Voltage) is showing a fault.

Figure 3: Controller Display Showing Fault Panel

To obtain more information about the state of the power supplies, follow these steps:

1. Tap the Home icon on the touchscreen;
2. Tap the Status button;
3. Tap the RCP Status button.

The resulting screen shows the measured voltages of both power supplies. In the case of the example shown in Figure 4,
Power Supply 1 shows a measured voltage of 21.9 V and Power Supply 2 shows 28.3 V.

Figure 4: Controller Display Showing RCP Status Info

The controller monitors the output voltage of each power supply module. If the output voltage level for a power supply is
above 23V, the fault indicator will illuminate green. If the output voltage drops below 22V, the fault indicator will illuminate red.

When looking at the back panel of the controller, PS1 is on the left and PS2 is on the right. Before removing a power supply,
ensure that the power cable to the supply is plugged in to a working outlet, and that the power switch of the supply is turned
on.

Remove Power Supply Module

To remove a faulted power supply module from the chassis, perform the following steps:

1. Unplug the line cord from the failed power supply;
2. Loosen the two captured thumbscrews securing the module to the chassis See Figure 5.;
3. Slide the module out of the chassis;
4. Unplug the quick-disconnect power pole connectors. See Figure 6.
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Figure 5: Loosen Thumbscrews and Slide Module from Chassis

Figure 6: Unplug Power Pole Connectors

Install New Power Supply Module

First, ensure that the new power supply module is the same type as the one being replaced! See the Power Supply
description in the Unit Description section to review the different power supply module types.

To install a new power supply module into the chassis, perform the following steps:

1. Plug together the quick-connect power pole connectors;
2. Slide the module into the chassis, taking care not to pinch the power cables;
3. Tighten the two captured thumbscrews to secure the module to the chassis.
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Restoring Factory Settings

The Teledyne Paradise Datacom Redundant System Controller comes with factory-preset settings specific to the default
system specifications. This factory setup can be restored at any time either automatically or manually.

  Important: Automatic restoration will restore complete factory setup (including COM settings and
miscellaneous fault handling). You will need to reconfigure any custom Communication settings specific
to your network.

See the instructions in the Touchscreen Operation section on how to save user settings from which you can restore to the
unit. There are two Backup repositories (User 1 and User 2) so you can save different configurations and quickly switch from
one to the other using the Restore menu.

Automatic Restore

To restore settings automatically, follow these simple steps:

1. Tap the Home icon on the touchscreen;
2. Tap the Options button;
3. Tap the System button;
4. Tap the Restore button;
5. Tap the Factory button.

Default factory setup is now restored.

Manual Restore

Manual setup restoration is dependent on the makeup of your specific system. To undertake a manual setup restoration,
follow these directions:

Set System Mode

1. Tap the Home icon on the touchscreen;
2. Tap the Redundancy button;
3. Tap the System Mode button;
4. Tick the checkbox for the system mode relevant to your system.

Set Fault Monitoring

1. Tap the Home icon on the touchscreen;
2. Tap the Fault Setup button;
3. Tap the Fault Monitor button;
4. Tick the SSPA Only checkbox if the controller is not supplying power to system LNBs; Tick the Both checkbox if the

controller must be configured as the primary power source for LNBs.

Set Fault Logic

1. Tap the Home icon on the touchscreen;
2. Tap the Fault Setup button;
3. Tap the Fault Logic button;
4. Tick the Fault on High checkbox.

Skip the following steps if the controller is not configured as a primary power source for the system's LNBs.

Re-calibrate LNBs Fault Window

Make sure the LNBs are reliably connected to the controller and that they are normally operational prior to system
calibration;

Make sure the controller is configured for tracking both LNA/LNB and external faults.

1. Tap the Home icon on the touchscreen;



2. Tap the Unit Control button;
3. Tap the Calibration LNBs button;
4. Tick the 8% Fault Window checkbox;
5. Observe the current measurements shown in the green windows on the display. If the current values are all normal,

tap the Cal buttons beneath each Unit display.

  You may need to re-enter all custom Communication settings specific to your network. See the
description of the various Communications parameters in the Touchscreen Operation section.



Firmware Programming

Teledyne Paradise Datacom's digital engineers continually strive to improve the performance of RCP2 software and
firmware. As this occurs, software and firmware upgrades are made available.

The DigiCore5 controller board allows two methods for upgrading the unit firmware:

• Upgrade over HTTP link by using web browser;
• Over programming USB connector J1.

The web upgrade is performed over the RCP2 IP port and does not require any special software. It can be performed
through any suitable web browser.

Upgrade over the USB port requires the installation of specific hardware USB drivers and batch scripts.

Required Hardware

The following equipment/hardware is necessary to perform the firmware upgrade.

• Depending on type of upgrade: Win7/XP PC with USB port or PC with available 10/100 Base-T port;
• Mini USB cable or Ethernet patch cable;

Required Software

For web upgrade:

• Web browser (IE, Chrome or Firefox);

For USB upgrade:

• USB FTDI VCP drivers. Drivers need to be installed before making a connection between the PC and the SSPA USB
programming port. Visit the FTDI web page (http://www.ftdichip.com/Drivers/VCP.htm) for the latest set of virtual COM port
(VCP) drivers.

• RCP2 field programing utility. Contact Teledyne Paradise Datacom technical support to obtain the latest version. The Field
Programming utility is typically not required for installation.
• Firmware image upgrade file: code.bin.

Web Upgrade Procedure

The web upgrade is the preferred method of upgrading the firmware.

Upgrading unit with incompatible firmware image may damage the equipment hardware. To ensure the proper firmware
image file is used, contact Teledyne Paradise Datacom technical support. Write down your current firmware version. You
may want also request image file of the current firmware in case it becomes necessary to revert back to the original.

Connect the unit to a 10/100 Base-T network or to a PC 10/100 Base-T network adapter. See the Ethernet Interface Set-Up
and Cabling section for proper Ethernet cable wiring.

Open a web browser window (Chrome, Firefox or IE are preferred). Enter the following address in the location window of the
browser:

XXX.XXX.XXX.XXX/fw/

where XXX.XXX.XXX.XXX is the IPv4 address of the unit. Press Enter.

The Upload Form is password protected. An authentication window should come up to ensure authorization. Use "admin" as
user name and the web logon password (default password is "paradise"). Click the "Log in" button (see Figure 7).
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Figure 7: Firmware Upgrade, Upload Form Login Window

The firmware upload form will load in the browser window (See Figure 8). Click the "Choose File" button and browse to
location of the firmware image code.bin file provided by technical support.

Figure 8: Firmware Upgrade, Upload code.bin File

Click the "Upload" button. A warning message will appear; click the "OK" button (See Figure 9).

Figure 9: Firmware Upgrade, Click 'OK' at Prompt to Proceed

The upload process will begin and the form will be informing about loading process (See Figure 10).

Figure 10: Firmware Upgrade, Upload Process Initiated

Do not interrupt this process and wait until its completion with positive or negative result. The process may take up to 15
minutes. When completed, the form will notify about end of process. See Figure 11.

Figure 11: Firmware Upgrade, Upload Process Complete

During the upgrade process, the unit remains fully functional. The new firmware will stay dormant until the next reboot of the
control card. Reboot the controller card by selecting the relevant front panel menu or by cycling power to the unit. Browse to
the front panel menu firmware information page and verify the installed version.

If the load process was interrupted, for any reason, the unit may not operate properly after a reboot. It is still possible to
recover from the problem by applying firmware upload over USB port. See the USB Port Upgrade Procedure for details.

USB Port Upgrade Procedure

Contact Teledyne Paradise Datacom support to obtain the latest firmware image and field programing utility. The
programming utility package includes an RFU upload utility, a script file and FTDI USB drivers. Use the USB upgrade method
only if the web upgrade has failed!
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Install FTDI VCP driver on the target PC;

Connect the USB mini port J1 at the back of unit to an available PC USB port.

  Warning! Connecting J1 to a PC USB will interrupt normal operation of the unit.

After connecting the unit, the target PC should recognize the newly connected hardware and connect to it using the
previously installed VCP FTDI drivers. Wait until this process is complete. Check the Windows device manager Ports section
and note the newly added USB Serial Port (See Figure 12). You will need a COM port designator in the next step.

Figure 12: Firmware Upgrade, Check Device Manager for COM Port Designator

Locate and run Upgrade.bat script file which was provided in firmware upgrade package. File will open command prompt
window and request the programing serial port designator. Enter the COM port designator located in previous step and then
press "Enter". The script file will start downloading a new image file to the unit. The resulting window is shown in Figure 13;

Figure 13: Firmware Upgrade, Command Prompt Window Progress

  Warning! Do not unplug the USB cable while the script is running.

When the script is completed, unplug the USB cable from the control card. The unit should restart with the new firmware
image.
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Advanced System Troubleshooting

The controller offers the ability to control various systems, which can include various subcomponents. In some cases it is
important to quickly pinpoint a faulty component without system disintegration. The controller offers such capabilities. The
following section describes the troubleshooting procedure for some systems.

Scenario 1

A 1:2 system contains devices connected to the RCP external port (SSPA) as well as an array of LNA devices connected to
the Plate assembly port. Major faults are configured to track both types of fault. Fault logic is set to "High". The controller
indicates a Unit1 fault.

To determine which component of the controlled setup is failed, tap the Home icon on the touchscreen, tap the Status button,
then tap the Fault Info button. Verify the status of the Aux Input State and SSPA Input state items. If the string of numbers
includes a "1", that indicates a fault on that Input State. See the Fault Info Menu description of the Touchscreen Operation
section.

If the faulted element is found in the LNA setup, the user can double-check what caused it. Perform the following steps:

1. Tap the Home icon on the touchscreen;
2. Tap the Unit Control button;
3. Tap the Calibrate LNA button;
4. The calibration points and current consumption for each LNA are displayed. Note whether value in the green fields

for each Unit falls between the low and high current values in the white boxes immediately below.

If the faulted element is found in the SSPA setup, double-check the fault causing the problem by tapping the Home icon, then
tapping the Fault Info button. Note the information shown in the "Last Flt. Cause" item.

Tap the Touch icon at the top right of the RF Signal Path Display. A new screen should open in the Menu area of the display
that shows the RF Power, DC Current and Temperature of each unit in the system. Total system information may also be
displayed if the system includes a forward and/or reflected power monitor.

Scenario 2

In a 1:2 SSPA system, three auxiliary devices are connected to the RCP external alarm port (J8). The controller utilizes "fault
on high" logic. Auxiliary faults are enabled. An auxiliary fault indicates a fault condition.

To find which auxiliary line indicates the fault, tap the Home icon on the touchscreen, tap the Status button, then tap the Fault
Info button. Review the string of numbers in the Aux Input State unit displayed.

If any auxiliary faults are present in the system, this item will show them in format ZYZYX, where X corresponds with
Auxiliary Alarm 1 (J8, pin 5), Y with Auxiliary Alarm 2 (J8, pin 6), and Z with Auxiliary Alarm 3 (J8, pin 7). A 0 indicates
normal (logic low state) operation and a 1 indicates a fault (logic high state) condition.

For example, a fault on Auxiliary Alarm 2 would display as 01010; faults on Auxiliary Alarms 1 and 3 would display as 10101.
A fault on Auxiliary Alarm 1 would display as 00001.

Teledyne Paradise Datacom
Drawing Number 216351-5 Revision B

ECO A26086
Last Modified: May 2022

UNCONTROLLED WHEN PRINTED!
You can view the latest revision of this manual section on the Teledyne Paradise Datacom web site:

http://www.paradisedatacom.com/xml/216351/216351-5.xml

USE AND DISCLOSURE OF DATA
EAR99 Technology Subject to Restrictions Contained in http://www.paradisedatacom.com/xml/216594/216594-1.xml.



THIS PAGE LEFT INTENTIONALLY BLANK



System Controllers with Touchscreen, Remote Control
Interface

Teledyne Paradise Datacom
Drawing Number: 216351-6 Revision B

ECO A26086
May 2022

UNCONTROLLED WHEN PRINTED!
You can view the latest revision of this manual section on the Teledyne Paradise Datacom web site:

http://www.paradisedatacom.com/xml/216351/216351-6.xml

USE AND DISCLOSURE OF DATA
EAR99 Technology Subject to Restrictions Contained in http://www.paradisedatacom.com/xml/216594/216594-1.xml.



Overview

A system which includes a system controller can be managed from a remote computer over a variety of remote control
interfaces (see Figure 1).

Figure 1: Remote Control Interface Stack

The parallel port on the unit provides a simple form of remote control. There are 10 Form C relay contacts for remote
monitoring. There are six opto-isolated inputs for remote control commands. To enable the remote parallel interface, select
Remote on the front panel Local/Remote key. When in Remote mode, all front panel commands are disabled with the
exception of the Local/Remote key. See the Remote Control - Parallel section.

The serial interface supports both RS-232 and RS-485 standards. The control protocol supports two formats:

• Normal serial protocol, as detailed in the Serial Communication section;

• ASCII-based protocol, suitable for HyperTerminal applications (see the Terminal Mode Serial Protocol section).

Serial interface is equipped with overvoltage and overcurrent protection and benefits from full galvanic isolation from the
chassis ground for extra protection.

The Ethernet interface supports multiple communication standards which can be used exclusively or simultaneously
depending on the selected setting:

• IPNet - UDP encapsulated Normal serial protocol;

• SNMP V1 with support of SNMP traps;

• HTTP web interface

Serial protocol format is set at no parity, 8 bit with 1 stop bit. Baud rate is selectable through the front panel.

If using a Terminal mode protocol, the controller provides remote menu access through a HyperTerminal program or through
an actual hardware terminal.

RS485 interface pin out is compatible with most 9-pin RS485 adapters. Interface always works in half-duplex mode and is
suitable for either 4- or 2-wire RS485 configuration. Maximum achievable node length for this interface is 1500 feet. Proper
termination and use of shielded twisted pair cable is required to achieve long cable runs

Ethernet interface is auto selectable between 10 and 100 MBits/s speeds. Maximum node length is 100 feet. Use of CAT5E
or CAT6 cables are preferred. CAT5 cable can be used for 10Base-T standard or short runs of 100Base-T.

Digicor5 digital platform controller allows simulations support of multiple remote control interfaces.

Table 1 shows a list of enabled interfaces depending on chosen interfaces setting.

Table 1: Interfaces Enabled Based on Chosen Interface Setting Selection

Interface Selection Supported Serial Interface Supported IP Interfaces

RS232 RS232 IPNet, Web M&C (read/write), SNMP (read/write)

RS485 RS485 IPNet, Web M&C (read/write), SNMP (read/write)
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IPNET RS485 IPNet, Web M&C (read/write), SNMP (read only)

SNMP RS485 Web M&C (read only), SNMP (read/write)

Serial protocol is an independent selection and allows support of Normal or Terminal mode protocols. Operation over IP
interface remains unchanged regardless of serial protocol selection.

Digicor5 digital platform controller allows simulations support of multiple remote control interfaces.

Serial protocol is an independent selection and allows support of Normal or Terminal mode protocols. Operation over IP
interface remains unchanged regardless of serial protocol selection.



Remote Control - Parallel

Control Outputs

The hardware behind the form C relay is a single pole, double throw relay. Under normal operation (no alarms) the relays are
in an energized state. When a fault occurs or the controller is powered off, the relays are in a de-energized state. The relay
contacts are capable of handling a maximum of 30 VDC @ 1A . The form C relay is shown schematically in Figure 2. The
form C relay contact outputs are listed in Table 2.

Figure 2: Parallel I/O Form C Relay

Control Inputs

The parallel control inputs are opto-isolated inputs with pull up resistors. To trigger a remote input command, the input should
be pulled to ground. The input does not need to be held to ground continuously but it is acceptable to do so. The input only
need be pulled low for a minimum of 20 msec. For example, to make amplifier #2 the standby amplifier, pulse pin 36 to
ground for 20 msec. If the operator then chooses to make amplifier #1 the standby amplifier, simply pulse pin 37 to ground
for 20 msec. The schematic representation of the control input is shown in Figure 3.
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Figure 3: Opto-isolated Parallel I/O Input

The external alarm and auxiliary alarm inputs use the same opto-isolated input circuitry shown in Figure 3.
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Serial Communication

This section describes the normal communication protocol between the controller and a host computer over RS232/RS485
serial interface. Serial port settings on host computer must be configured for 8-bit data at no parity, with 1 stop bit. Baud rate
should match selected baud rate parameter on unit.

The unit will only respond to properly formatted protocol packets. Figure 4 shows the basic communication packet. It consists
of a Header, Data, and Trailer sub-packet.

Figure 4: Basic Serial Communication Packet

Header Packet

The Header packet is divided into three sub-packets which are the Frame Sync, Destination Address, and Source Address
packets, as shown in Figure 5.

Figure 5: Header Sub-Packet

Frame Sync Word

The Frame Sync word is a two byte field that marks the beginning of a packet. This value is always 0xAA55. This field
provides a means of designating a specific packet from others that may exist on the same network. It also provides a
mechanism for a node to synchronize to a known point of transmission.

The destination address field specifies the node for which the packet is intended. It may be an individual or broadcast
address. The broadcast address is 0xFF or 0xAA. This is used when a packet of information is intended for several nodes on
the network. The broadcast address can be used in a single device connection when the host needs to determine the
address of the amplifier. The unit will reply with its unique address.

Source Address

The source address specifies the address of the node that is sending the packet. All unique addresses, except the broadcast
address, are equal and can be assigned to individual units. The host computer must also have a unique network address.

Data Packet

The data sub-packet is comprised of six to 32 bytes of information. It is further divided into seven fields as shown in Figure 6.
The first six fields comprise the command preamble while the last field is the actual data.

Figure 6: Data Sub-Packet
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Protocol ID

This field provides backward compatibility with older generation equipment protocol. It should normally be set to zero. This
field allows the unit to auto-detect other protocol versions, which may exist in the future.

Request ID

This is an application specific field. The amplifier will echo this byte back in the response frame without change. This byte
serves as a request tracking feature.

Command

The RCP2 protocol is a table based protocol. It allows the user to view and modify data tables located on the controlled
device. Throughout the remainder of this description, "sender" will refer to the host PC, and "receiver" will refer to the unit.

Sender and receiver are limited to two commands and two command responses. The Get Request command issued by a
command sender allows monitoring of existing conditions and parameters on the receiver. The Get Request frame should
not have any bytes in the Data Field and be no longer than 11 bytes.

The Response frame from the receiver will contain a Get Response designator in the Command field. If the receiver does not
detect any errors in the Get Request frame, the requested data will be attached to the response frame. The length of the Get
Response frame varies by the amount of attached data bytes. It may contain 11+N bytes where N is the amount of requested
data bytes from a particular table, specified in the Data Length field.

The Set Request command allows the sender to actively change parameters for the receiver's internal configuration. The Set
Request frame must contain a number of bytes in the Data Field as specified in the Data length field. The frame size must be
11+N bytes, where N is the length of the attached data structure. The receiver will respond with a frame where the command
field will be set to a Set Response designator. The frame length is equal to the Request frame.

The byte value for each command is given in Table 2.

Table 2: Command Byte Values

Command Name Command Byte Value

Set Request 0

Get Request 1

Set Response 2

Get Response 3

Data Tag

The controller internal structure is organized in several tables, all of which share similar functionality and internal resources.
To access the various tables, the data tag must be specified in the request frame. The data associated with certain tags is
read only. Therefore only the "Get" command request would be allowed to access these data tags. The controller will return
an error on attempts to issue a "Set" request to a read-only table tag. Various tables may contain values formatted either in 1
or 2 bytes format. The data tag byte values are given in Table 3.

Table 3: Data Tag Byte Values

Tag Name
Data Tag

Byte
Value

Min. Valid
Length of
Data Field

Description

Systems
Settings Tag 0 1 Byte

This tag allows accessing various system settings on remote unit. Host
access status: Full Read/Write access. Settings can be modified at any

time. Some of the settings may require hardware reset of the remote unit.

System
Thresholds Tag 1 2 Bytes This tag allows access to the critical unit thresholds. Host access status:

Tag have read only status.

System
Conditions Tag 3 1 Byte

This tag allows access to the unit's internal conditions flags, such as fault
status or current system status. Host access status: Read only. This type of

the data can not be set or modified remotely.

ADC Channels
Access Tag 4 2 Bytes ADC legacy access. Don't use for new development

Reserved 6 N/A This tag is reserved.

Reserved 2 N/A This tag is reserved.

Reserved 5 N/A This tag is reserved for factory use only.



Special
Command Tag

(v.6.00)
10 N/A This tag is reserved for factory use only.

Data Address / Error Status / Local Port Frame Length

This field is a tag extension byte and specifies the first table element of the tagged data. If the Data Length is more than 1
byte, then all subsequent data fields must be accessed starting from the specified address. For example, if the requestor
wants to access the amplifier's unique network address, it should set data tag 0 (System settings tag) and data address 8
(see Table 7, System Settings Details table). If the following Data Length field is more than 1, then all subsequent Settings
will be accessed after the Unique Network Address.

  Important! In any response frame, the Data Address field is replaced with the Error Status information.
The various error codes are given in Table 4.

Table 4: Error Status Byte Values

Error Code Name Byte
Value Possible Cause

No Errors 0 Normal Condition, no errors detected

Data Frame Too Big 1 Specified Data length is to big for respondent buffer to accept

No Such Data 2 Specified Data Address is out off bounds for this tag data

Bad Value 3 Specified value not suitable for this particular data type

Read Only 4 Originator tried to set a value which has read only status

Bad Checksum 5 Trailer checksum not matched to calculated checksum

Unrecognizable
Error 6 Error presented in originator frame, but respondent failed to recognize it. All data

aborted.

Data Length

This byte value specifies the number of bytes attached in the Data Field. For the Get command, it specifies the number of
data bytes that has to be returned by the unit to a host PC in the Response frame. For the Set command, the value of this
byte specifies the number of data fields to be accessed starting from the address specified in the Data Address byte. In
general, Data Length value plus Data Address must not exceed the maximum data size particular tag.

Data Field

The actual data contained in the packet must be placed in this field. The "Get Request" type of command must not contain
any Data Field. "Get Request" will be rejected if any data is present in the Data Field. Generally, the Bad Checksum error
code will be added to the response from the unit. In case the data length is 2 bytes, each data word is placed in the frame
with its least significant byte first. All data with length of 2 bytes must be represented as integer type with maximum value
range from 32767 to (-32767).

Trailer Packet

The trailer component contains only one byte called the Frame Check Sequence. This field provides a checksum during
packet transmission. See Figure 7.

Figure 7: Trailer Sub-Packet

Frame Check Sequence

http://stc-ppapp-web02/Intranet/xml/216351draft/images/trailer-packet.png
http://stc-ppapp-web02/Intranet/xml/216351draft/images/trailer-packet.png


This value is computed as a function of the content of the destination address, source address and all Command Data
Substructure bytes. In general, the sender formats a message frame, calculates the check sequence, appends it to the
frame, then transmits the packet. Upon receipt, the destination node recalculates the check sequence and compares it to the
check sequence embedded in the frame. If the check sequences are the same, the data was transmitted without error.
Otherwise an error has occurred and some form of recovery should take place. In this case the amplifier will return a packet
with the "Bad Checksum" error code set. Checksums are generated by summing the value of each byte in the packet while
ignoring any carry bits. A simple algorithm is given as:

Chksum=0 
FOR byte_index=0 TO byte_index=packet_len-1 

Chksum=(chksum+BYTE[byte_index]) MOD 256 
NEXT byte_index

Timing Issues

There is no maximum specification on the inter-character spacing in messages. Bytes in messages to amplifier units may be
spaced as far apart as you wish. The amplifier will respond as soon as it has collected enough bytes to determine the
message. Generally, there will be no spacing between characters in replies generated by units. The maximum length of the
packet sent to the amplifier node should not exceed 64 bytes, including checksum and frame sync bytes. Inter-message
spacing, must be provided for good data transmission. The minimum spacing should be 100 ms. This time is required for the
controller to detect a "Line Cleared" condition with half duplex communications. Maximum controller respond time is 200 ms.



Serial Communications Protocol

Table 5 through Table 9 detail the values of the serial communications protocol.

Table 5: Request Frame Structure

Byte Tag Description

1 0xAA Frame Sync 1

2 0x55 Frame Sync 2

3 Destination
Address -// -

4 Source Address -// -

5 Protocol Version Protocol Compatibility Byte, must be set 0

6 Request ID Service Byte

7 Command 0 = Set Request; 1 = Get Request

8 Data Tag 0 = System Settings; 1 = System Thresholds; 2 = Reserved; 3 = Conditions; 4 = ADC Data; 5
= Reserved

9 Data Address Setting number, Sensor command, EEPROM address

10 Data Length Total length of the data, valid values: 1 - 10

11+N Data Actual Data

11+N+1 Checksum Destination Address + Source Address + Protocol Version + Request ID + Command + Data
Tag + Data Address + Data Length + Data

Table 6: Response Frame Structure

Byte Tag Description

1 0xAA Frame Sync 1

2 0x55 Frame Sync 2

3 Destination
Address -// -

4 Source Address -// -

5 Protocol Version Protocol Compatibility Byte, must be set 0

6 Request ID Service Byte

7 Command 2 = Set Response; 3 = Get Response

8 Data Tag 0 = System Settings; 1 = System Thresholds; 2 = Reserved; 3 = Conditions; 4 = ADC Data; 5
= Reserved

9 Error Status 0 = No Errors, 1 = Too Big, 2 = No Such Data, 3 = Bad Value, 4 = Read Only, 5 = Bad
Checksum; 6 = Unrecognized Error

10 Data Length Total length of the data, valid values: 1 - 10

11+N Data Actual Data

11+N+1 Checksum Destination Address + Source Address + Protocol Version + Request ID + Command + Data
Tag + Data Address + Data Length + Data

Table 7: System Settings Data Values

Data
Address

#
Bytes Description Limits and Byte Values

1 1 System Configuration
0 = 1:2 Controller; 1 = 1:1 Controller; 2 = 1:1 Phase

combine; 3 = Dual 1:1 Controller; 4 = Maintenance Mode; 5
= 1:2 Phase combine (v. 6.00)

2 1 Switching Mode 0 = Auto Mode; 1 = Manual Mode; 2 = Lock Mode (v. 6.00)

3 1 Control Mode 0 = Local; 1 = Remote

4 1 Reserved N/A



5 1 Priority Select 0 = Pol1; 1 = Pol2

6 1 Communication Protocol * 0 = Normal; 1 = Terminal (v. 4.00)

7 1 Baud Rate * 0 = 9600; 1 = 2400; 2 = 4800; 3 = 19200; 4 = 38400

8 1 Unique network address Valid values: 0 - 255

9 1 Type of Serial Interface * 0 = RS232; 1 = RS485; 2 = IPnet; 3 = SNMP (v. 4.00)

10 1 Type of Fault Monitoring 0 = SSPA only; 1 = LNA only; 2 = Both; 3 = SSPA Com
Faults (v. 6.00)

11 1 Auxiliary Fault Monitoring
0 = Enable non-switching faults; 1 = Ignore; 2 = Enable non-
switching faults, inverted logic; 3 = Enable switching faults

(v. 6.00); 4 = Enable switching faults, inverted logic (v. 6.00)

12 1 RF Switch Monitoring 0 = Major Fault; 1 = Alert Only; 2 = Alternate (v. 3.30)

13 1 Fault Latching 0 = Latch Enable; 1 = Latch Disable

14 1 Fault Window 0 = 20%; 1 = 8%; 2 = 12%, 3 = 15%

15 1 Fault Logic 0 = Fault on Low; 1 = Fault on High

16 1 User Password Valid Values=0 to 255

17 1 Amplifier Standby Configuration
0 = Amplifier 2 on Standby (default); 1 = Amplifier 1 on
Standby; 2 = Amplifier 2 on Standby; 3 = Amplifier 3 on

Standby

18 1 Buzzer 0 = Enable Buzzer; 1 = Disable Buzzer

19 1 Password Protection 0 = Protection Off; 1 = Protection On

20 1 System Type 0 = None; 1 = Compact Outdoor; 2 = Rack Mount; 4 =
vBUC; 5 = SystemX; 6 = PowerMAX (v. 6.00)

21 1 RF Power Units 0 = Measure RF in dBm; 1 = Measure RF in Watts (v. 3.50)

22 1 Reserved N/A

23 1 LNA/LNB PS Output Voltage
0 = Low range 13V, 900 mA; 1 = High range 17V, 900 mA; 2
= High Power Range 24V, 0.9A/1.5A (Standard/HP version

only)

24 1 Standby Mode 0 = Hot Standby; 1 = Cold Standby (v. 6.00)

25 1 Mute State 0 = Mute On; 1 = Mute Pol1 (1:2 only) (v. 6.15); 2 = Mute
Pol2 (1:2 only) (v 6.15); 255 = Mute Off

26 1 Remote SSPA Attenuation Valid Values= 0 to 255 (v. 3.10 dBx10 value)

27 1 Switch Mute 0 = Off; 1 = Internal; 2 = External; 3 = All on (v. 3.30)

28 1 Fault Tolerance 0 = Disabled; 1 = One Fault; 2 = Two Faults (v. 3.70)

29-32 4 IP Address (MSB - LSB) *

Settings required for normal operation of IP interface.
Consult network administrator for a proper setup. All settings

physically located on the RCP unit. Changes to these
settings effective only after controller restart. (v. 4.00)

33-35 4 IP Gateway (MSB - LSB) *

Settings required for normal operation of IP interface.
Consult network administrator for a proper setup. All settings

physically located on the RCP unit. Changes to these
settings effective only after controller restart. (v. 4.00)

36-40 4 IP Subnet Mask (MSB - LSB) *

Settings required for normal operation of IP interface.
Consult network administrator for a proper setup. All settings

physically located on the RCP unit. Changes to these
settings effective only after controller restart. (v. 4.00)

41-42 2 Receive IP Port (MSB - LSB) *

Settings required for normal operation of IP interface.
Consult network administrator for a proper setup. All settings

physically located on the RCP unit. Changes to these
settings effective only after controller restart. (v. 4.00)

43-46 4 IP Lock Address (MSB - LSB) *

Settings required for normal operation of IP interface.
Consult network administrator for a proper setup. All settings

physically located on the RCP unit. Changes to these
settings effective only after controller restart. (v. 4.00)



47-49 3

Individual SSPA Unit Attenuation Offset.
Sum of Offset value and Remote SSPA

Attenuation value (Data Address 26)
must be ≤ 20

Valid Values= 0 to 255 (v. 4.20)

* Requires hardware reset

Table 8: System Condition Data Values

Data
Address

#
Bytes Description Limits and Byte Values

1 1 Unit 1 Fault State 0 = No Fault; 1 = Fault; 2 = Ignored

2 1 Unit 2 Fault State 0 = No Fault; 1 = Fault; 2 = Ignored

3 1 Unit 3 Fault State 0 = No Fault; 1 = Fault; 2 = Ignored

4 1 Summary Fault 0 = No Fault; 1 = Fault

5 1 Power Supply 1 Fault State 0 = No Fault; 1 = Fault

6 1 Power Supply 2 Fault State 0 = No Fault; 1 = Fault

7 1 Auxiliary Input Fault State 0 = No Fault; 1 = Fault; 2 = Ignored

8 1 External Port State Bit 0-2 = SSPA Input lines; Bit 3-8 = Auxiliary Input lines

9 1 LNA Faults
Bit 0 = 1, Faults enabled; Bit 0 = 0, Faults disabled; Bit 1 = 1,
Unit 1 Fault; Bit 2 = 1, Unit 2 Fault; Bit 3 = 1, Unit 3 Fault; Bits

1-3 = 0, No Fault

10 1 SSPA Faults
Bit 0 = 1, Faults enabled; Bit 0 = 0, Faults disabled; Bit 1 = 1,
Unit 1 Fault; Bit 2 = 1, Unit 2 Fault; Bit 3 = 1, Unit 3 Fault; Bits

1-3 = 0, No Fault

11 1 RF Switch 1 Position 1= Switch Fault; 2 = Switch Ignore; 3 = Position 1; 4 = Position
2

12 1 RF Switch 1 Position 1= Switch Fault; 2 = Switch Ignore; 3 = Position 1; 4 = Position
2

13-14 2
Forward RF Power (available only

with systems equipped with Forward
RF power meter)

If Setting RF Power Units = 0, Value x 10dBm; If Setting RF
Power Units = 1, Value x 10 W; (See Table 7, Data Address 21

for details) (-100 for N/A (0xFF9C)); Low Byte First (v. 3.10)

15-16 2

Ambient Temperature (in °C)
(available only with systems

equipped with Forward RF power
meter)

Value x 1 °C; N/A=0xFF9C (if parameter is not available at
present time); Low Byte First (v. 3.10)

17-18 2
Core Temperature of SSPA Unit 1
(available only with systems with
remote SSPA control enabled)

Value x 1 °C; N/A=0xFF9C (if parameter is not available at
present time); Low Byte First (v. 3.10)

19-20 2
Core Temperature of SSPA Unit 2
(available only with systems with
remote SSPA control enabled)

Value x 1 °C; N/A=0xFF9C (if parameter is not available at
present time); Low Byte First (v. 3.10)

21-22 2
Core Temperature of SSPA Unit 3
(available only with systems with
remote SSPA control enabled)

Value x 1 °C; N/A=0xFF9C (if parameter is not available at
present time); Low Byte First (v. 3.10)

23-24 2
Reflected RF Power (available only

with systems equipped with
Reflected RF power meter)

If Setting RF Power Units = 0, Value x 10dBm; If Setting RF
Power Units = 1, Value x 10 W; (See Table 7, Data Address 21

for details) (-100 for N/A (0xFF9C)); Low Byte First (version
3.30)

25-26 2 DC Current (Unit 1 in Amps) Value x 10 Amp; N/A=0XFF9C; Low Byte First (v. 3.60)

27-28 2 DC Current (Unit 2 in Amps) Value x 10 Amp; N/A=0XFF9C; Low Byte First (v. 3.60)

29-30 2 DC Current (Unit 3 in Amps) Value x 10 Amp; N/A=0XFF9C; Low Byte First (v. 3.60)

31-32 2 Forward RF Power (Unit 1 in dBm) Value x 10 dBm; N/A=0XFF9C; Low Byte First (v. 3.60)

33-34 2 Forward RF Power (Unit 2 in dBm) Value x 10 dBm; N/A=0XFF9C; Low Byte First (v. 3.60)

35-36 2 Forward RF Power (Unit 3 in dBm) Value x 10 dBm; N/A=0XFF9C; Low Byte First (v. 3.60)

Table 9: System Threshold Data Values



Data
Address

#
Bytes Description Limits and Byte Values

1 2 LNA Unit 1 Calibration
Data

Point conversion: 0.57 mA per 1 value increment, maximum value =4095
(2.3A) (read/write)

2 2 LNA Unit 2 Calibration
Data

Point conversion: 0.57 mA per 1 value increment, maximum value =4095
(2.3A) (read/write)

3 2 LNA Unit 3 Calibration
Data

Point conversion: 0.57 mA per 1 value increment, maximum value =4095
(2.3A) (read/write)

4 2 LNA Unit 1 DC Current Point conversion: 0.57 mA per 1 value increment, maximum value =4095
(2.3A) (v6.00) (read only)

5 2 LNA Unit 2 DC Current Point conversion: 0.57 mA per 1 value increment, maximum value =4095
(2.3A) (v6.00) (read only)

6 2 LNA Unit 3 DC Current Point conversion: 0.57 mA per 1 value increment, maximum value =4095
(2.3A) (v6.00) (read only)

7 2 LNA Unit 1 DC Voltage Point conversion: 0.1 V per 1 value increment, maximum value =1023
(v6.00) (read only)

8 2 LNA Unit 2 DC Voltage Point conversion: 0.1 V per 1 value increment, maximum value =1023
(v6.00) (read only)

9 2 LNA Unit 3 DC Voltage Point conversion: 0.1 V per 1 value increment, maximum value =1023
(v6.00) (read only)

10 2 PS1 DC Voltage Point conversion: 0.1 V per 1 value increment, maximum value =1023
(v6.00) (read only)

11 2 PS2 DC Voltage Point conversion: 0.1 V per 1 value increment, maximum value =1023
(v6.00) (read only)

12 2 RCP Chassis
Temperature Value x 1 °C (v6.00) (read only)



Examples

This section contains several examples of serial data exchange between a host computer and an RCP 1:2 Redundant
Controller. All byte values are given in hexadecimal format. The following controller and system switch positions are used
throughout all examples.

RCP2-1200 Network Address = 0 
Host Computer Network Address = 0xA
Request ID = 0x6F

 
Amplifier Status
  Amplifier #1= OK
  Amplifier #2= Faulted
  Amplifier #3= OK 

Power Supply Status
  Power Supply #1=OK
  Power Supply #2=OK

Auxiliary Fault Inputs = Faulted

RF Switch Status
  Switch #1 Position = Position 1
  Switch #2 Position = Undetermined or Faulted

Example 1

The host computer requests the RCP system conditions. The RCP detects no errors in the request frame and issues a
response. The PC request string is listed below.

Table 10: Example 1: PC Requests RCP System Conditions

Byte
Position

Byte Value
(Hex) Description

1 AA Frame Sync Byte 1

2 55 Frame Sync Byte 2

3 0 Destination Address of RCP unit

4 A Source address of Request originating PC Host

5 0 Protocol Version Compatibility Field must always be 0

6 6F Request ID byte is set by originator, will be echoed back by respondent

7 1 Command field for "Get" type request

8 3 "System Conditions" tag indicates which data from respondent required in response frame

9 1 Data Address field indicates the beginning data address inside of the "System Conditions" data
set to 1 (first element)

10 C Data Length field indicates how many data bytes of the "System Conditions" requested from
RCP2 (12 (C) is all available data of "System Conditions" type)

11 8A Arithmetic checksum of bytes number 3 through 10

The RCP replies with the following response string.

Table 11: Example 1: RCP Response (System Conditions)

Byte
Position

Byte
Value
(Hex)

Description



1 AA Frame Sync Byte 1

2 55 Frame Sync Byte 2

3 A Destination Address of PC request originator

4 0 Source address of RCP respondent

5 0 Protocol Version Compatibility Field must always be 0

6 6F Echo of the Originator's Request ID byte

7 3 Command field for "Get" type response

8 3 "System Conditions" tag indicates which data from respondent included in response frame.

9 0 Data Address field omitted and replaced with Error status code. 0 in this field indicates absence of
errors.

10 C Data Length field indicates how many data bytes of the "System conditions" requested from RCP
(12 (C) is all available data of "System Conditions" type).

11 0 Data field 1 contains data element 1 of "System Conditions" data type, which is RCP System
Unit1 Fault State. 0 Indicates that Unit 1 is not faulted.

12 1 Data field 2 contains data element 2 of "System Conditions" data type, which is RCP System
Unit2 Fault State. 1 Indicates that Unit 2 is in fault condition.

13 0 Data field 3 contains data element 3 of "System Conditions" data type, which is RCP System
Unit3 Fault State. 0 Indicates that Unit 3 is not faulted.

14 1 Data field 4 contains data element 4 of "System Conditions" data type, which is RCP System
Summary Fault State. 1 Indicates presence of faults in the system.

15 0
Data field 5 contains data element 5 of "System Conditions" data type, which is RCP System

Power Supply 1 Fault State. 0 Indicates that Power supply 1 is not faulted and functioning
properly.

16 0
Data field 6 contains data element 6 of "System Conditions" data type, which is RCP System

Power Supply 2 Fault State. 0 Indicates that Power supply 2 is not faulted and functioning
properly.

17 1 Data field 7 contains data element 7 of "System Conditions" data type, which is RCP System
Auxiliary Fault State. 1 Indicates presence of faults on one of the Auxiliary Inputs.

18 FF Data field 8 contains data element 8 of the "System Conditions" data type. This data element is
reserved for future applications.

19 FF Data field 9 contains data element 9 of the "System Conditions" data type. This data element is
reserved for future applications.

20 FF Data field 10 contains data element 10 of the "System Conditions" data type. This data element is
reserved for future applications.

21 3 Data field 11 contains data element 11 of the "System Conditions" data type, which is RF Switch 1
state. 3 Indicates that RF Switch 1 is in Position 1.

22 1
Data field 12 contains data element 12 of the "System Conditions" data type, which is RF Switch

2 state. 1 Indicates that RF Switch 2 is has a fault condition or its position can't be reliably
determined.

23 8F Arithmetic checksum of bytes number 3 through 22

Example 2

The host computer requests the RCP system thresholds. The request string is:

Table 12: Example 2: PC Requests RCP System Thresholds

Byte
Position

Byte Value
(Hex) Description

1 AA Frame Sync Byte 1

2 55 Frame Sync Byte 2

3 0 Destination Address of RCP unit

4 A Source address of Request originating PC Host

5 0 Protocol Version Compatibility Field must always be 0



6 6F Request ID byte is set by originator, will be echoed back by respondent

7 1 Command field for "Get" type request

8 1 "System Thresholds" tag indicates which data from respondent required in response frame

9 1 Data Address field indicates the beginning data address inside of the "System Conditions" data
set to 1 (first element)

10 6 Data Length field indicates how many data bytes of the "System Thresholds" requested from
RCP2 (6 is all available data of "System Thresholds" type)

11 82 Arithmetic checksum of bytes number 3 through 10

The RCP replies with the following response string:

Table 13: Example 2: RCP Response (System Thresholds)

Byte
Position

Byte
Value
(Hex)

Description

1 AA Frame Sync Byte 1

2 55 Frame Sync Byte 2

3 A Destination Address of PC request originator

4 0 Source address of RCP respondent

5 0 Protocol Version Compatibility Field must always be 0

6 6F Echo of the Originator's Request ID byte

7 3 Command field for "Get" type response

8 1 "System Thresholds" indicates which data from respondent is included in response frame

9 0 Data Address field omitted and replaced with Error status code. 0 = no errors.

10 6 Data Length field indicates how many data bytes "System Thresholds" requested from RCP (6 is
all available data of "System Thresholds" type)

11 D1 Data field 1 contains least significant byte of data element 1 of "System Thresholds" data type,
which is LNA 1 cal. point

12 0
Data field 2 contains most significant byte of data element 1 of "System Thresholds" data type,

which is LNA 1 cal. point. Data can be normalized to LNA current as follows: Lna1calpoint *
0.57mA/point = 209*0.57 = 119.13 mA

13 F Data field 3 contains least significant byte of data element 2 of "System Thresholds" data type,
which is LNA 2 cal. point

14 0
Data field 4 contains most significant byte of data element 2 of "System Thresholds" data type,
which is LNA 2 cal. point. Data can be normalized to LNA current as follows: Lna1 cal point *

0.57mA/point = 216*0.57 = 123.12 mA

15 DC Data field 5 contains least significant byte of data element 3 of "System Thresholds" data type,
which is LNA3 cal. point.

16 0
Data field 6 contains most significant byte of data element 2 of "System Thresholds" data type,
which is LNA 3 cal. Point. Data can be normalized to LNA current as follows: Lna1 cal point *

0.57mA/point = 220*0.57 = 125.4 mA

17 8 Arithmetic checksum of bytes number 3 through 16

Example 3

The host computer requests the RCP network address. The PC request string is listed below.

Table 14: Example 3: PC Requests RCP Network Address

Byte
Position

Byte Value
(Hex) Description

1 AA Frame Sync Byte 1

2 55 Frame Sync Byte 2

3 FF Destination Address is broadcast network address



4 A Source address of Request originating PC Host

5 0 Protocol Version Compatibility Field must always be 0

6 6F Request ID byte is set by originator, will be echoed back by respondent

7 1 Command field for "Get" type request

8 0 "System Settings" tag indicates which data from respondent required in response frame

9 8 Data Address field indicates the address of the RCP2's network address inside "System
Settings" data set to 8

10 1 Data Length field indicates how many data bytes "System Settings" requested from RCP (1
byte requested)

11 82 Arithmetic checksum of bytes number 3 through 10

The RCP replies with the following response string.

Table 15: Example 3: RCP Response (Network Address)

Byte
Position

Byte Value
(Hex) Description

1 AA Frame Sync Byte 1

2 55 Frame Sync Byte 2

3 A Destination Address of PC request originator

4 0 Source address of RCP respondent

5 0 Protocol Version Compatibility Field must always be 0

6 6F Request ID byte is set by originator, will be echoed back by respondent

7 3 Command field for "Get" type of the response

8 0 "System Settings" indicates which data from respondent is included in response frame

9 0 Data Address field omitted and replaced with Error status code. 0 in this field indicates
absence of errors

10 1 Data Length field indicates how many data bytes "System Settings" requested from RCP

11 0 Data field 1 contains data element 8 of "System Settings" data type. "Unique Network
Address"=0

12 7D Arithmetic checksum of bytes number 3 through 11

Example 4

The host computer requests the Priority be set to Polarity #2. The PC request string is listed below.

Table 16: Example 4: PC Requests RCP Priority Set to Polarity #2

Byte
Position

Byte Value
(Hex) Description

1 AA Frame Sync Byte 1

2 55 Frame Sync Byte 2

3 0 Destination Address of RCP unit

4 A Source address of Request originating PC Host

5 0 Protocol Version Compatibility Field must always be 0

6 6F Request ID byte is set by originator, will be echoed back by respondent

7 0 Command field for "Set" type request

8 0 "System Settings" indicates which data from respondent is required in response frame

9 5 Data Address field indicates the address of the RCP's Priority Select data element inside
"System Settings" (data element 5)

10 1 Data Length field indicates how many data bytes of the "System Conditions" requested from
RCP2 (1 byte requested)



11 1 Data Field 1. 1 Indicates that priority must be set to Pol2

12 7F Arithmetic checksum of bytes number 3 through 11

The RCP replies with the following response string.

Table 17: Example 4: RCP Response (Priority Set Failed)

Byte
Position

Byte Value
(Hex) Description

1 AA Frame Sync Byte 1

2 55 Frame Sync Byte 2

3 A Destination Address of PC request originator

4 0 Source address of RCP respondent

5 0 Protocol Version Compatibility Field must always be 0

6 6F Echo of the Originator's Request ID byte

7 2 Command field for "Set" type response

8 0 "System Settings" indicates which data from respondent is included in response frame

9 2 Data Address field omitted and replaced with Error status code. 2 indicates "No such
data" error

10 1 Data Length field indicates how many data bytes "System Settings" requested from RCP

11 0 Data field 1 contains rejected data

12 7E Arithmetic checksum of bytes number 3 through 11



Terminal Mode Serial Protocol

The Teledyne Paradise Datacom RCP Redundant System Controller utilizes Terminal Mode Serial Protocol (TMSP) as a
secondary serial protocol for Management and Control through a Remote Serial Interface.

TMSP allows the user to access internal RCP functions via a remote ASCII Terminal or its equivalent (such as HyperTerminal
for Windows). TMSP is accomplished through either the RS-232 or RS-485, half duplex, serial communication link.

U.S. ASCII encoded character strings are used to represent commands and data messages. A remote terminal or controller
initiates a communication session and the RCP takes action and returns a report of requested status. The controller will not
initiate communication and will transmit data only when commanded to do so. Prior to establishing the session with the unit,
this mode must be enabled through the front panel menu.

The remote terminal must be configured with serial settings that match the unit's serial port settings. For example, if the unit
is set at 9600 Baud, the remote terminal must be also configured as ASCII terminal at 9600 Baud, no parity, 8 bit data with 1
stop bit serial connection. The unit will not echo back any incoming characters, so local echo must be enabled on the remote
terminal.

To establish a remote control session with the unit, the user must type "UNIT#XXX" in the terminal window (all letters must
be in upper case), where XXX is the unit's unique network address or the global call address (255). Press the "Enter" key on
Remote Terminal keyboard.

The unit should answer with words "Unit#XXX OnLine" with the first menu screen on the following lines. After a remote
session is successfully established, the unit will stay connected as long as needed. The session interface mimics the unit's
front panel menu. To help the user navigate through the menu, the help string with the list of active keys always follows the
menu strings.

For example: "Active Keys:(U)p+Enter;(D)own+Enter;(C)lrearFlt; (M)enu+Enter; (E)nd+Enter" will be the last transmission
string on all informative menu screens. NOTE: All letters must be in upper case!

To refresh current screen on the Remote Terminal simply press "Enter" key. To end a session, press "E" and then the "Enter"
key.

  Important! If multiple units are networked on the same serial link, DO NOT ESTABLISH A SESSION WITH
MORE THAN ONE UNIT A TIME. If you do so you will not get a valid response!

The following procedure will guide the user through the remote terminal setup, using the Windows 95/98 HyperTerminal
software. The unit must be connected to a PC com port and configured to use TMSP with 9600 Baud rate prior to setting up
the PC configurations.

Start the Windows HyperTerminal Program (default Windows location at Programs - Accessories - HyperTerminal).

Enter the name of your serial connection ("Compact Outdoor SSPA" for example), and then click "Ok" button. See Figure 8.

Figure 8: HyperTerminal Connection Description

Select direct connection to the PC communication port (Com1 for example), which meant to be used for communication with
unit, and then click "OK" Button. See Figure 9.
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Figure 9: HyperTerminal Communication Port Selection

In the next window, select the following as shown in Figure 10:

1. Set Bits per Second to 9600;
2. Set Data bits to 8;
3. Set Parity to None;
4. Set Stop bits to 1;
5. Set Flow control to none.
6. Click the "OK" button.

Figure 10: HyperTerminal Communication Properties

Normally, the unit will not echo back characters typed by the user in a Terminal window. For added security and convenience,
turn on Local Echo in the HyperTerminal application. To do so, select the following from the HyperTerminal menu: File ?
Properties ? Settings ? ASCII setup. This will bring up a window similar to that shown in Figure 11. In this window, check the
box marked "Echo typed characters locally" and click "OK".
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Figure 11: HyperTerminal ASCII Setup

  NOTE: Due to a software bug on some versions, this feature may not work. Do not use versions prior to
6.3. Download the latest version of HyperTerminal at http://www.hilgraeve.com.

Your PC is now configured to work with the controller in Terminal mode. To establish a session with the controller, type
"UNIT#170"

  Note: When using a RS-485 connection, avoid using the global address (170). Instead, use the unique
RCP address.

An example of a terminal mode session shown on Figure 12.
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Figure 12: Terminal Mode Example
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Ethernet Interface

Overview

The RCP2 Ethernet port (J9) supports several IP network protocols to provide a full featured remote M&C interface over an
Ethernet LAN.

• IPNet protocol - redirection of standard Teledyne Paradise Datacom serial protocol over UDP transport layer
protocol. This protocol is fully supported in Teledyne Paradise Datacom's Universal M&C software.

• SNMPv1 protocol - This protocol intended for integration into large corporate NMS architectures.
• HTTP Web interface - This interface is designed to allow platform independent remote control function for a single

RCP2 unit.

In order to utilize either of the protocols listed above, the relevant interface option has to be turned on. Refer to the following
sections:

• IPNET Interface

• SNMP Interface

• Web Interface

Of course, standard IP level functions such as ICMP Ping and ARP are supported as well. There is currently no support for
dynamic IP parameters settings (DHCP).

IPNet Interface

General Concept

Satcom system integrators are recognizing the benefits of an Ethernet IP interface. These benefits include:

• Unsurpassed system integration capabilities;
• Widely available and inexpensive set of support equipment (network cable; network hubs);
• Ability to control equipment over Internet;
• Ease of use

Implementation of the raw Ethernet interface is not practical due to the limitations it places on M&C capabilities by the range
of a particular LAN. It is more practical to use an Ethernet interface in conjunction with the standard OSI (Open System
Interconnect) model to carry a stack of other protocols. In an OSI layered stack, an Ethernet interface can be represented as
a Data Link layer. All upper layers are resolved through a set of IP protocols. In order to keep data bandwidth as low as
possible (which is important when M&C functions are provided through a low-bandwidth service channel) the IP/UDP
protocol set is used as the Network/Transport layer protocol on Teledyne Paradise Datacom SSPAs.

UDP (User Datagram Protocol) was chosen over TCP (Transmission Control Protocol) because it is connectionless; that is,
no end-to-end connection is made between the unit and controlling workstation when datagrams (packets) are exchanged.

Teledyne Paradise Datacom provides a Windows ®-based control application to establish UDP-based Ethernet
communication with the unit. The control application manages the exchange of datagrams to ensure error-free
communication. An attractive benefit of UDP is that it requires low overhead resulting in minimal impact to network
performance. The control application sends a UDP request to unit and waits for response. The length of time the control
application waits depends on how it is configured. If the timeout is reached and the control application has not heard back
from the agent, it assumes the packet was lost and retransmits the request. The number of the retransmissions is user
configurable.

The Teledyne Paradise Datacom RCP2 Ethernet IP interface can use UDP ports from 0 to 65553 for sending and receiving.
The receiving port needs to be specified through the front panel menu. For sending, it will use the port from which the UDP
request originated. It is up to the user to select an appropriate pair of ports that are not conflicting with standard IP services.
Teledyne Paradise Datacom recommends usage of ports 1007, 1038 and 1039. These ports are not assigned to any known
application.

As an application layer protocol (which actually carries meaningful data), the standard RCP2 serial protocol was selected.
This protocol proves to be extremely flexible and efficient. It is also media independent and can be easily wrapped into
another protocol data frame. An example of the UDP frame with encapsulated Teledyne Paradise Datacom protocol frame is
shown on Figure 13.

Figure 13: UDP Frame
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This set of Ethernet IP protocols is currently supported by Teledyne Paradise Datacom Universal M&C package
(RCP2/FPRC/RCPD selection). The software is available for download from the web site, http://www.paradisedata.com.

Setting IPNet Interface

All IP-related menu items are consolidated under the following menu: Tap the Home icon to return to the main menu screen;
tap the Communication button; tap the IP Setup button.

Prior to enabling the Ethernet IP interface, the following IP parameters need to be set: IP Address, Gateway, Subnet Mask,
Local Port and Lock IP Address. The Lock IP address is a security measure. Setting this parameter either to 0.0.0.0 or
255.255.255.255 will allow any host to control the unit. Setting the parameter to the specific address of the remote host will
lock RCP2 access to this host. Packets received from other hosts will be ignored. For other parameters (IP Address,
Gateway, Subnet Mask, Local Port) contact your network system administrator.

  Important! If you are planning to access the unit through the Internet, you must exercise the appropriate
security measures. It is strongly recommended to put RCP2 units behind a protective Firewall or set up a
VPN link for remote access.

After selecting the IP parameters, you may turn on IP interfaces through front panel. Tap the Home icon to get to the main
menu; tap the Communication button; tap the Interface button; tick the IPNET checkbox.

Once the Ethernet Interface is selected, the RS232/485 Main port is disabled. IP settings may be adjusted when the IPNet
interface is turned on as needed without losing IP link. New settings will become effective only after a controller hardware
reset or power cycle (Tap "Home" > "Options" > "System" > "Reset" > "Comms Only" > "OK" to confirm reset).

To disable the Ethernet port and enable the RS232/485 port, tap the Home icon to access the main menu; tap the
Communication button; tap the Interface button; tick either the RS232 or RS485 checkbox.

  Important! At present, the controller supports one remote control protocol selection through its Ethernet
interface port. This protocol is referred to as "Normal" on the front panel display. If the protocol selection
is set to "Terminal", the controller will force its protocol selection to "Normal".

The Ethernet port can be connected to a network hub through straight through network cable or directly to a work station NIC
card through a null-modem or cross-over cable (Rx and Tx lines are crossed). As soon as an Ethernet interface has been
selected as the primary interface, you should be able to verify the network connection to the unit by using the Ping command
from your host workstation.

To do so on a Windows based PC, open a Command Prompt window and type PING and the dot delimited IP address of the
controller, then press the Enter key. If the unit is successfully found on the network, the request statistic will be displayed.

PING XXX.XXX.XXX.XXX

If the unit does not answer on the ping command, check all hardware connections and verify that the IP settings on your host
workstation and the controller match your network parameters. On a Windows-based PC you may also check ARP table
entries. The new IP address of the unit may be set to another PC or network equipment with a different MAC address. Open
a Command Prompt window and type "ARP -a", the press Enter. The current table will be displayed. If you see the unit IP
address entry in the table, delete it by issuing the command "ARP -d XXX.XXX.XXX.XXX" and press Enter
(XXX.XXX.XXX.XXX is the IP address of the unit). Now try the PING command again. More information about how to set up
a network connection with the unit can be found in the Ethernet Interface Set-Up and Cabling section.

Using the RCP2 Web Interface

Starting with firmware version 6.00, the RCP web interface no longer needs to have a pre-installed Java application to
operate. The web interface uses standard hypertext transfer protocol on port 80. The web interface is compatible with most
modern web browsers, such as Firefox, Chrome or Internet Explorer, which support asynchronous JavaScript XML
transactions (aka AJAX).

To connect to the controller internal web page, the user must make sure Web/IPNet interface is enabled on the device and
that an IP address has been assigned to the unit. Connect the unit to an Ethernet network or directly to a PC 10/100 Base-T
adapter and then open a web browser. Refer to the Setting IPNet Interface procedure of the Remote Control Interface
section.



Figure 14: Web Interface Screen

Enter the IP address of the unit into the address bar of the browser. A security login window will appear. In the User Name
field, enter admin, the default User Name. See Figure 15. The User Name is fixed and cannot be changed by the operator.

Figure 15: Web Interface Login Window

In the Password field, enter the web password assigned to the unit. The factory default password is paradise. The user
name and password are case sensitive. The password may be changed at any time and may comprise up to 15 alpha-
numeric characters.

Click on the [Log In] button to open the M&C control in the web browser (Figure 15).

To select another password, enter the following selection on the touchscreen: Tap the Home icon to return to the Main Menu;
tap the Communication button; tap the Interface button; tick the IPNet checkbox; tap the IP Setup button; tap the Web Pwd
button. Enter the new password using the keypad on the touchscreen. Tap the OK button to accept the entered password.

The top bar of RCP2 Monitor and Control application shows top level fault conditions: Power supply and unit faults as well as
Auxiliary fault status.

The left side of the window displays unit model and serial number, firmware build, device MAC address and device up time
since last I/O card power up or reboot. Additional information is displayed in multipage insert in the middle of the screen:

• Status: A view of all faults and operational parameters.
• Communication Settings: This tab provides access to all communication related settings. From here, the user can

change the IP settings, Interface, Protocol, Baud Rate, Password and SNMP settings.
• General Settings: Read/Write listing of most adjustable RCP parameters. All options are selectable. To set a

parameter, select the new value and click the "Confirm" button with the mouse pointer.
• HPA Control panel: All information and controls related to remotely control HPA system (if available)
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  Note: The web server has limited hardware resources to support multiple simultaneously connected
users. In the case that multiple users are connected to the same amplifier, service quality cannot be
assured.

SNMP Interface

Introduction

SNMP-based management was initially targeted for TCP/IP routers and hosts. However, the SNMP-based management
approach is inherently generic so that it can be used to manage many types of systems. This approach has become
increasingly popular for remote management and control solutions for various SSPA systems.

Teledyne Paradise Datacom devices with Ethernet interface support the most popular SNMPv1 format (SMIv1, RFC1155),
SNMP Get, SNMP GetNext and SNMP Set commands. SNMP Traps are currently unsupported in units with serial numbers
of 400000 and below.

In order to utilize SNMP protocol, the user has to enable this feature through the front panel or by remote serial protocol.
SNMP uses the UDP fixed port 161 for sending and receiving requests.

The definition of managed objects described in MIB. The MIB file is available for download from the Software Downloads
section of the Teledyne Paradise Datacom web site, http://www.paradisedata.com.

As with the serial protocol, the RCP2 MIB allows access to a remote SSPA (default state) as well as to the unit itself. To
switch between those devices' MIBs, the proper Device Type has to be selected (OID -1.3.6.1.4.1.20712.1.4).

The Teledyne Paradise Datacom MIB is a table-based MIB, and is the same for all devices. The MIB table is designed to
follow the same pattern as the tables for serial protocol. For additional information about OID values, refer to Table 11
through Table 13. The text values in the tables help automatic value parsing within NMS or make the values readable
through an MIB browser. All text value OIDs follow the same pattern:

1. For settings or parameters with discreet values:
SettingName'ValueName1=xxx, ..,ValueNamex=xxx
Example: ControlMode'Local=0,Remote=1

2. For settings or parameters with continuous values:
SettingName'LowLimit..HighLimit
Example: NetworkAddress'0..255

SNMP V3 Issues in Teledyne Paradise Datacom RCP2 Controller

Simple Network Management Protocol (SNMP) is an interoperable standards-based protocol that allows for external
monitoring of the Content Engine through an SNMP agent.

A SNMP-managed network consists of three primary components: managed devices, agents, and management systems. A
managed device is a network node that contains a SNMP agent and resides on a managed network. Managed devices
collect and store management information and use SNMP to make this information available to management systems that
use SNMP. Managed devices include routers, servers, switches, bridges hubs, computer hosts, and printers.

An agent is a software module that has local knowledge of management information and translates that information into a
form compatible with SNMP: the Management Information Base (MIB). The agent can send traps, or notification of certain
events, to the manager. Essentially, a Teledyne Paradise Datacom SSPA is considered a "SNMP agent".

A manager is a software module that listens to the SNMP notifications sent by SNMP agents. The manager can also send
requests to an agent to collect remote information from the Management Information Base (MIB).

The communication between the agent and the manager uses the SNMP protocol, which is an application of the ASN.1 BER
(Abstract Syntax Notation 1 with Basic Encoding Rules), typically over UDP (for IP networks).

Version 1 (SNMPv1, described in RFC 1157) is the initial implementation of SNMP.
Version 2 (SNMPv2c, described in RFC 1902) is the second release of SNMP. It provides additions to data types, counter
size, and protocol operations.
Version 3 (SNMPv3, described in RFC 2271 through RFC 2275) is the most recent version of SNMP.

SNMP V1

SNMP version 1 (SNMPv1) is the initial implementation of the SNMP protocol. SNMPv1 operates over protocols such as
User Datagram Protocol (UDP), Internet Protocol (IP), OSI Connectionless Network Service (CLNS), AppleTalk Datagram-
Delivery Protocol (DDP), and Novell Internet Packet Exchange (IPX). SNMPv1 is widely used and is the de-facto network-
management protocol in the Internet community.



The Teledyne Paradise Datacom RCP2 family of products utilizes the most popular implementation, SNMP V1 over UDP
transport layer.

SNMP V2

SNMPv2 (RFC 1441-RFC 1452) revises version 1 and includes some improvements in the areas of performance, security,
confidentiality, and manager-to-manager communications. It introduced GetBulkRequest, an alternative to iterative
GetNextRequests for retrieving large amounts of management data in a single request.

However, the new party-based security system in SNMPv2, viewed by many as overly complex, was not widely accepted.

The format of the trap message was also changed in SNMPv2. To avoid these compatibility issues, the trap mechanism was
not implemented in the Teledyne Paradise Datacom SSPA MIB.

SNMP V3

Although SNMPv3 makes no changes to the protocol aside from the addition of cryptographic security, it looks much different
due to new textual conventions, concepts, and terminology. SNMPv3 primarily added security and remote configuration
enhancements to SNMP. Many embedded controllers and microprocessors that are used in electronic components such as
amplifier modules do not have support for SNMP V2 or V3. This is due to the extensive memory resources required by the
computation intensive cryptographic security of SNMP V3.

For this reason V3 has not gained widespread support amongst embedded MCU platform manufacturers. Existing port
implementations are limited to very powerful ARM5 or above cores, running under full-scale OS systems (Linux, Android,
etc.). At large, these configurations require external bulk RAM/FLASH to operate. This requirement ultimately affects the
minimum device startup time (tens of seconds, due to the large boot BIOS) and working temperature range (mostly indoor).

As noted in Cisco's release notes about SNMP V3:

  SNMP notifications can be sent as traps or inform requests. Traps are unreliable because the receiver
does not send acknowledgments when this device receives traps. The sender cannot determine if the
traps were received. However, an SNMP entity that receives an inform request acknowledges the message
with an SNMP response protocol data unit (PDU). If the sender never receives the response, the inform
request can be sent again. Therefore, informs are more likely to reach their intended destination. However,
informs consume more resources in the agent and in the network. Unlike a trap, which is discarded as
soon as it is sent, an inform request must be held in memory until a response is received, or the request
times out. Traps are sent only once, while an inform can be retried several times. The retries increase
traffic and contribute to a higher overhead on the network.

(http://www.cisco.com/c/en/us/support/docs/ip/simple-network-management-protocol-snmp/13506-snmp-traps.html, last
visited on 19 March 2019.)

SNMP MIB Tree



--paradiseDatacom(1.3.6.1.4.1.20712) 
  | 
  +--deviceINFO(1) 
  |  | 
  |  +-- r-n OctetString deviceID(1) 
  |  +-- rwn OctetString deviceLocation(2) 
  |  +-- r-n OctetString deviceRevision(3) 
  |  +-- r-n Enumeration deviceType(4) 
  | 
  +--devices(2) 
     | 
     +--paradiseDevice(1) 
     |  | 
     |  +--settings(1) 
     |  |  | 
     |  |  +--settingsEntry(1) [settingIndex] 
     |  |     | 
     |  |     +-- rwn Integer32   settingIndex(1) 
     |  |     +-- rwn Integer32   settingValue(2) 
     |  |     +-- r-n OctetString settingTextValue(3) 
     |  | 
     |  +--thresholds(2) 
     |  |  | 
     |  |  +--thresholdsEntry(1) [thresholdIndex] 
     |  |     | 
     |  |     +-- rwn Integer32   thresholdIndex(1) 
     |  |     +-- r-n Integer32   thresholdValue(2) 
     |  |     +-- r-n Enumeration thresholdStatus(3) 
     |  |     +-- r-n OctetString thresholdText(4) 
     |  | 
     |  +--conditions(3) 
     |     | 
     |     +--conditionsEntry(1) [conditionsIndex] 
     |        | 
     |        +-- rwn Integer32   conditionsIndex(1) 
     |        +-- r-n Integer32   conditionsValue(2) 
     |        +-- r-n Counter     conditionsEventCount(3) 
     |        +-- r-n OctetString conditionsText(4) 
     | 
     +--paradiseDeviceA(2) 
     | 
     +--paradiseDeviceB(3) 
     | 
     +--paradiseDeviceC(4) 
     | 
     +--modem(5) 

Description of MIB Entities

deviceINFO - This field includes general device information.

deviceID - Octet string type; maximum length -60; field specifies device model and serial number; read only access; OID
-1.3.6.1.4.1.20712.1.1

deviceLocation - Octet string type; maximum length 60; filed allow customer to store information about device physical
location or any other textual information related to the device; read/write access; OID -1.3.6.1.4.1.20712.1.2

deviceRevision - Octet string type; maximum length 60; field specifies device firmware revision; read only access; OID
-1.3.6.1.4.1.20712.1.3

deviceType - Enumeration, integer type; field allows simple detection of SNMP device type. Values: rmsspa(1), cosspa(2),
rcp2fprc(3), rcp21000rm(4), rcp21000co(5), rcp21000rcp(6), buc(7), rbc(8), minicosspa(9); read/write access. Setting the ID
to any other value will default type to cosspa. OID -1.3.6.1.4.1.20712.1.4

devices - This field is subdivided into 5 branches: paradiseDevice, paradiseDeviceA, paradiseDeviceB, paradiseDeviceC
and modem. The paradiseDevice branch currently is used for all Paradise Datacom LLC SNMP enabled device except
Modem. See the Evolution Modem manual for specific MIB information for modems. Branches for Device A, B and C are
reserved for future use.

paradiseDevice - Field contents tables hold specific device information: Settings, Thresholds and Conditions. All table
formats follow a common pattern: Index, Value, TextValue. The threshold table has an additional column for parameter
validation. The conditions table has an extra column for event counters.

The Index column provides general table indexing; the Value column presents the current value of the relevant parameter;
the TextValue column provides information about parameter name, measurement units and limits.



Value "1" in the validation column of the thresholds table indicates that relevant parameter is valid under the current system
configuration; value "2" indicates that parameter is invalid or "Not available".

The event counter column of the conditions table indicates how many times a value of a relevant parameter changed its state
since system power-up.

settings - Table contains current device configuration and provides device management. For detailed settings table info for
SNMP device see Table 18 . Read/write access for settingsValue column.

thresholds - Table provides information about device internal limits and subsystems info. For detailed table information refer
to Table 19. Read only access.

conditions - Table contents device fault status information. Read only access. For detailed conditions table info see Table
20.

Table 18: SNMP Detailed Settings

settingIndex/
settingValue settingTextValue Value OID Description

1/INTEGER
SysMode'1:2=0,1:1=1,

1:1PhC1:1=2,Dual1:1=3,
SnglSw=4,PhC1:2=5

1.3.6.1.4.1.20712.2.1.1.1.2.1 System Operation Mode

2/INTEGER SwitchMode'Auto=0, Manual=1 1.3.6.1.4.1.20712.2.1.1.1.2.2 System Switching Mode

3/INTEGER ControlMode'Local=0, Remote=1 1.3.6.1.4.1.20712.2.1.1.1.2.3 System Control Mode

4/INTEGER Reserved'0..255 1.3.6.1.4.1.20712.2.1.1.1.2.4 Field reserved for factory use

5/INTEGER Priority'Pol1=0,Pol2=1 1.3.6.1.4.1.20712.2.1.1.1.2.5 Switching Priority

6/INTEGER Protocol'Normal=0, Terminal=1 1.3.6.1.4.1.20712.2.1.1.1.2.6 Remote Serial Control Protocol

7/INTEGER Baud'9600=0,2400=1,
4800=2,19200=3, 38400=4 1.3.6.1.4.1.20712.2.1.1.1.2.7 Baud Rate of Serial Interface

8/INTEGER NetworkAddress'0..255 1.3.6.1.4.1.20712.2.1.1.1.2.8 Unique Network Address

9/INTEGER Interface'RS232=0,
RS485=1,IPNet=2, SNMP=3 1.3.6.1.4.1.20712.2.1.1.1.2.9 Type of Remote Control

Interface

10/INTEGER FaultMonitor'SSPA=0,
LNA/LNB=1,Both=2, SerCom=3 1.3.6.1.4.1.20712.2.1.1.1.2.10 Type of Fault Monitoring

11/INTEGER AuxFaultMonitoring'Off=0,
NonSw=1,NoSwInv=2, Sw=3,SwInv=4 1.3.6.1.4.1.20712.2.1.1.1.2.11 Auxiliary Fault Monitoring

12/INTEGER RFSwitchFault'Major=0, Alert
Only=1,Alternate=2 1.3.6.1.4.1.20712.2.1.1.1.2.12 RF Switch Fault Monitoring

13/INTEGER FaultLatch'Enable=0, Disable=1 1.3.6.1.4.1.20712.2.1.1.1.2.13 Fault Latch

14/INTEGER FaultWindow'20%=0,
8%=1,12%=2,15%=3 1.3.6.1.4.1.20712.2.1.1.1.2.14 LNB/LNA Current Fault

Monitoring Window

15/INTEGER FaultLogic'FaultOnLow=0,
FaultOnHigh=1 1.3.6.1.4.1.20712.2.1.1.1.2.15 SSPA and Aux Fault Logic

16/INTEGER UserPassword'0..255 1.3.6.1.4.1.20712.2.1.1.1.2.16 User Password

17/INTEGER StandbyUnit'Default=0,
Unit1=1,Unit2=2, Unit3/combine=3 1.3.6.1.4.1.20712.2.1.1.1.2.17 Unit Standby Select

18/INTEGER Buzzer'On=0,Off=1 1.3.6.1.4.1.20712.2.1.1.1.2.18 Audible Alarm

19/INTEGER MenuPassword'On=0, Off=1 1.3.6.1.4.1.20712.2.1.1.1.2.19 Menu Password State

20/INTEGER
HPASysType'Off=0,CO=1,
RM=2,Path=3,VBUC=4,

SysX=5,PMAX=6
1.3.6.1.4.1.20712.2.1.1.1.2.20 Type of Optional SSPA

Subsystem

21/INTEGER RFPowerUnits'dBm=0, Watts=1 1.3.6.1.4.1.20712.2.1.1.1.2.21 Frwd/Reflected Power
Measurement Units

22/INTEGER Reserved'0..255 1.3.6.1.4.1.20712.2.1.1.1.2.22 Field reserved for factory use

23/INTEGER LNAPSRange'Low=0, High=1,Max=2 1.3.6.1.4.1.20712.2.1.1.1.2.23 LNA PS Output Voltage Range

24/INTEGER StdbyMode'Hot=0,Cold=1 1.3.6.1.4.1.20712.2.1.1.1.2.24 HPA Subsystem Standby Mode
Select



25/INTEGER SubsystemMute'On=0,
Pol1=1,Pol2=2,Off=255 1.3.6.1.4.1.20712.2.1.1.1.2.25 SSPA Subsystem Mute Control

26/INTEGER SubsystemAttenuation (dBx10)'0..200 1.3.6.1.4.1.20712.2.1.1.1.2.26 SSPA Subsystem Attenuation
Control

27/INTEGER SwitchMute'Off=0,
Internal=1,External=2, All On=3 1.3.6.1.4.1.20712.2.1.1.1.2.27 Switch Muting State

28/INTEGER Reserved'0..255 1.3.6.1.4.1.20712.2.1.1.1.2.28 Field reserved for factory use

29/INTEGER IPAddressByte1'0..255 1.3.6.1.4.1.20712.2.1.1.1.2.29 Device IP Address Byte1
(MSB)

30/INTEGER IPAddressByte2'0..255 1.3.6.1.4.1.20712.2.1.1.1.2.30 Device IP Address Byte2

31/INTEGER IPAddressByte3'0..255 1.3.6.1.4.1.20712.2.1.1.1.2.31 Device IP Address Byte3

32/INTEGER IPAddressByte4'0..255 1.3.6.1.4.1.20712.2.1.1.1.2.32 Device IP Address Byte4 (LSB)

33/INTEGER IPGateWayByte1'0..255 1.3.6.1.4.1.20712.2.1.1.1.2.33 Device Gateway Address
Byte1 (MSB)

34/INTEGER IPGateWayByte2'0..255 1.3.6.1.4.1.20712.2.1.1.1.2.34 Device Gateway Address
Byte2

35/INTEGER IPGateWayByte3'0..255 1.3.6.1.4.1.20712.2.1.1.1.2.35 Device Gateway Address
Byte3

36/INTEGER IPGateWayByte4'0..255 1.3.6.1.4.1.20712.2.1.1.1.2.36 Device Gateway Address
Byte4 (LSB)

37/INTEGER IPSubnetByte1'0..255 1.3.6.1.4.1.20712.2.1.1.1.2.37 Device Subnet Mask Byte1
(MSB)

38/INTEGER IPSubnetByte2'0..255 1.3.6.1.4.1.20712.2.1.1.1.2.38 Device Subnet Mask Byte2

39/INTEGER IPSubnetByte3'0..255 1.3.6.1.4.1.20712.2.1.1.1.2.39 Device Subnet Mask Byte3

40/INTEGER IPSubnetByte4'0..255 1.3.6.1.4.1.20712.2.1.1.1.2.40 Device Subnet Mask Byte4
(LSB)

41/INTEGER IPPortByte1'0..255 1.3.6.1.4.1.20712.2.1.1.1.2.41
Device Port Address Byte1

(MSB) (required only for IPNet
Interface)

42/INTEGER IPPortByte2'0..255 1.3.6.1.4.1.20712.2.1.1.1.2.42
Device Port Address Byte2

(LSB) (required only for IPNet
Interface)

43/INTEGER IPLockByte1'0..255 1.3.6.1.4.1.20712.2.1.1.1.2.43
Device IP Lock Address Byte1
(MSB) (required only for IPNet

Interface)

44/INTEGER IPLockByte2'0..255 1.3.6.1.4.1.20712.2.1.1.1.2.44
Device IP Lock Address Byte2

(required only for IPNet
Interface)

45/INTEGER IPLockByte3'0..255 1.3.6.1.4.1.20712.2.1.1.1.2.45
Device IP Lock Address Byte3

(required only for IPNet
Interface)

46/INTEGER IPLockByte4'0..255 1.3.6.1.4.1.20712.2.1.1.1.2.46
Device IP Lock Address Byte4
(LSB) (required only for IPNet

Interface)

47/INTEGER Unit_Offset1'0..255 1.3.6.1.4.1.20712.2.1.1.1.2.47 SSPA Unit 1 Attenuation Offset

48/INTEGER Unit_Offset2'0..255 1.3.6.1.4.1.20712.2.1.1.1.2.48 SSPA Unit 2 Attenuation Offset

49/INTEGER Unit_Offset3'0..255 1.3.6.1.4.1.20712.2.1.1.1.2.49 SSPA Unit 3 Attenuation Offset

Table 19: SNMP Detailed Thresholds

thresholdIndex/
thresholdValue thresholdTextValue Value OID Description

1/INTEGER LNA1CalibrationPoint
(x0.57mA)'0..4095 1.3.6.1.4.1.20712.2.1.2.1.2.1 LNA1 Current Fault

Threshold

2/INTEGER LNA2CalibrationPoint
(x0.57mA)'0..4095 1.3.6.1.4.1.20712.2.1.2.1.2.2 LNA2 Current Fault

Threshold



3/INTEGER LNA3CalibrationPoint
(x0.57mA)'0..4095 1.3.6.1.4.1.20712.2.1.2.1.2.3 LNA3 Current Fault

Threshold

4/INTEGER LNA1DCCurrent
(x0.57mA)'0..4095 1.3.6.1.4.1.20712.2.1.2.1.2.4 LNA1 PS Output Current

5/INTEGER LNA2DCCurrent
(x0.57mA)'0..4095 1.3.6.1.4.1.20712.2.1.2.1.2.5 LNA2 PS Output Current

6/INTEGER LNA3DCCurrent
(x0.57mA)'0..4095 1.3.6.1.4.1.20712.2.1.2.1.2.6 LNA3 PS Output Current

7/INTEGER LNA1PSVoltage (x0.1V)'0..4095 1.3.6.1.4.1.20712.2.1.2.1.2.7 LNA1 PS Output Voltage

8/INTEGER LNA2PSVoltage (x0.1V)'0..4095 1.3.6.1.4.1.20712.2.1.2.1.2.8 LNA2 PS Output Voltage

9/INTEGER LNA3PSVoltage (x0.1V)'0..4095 1.3.6.1.4.1.20712.2.1.2.1.2.9 LNA3 PS Output Voltage

10/INTEGER PS1Voltage (x0.1V)'0..4095 1.3.6.1.4.1.20712.2.1.2.1.2.10 PS1 Output Voltage

11/INTEGER PS2Voltage (x0.1V)'0..4095 1.3.6.1.4.1.20712.2.1.2.1.2.11 PS2 Output Voltage

12/INTEGER ChassyTemperature (C)'-99..99 1.3.6.1.4.1.20712.2.1.2.1.2.12 Chassis Temperature

Table 20: SNMP Detailed Conditions

conditionIndex/
conditionValue conditionTextValue Value OID

1/INTEGER Unit1FaultState'NoFault=0,Fault=1,N/A=2 1.3.6.1.4.1.20712.2.1.3.1.2.1

2/INTEGER Unit2FaultState'NoFault=0,Fault=1,N/A=2 1.3.6.1.4.1.20712.2.1.3.1.2.2

3/INTEGER Unit3FaultState'NoFault=0,Fault=1,N/A=2 1.3.6.1.4.1.20712.2.1.3.1.2.3

4/INTEGER SummaryFaultState'NoFault=0,Fault=1 1.3.6.1.4.1.20712.2.1.3.1.2.4

5/INTEGER PS1FaultState'NoFault=0,Fault=1 1.3.6.1.4.1.20712.2.1.3.1.2.5

6/INTEGER PS2FaultState'NoFault=0,Fault=1 1.3.6.1.4.1.20712.2.1.3.1.2.6

7/INTEGER AuxiliaryFaultState'NoFault=0, Fault=1,N/A=2 1.3.6.1.4.1.20712.2.1.3.1.2.7

8/INTEGER ExternalPortState'0..255 1.3.6.1.4.1.20712.2.1.3.1.2.8

9/INTEGER LNAFaults'0..255 1.3.6.1.4.1.20712.2.1.3.1.2.9

10/INTEGER SSPAFaults'0..255 1.3.6.1.4.1.20712.2.1.3.1.2.10

11/INTEGER RFSwitch1State'NoFault=0,
Fault=1,N/A=2,Pos1=3,Pos2=4 1.3.6.1.4.1.20712.2.1.3.1.2.11

12/INTEGER RFSwitch2State'NoFault=0,
Fault=1,N/A=2,Pos1=3,Pos2=4 1.3.6.1.4.1.20712.2.1.3.1.2.12

13/INTEGER ForwardRFLowByte(0xHLx0. 1RFPowerUnits)'0..255 1.3.6.1.4.1.20712.2.1.3.1.2.13

14/INTEGER ForwardRFHighByte(0xHLx0. 1RFPowerUnits)'0..255 1.3.6.1.4.1.20712.2.1.3.1.2.14

15/INTEGER AmbientTemperatureLowByte(0xHL C)'0..255 1.3.6.1.4.1.20712.2.1.3.1.2.15

16/INTEGER AmbientTemperatureHighByte(0xHL C)'0..255 1.3.6.1.4.1.20712.2.1.3.1.2.16

17/INTEGER Unit1TemperatureLowByte(0xHL C)'0..255 1.3.6.1.4.1.20712.2.1.3.1.2.17

18/INTEGER Unit1TemperatureHighByte(0xHL C)'0..255 1.3.6.1.4.1.20712.2.1.3.1.2.18

19/INTEGER Unit2TemperatureLowByte(0xHL C)'0..255 1.3.6.1.4.1.20712.2.1.3.1.2.19

20/INTEGER Unit2TemperatureHighByte(0xHL C)'0..255 1.3.6.1.4.1.20712.2.1.3.1.2.20

21/INTEGER Unit3TemperatureLowByte(0xHL C)'0..255 1.3.6.1.4.1.20712.2.1.3.1.2.21

22/INTEGER Unit3TemperatureHighByte(0xHL C)'0..255 1.3.6.1.4.1.20712.2.1.3.1.2.22

23/INTEGER ReflectedRFLowByte(0xHLx 0.1EFPowerUnits)'0..255 1.3.6.1.4.1.20712.2.1.3.1.2.23

24/INTEGER ReflectedRFHighByte(0xHLx 0.1EFPowerUnits)'0..255 1.3.6.1.4.1.20712.2.1.3.1.2.24

25/INTEGER Unit1DCCurrentLowByte(0xHLx 0.1Amper)'0..255 1.3.6.1.4.1.20712.2.1.3.1.2.25

26/INTEGER Unit1DCCurrentHighByte(0xHLx 0.1Amper)'0..255 1.3.6.1.4.1.20712.2.1.3.1.2.26

27/INTEGER Unit2DCCurrentLowByte(0xHLx 0.1Amper)'0..255 1.3.6.1.4.1.20712.2.1.3.1.2.27

28/INTEGER Unit2DCCurrentHighByte(0xHLx 0.1Amper)'0..255 1.3.6.1.4.1.20712.2.1.3.1.2.28



29/INTEGER Unit3DCCurrentLowByte(0xHLx 0.1Amper)'0..255 1.3.6.1.4.1.20712.2.1.3.1.2.29

30/INTEGER Unit3DCCurrentHighByte(0xHLx 0.1Amper)'0..255 1.3.6.1.4.1.20712.2.1.3.1.2.30

31/INTEGER Unit1RFOutputLowByte(0xHLx 0.1dBm)'0..255 1.3.6.1.4.1.20712.2.1.3.1.2.31

32/INTEGER Unit1RFOutputLowByte(0xHLx 0.1dBm)'0..255 1.3.6.1.4.1.20712.2.1.3.1.2.32

33/INTEGER Unit2RFOutputLowByte(0xHLx 0.1dBm)'0..255 1.3.6.1.4.1.20712.2.1.3.1.2.33

34/INTEGER Unit2RFOutputLowByte(0xHLx 0.1dBm)'0..255 1.3.6.1.4.1.20712.2.1.3.1.2.34

35/INTEGER Unit3RFOutputLowByte(0xHLx 0.1dBm)'0..255 1.3.6.1.4.1.20712.2.1.3.1.2.35

36/INTEGER Unit3RFOutputLowByte(0xHLx 0.1dBm)'0..255 1.3.6.1.4.1.20712.2.1.3.1.2.36

Configuring RCP2 Unit to Work With SNMP Protocol

Set up the unit IP address. Tap the Home icon to access the main menu; tap the Communication button; tap the IP Setup
button; tap the IP Address button. Enter the desired IP address. The default address of a single controller in a system is
192.168.0.9. Tap the OK button to accept the entered value.

Set up the unit gateway address. Tap the Gateway button; Enter the desitred IP address of the gateway. The default gateway
address of a single controller in a system is 192.168.0.1. If no gateway is needed, set the address to 0.0.0.0. Tap the OK
button to accept the entered value.

Set up the unit subnet mask. Tap the Subnet Mask button; Enter the desired Subnet Mask address. The default subnet mask
address of a single controller in a system is 255.255.255.0. Tap the OK button to accept the entered value.

Set up the unit Community Get string. Tap the Home icon to return to the main menu; tap the Communication button; tap the
SNMP Setup button. Tap the Community Get button; use the keypad to enter the desired Community Get string. The default
string is public. Tap the OK button to accept the entered value.

Set up the unit Community Set string. Tap the Community Set button; use the keypad to entered the desired Community Set
string. The default string is private. Tap the OK button to accept the entered value.

Set up the unit interface to communicate over SNMP. Tap the Home icon to return to the main menu; tap the Communication
button; tap the Interface button; tick the SNMP checkbox.

SNMP protocol now is set and ready to be used.

Connecting to a MIB Browser

For a MIB browser application example, we will use the freeware browser GetIf, version 2.3.1. Other browsers are available
for download from http://www.snmplink.org.

Copy the provided Paradise Datacom LLC MIB file into the Getif Mibs subfolder. The MIB is available for download at
http://www.paradisedata.com.

Start the GetIf application.

Select the unit IP address and community strings in the relevant text boxes on the Parameters tab (see Figure 16) and then
click the Start button.

http://stc-ppapp-web02/Intranet/xml/216351draft/images/getif-parameters.png
http://stc-ppapp-web02/Intranet/xml/216351draft/images/getif-parameters.png


Figure 16: Enter Parameters into GetIF

Select the MIBBrowser tab.

Click on 'iso main entity' on the MIB tree, then click the Start button.

See update data in output data box (Figure 17).

Figure 17: Update Data in MBrowser

The controller is equipped with a DigitalCore5 control board and utilizes firmware version 6.00 and above. These units
feature an extended SNMP MIB and support SNMP traps. This extended MIB covers several OID objects related to SNMP
trap functions.

These units allow independent functioning of two SNMP traps (asynchronous notifications): Fault trap and Conditions trap.
Both traps can be enabled or disabled by the operator. The operator can also specify how many times the same trap
notification will be sent back to the SNMP manager.

The SNMP manager IP address is also selectable by the operator. This IP address must be specified in the relevant OID
branch.

Every trap message is marked by the fixed trap community string "trap". This community name is not user selectable.

Fault Trap

The Fault trap allows asynchronous notification of the RCP2 fault state change. When enabled, trap notification will be sent
to a manager every time either the summary fault state or a fault type is changed.

The Last Fault Time ticks counter will be reset each time the summary fault changes its state to "Alarm" or when a new fault
condition is detected. This counter also resets itself during device power-up. If no faults are present after device power-up,
Fault Trap will issue a "Cold Start" notification to the manager.

Condition Trap

The Condition Trap allows the unit to generate asynchronous notifications independent from the unit fault state. Currently, the
following conditions can be used for this trap triggering: Forward RF Level (each remotely controlled HPA or System RF level
can be selected), Reflected RF Level (for systems equipped with a Reflected RF sensor), DC Current level (each remotely
controlled HPA can be selected), PS Voltage level (both internal PS units can be selected), Temperature (each remotely
control HPA can be selected or Ambient temperature sensor, if equipped), or LNA/LNB current.

To enable this trap, set the Condition Trap Resend option to a non-zero value and determine the upper and lower limits for
the condition window. Window values must be selected according to the relevant selected condition measured by the unit.

For example: Temperature must be selected in degrees, RF power in tenth of dBms, etc. After successful configuration, the
controller will generate a notification every time the selected condition is outside the selected measurement window. For
units with multiple measured parameters, the relevant condition location must be selected (i.e., units with two power supplies
use 1 for PS1, and 2 for PS2).

For other conditions, this value is "don't care". Both traps will send a "Device Up Time" time stamp with every trap
notification.

Extended SNMP MIB Tree

http://stc-ppapp-web02/Intranet/xml/216351draft/images/getif-mbrowser.png
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--paradiseDatacom(1.3.6.1.4.1.20712) 
| 
+--deviceINFO((1.3.6.1.4.1.20712.1) 
| | 
| +-- r-n OctetString deviceID(1.3.6.1.4.1.20712.1.1) 
| +-- rwn OctetString deviceLocation(1.3.6.1.4.1.20712.1.2) 
| +-- r-n OctetString deviceRevision(1.3.6.1.4.1.20712.1.3) 
| +-- r-n Enumeration deviceType(1.3.6.1.4.1.20712.1.4) 
| +--deviceTimeTicks(1.3.6.1.4.1.20712.1.5) 
| | | 
| | +-- r-n TimeTicks deviceUpTime(1.3.6.1.4.1.20712.1.5.1) 
| | +-- r-n TimeTicks deviceFaultTime(1.3.6.1.4.1.20712.1.5.2) 
| | 
| +--deviceCounters(1.3.6.1.4.1.20712.1.6) 
| | | 
| | +-- r-n Counter deviceSFaultCounter(1) 
| | 
| +--deviceFaultState(1.3.6.1.4.1.20712.1.7) 
| | | 
| | +-- r-n Enumeration deviceSummaryFault(1) 
| | +-- r-n Enumeration deviceLastFault(2) 
| | 
| +--deviceTrapedCondition(1.3.6.1.4.1.20712.1.8) 
| | | 
| | +-- r-n Integer32 deviceTrappedConditionValue(1) 
| | 
| +--deviceTrapControl(1.3.6.1.4.1.20712.1.9) 
| | | 
| | +-- rwn IpAddress deviceManagerIP(1) 
| | +-- rwn Integer32 deviceFaultsTrapResend(2) 
| | +-- rwn Integer32 deviceConditionTrapResend(3) 
| | +-- rwn Enumeration deviceConditionToMonitor(4) 
| | +-- rwn Integer32 deviceConditionULimit(5) 
| | +-- rwn Integer32 deviceConditionLLimit(6) 
| | +-- rwn Integer32 deviceConditionLocation(7) 
| | 
| +--deviceTraps(1.3.6.1.4.1.20712.1.10) 
| | 
| +-- (1.3.6.1.4.1.20712.1.10.0) 
| | 
| +--deviceFaultsTrap(1.3.6.1.4.1.20712.1.10.0.11) 
| [deviceUpTime,deviceSummaryFault,deviceLastFault] 
| | 
| +--deviceConditionTrap(1.3.6.1.4.1.20712.1.10.0.12) 
| [deviceUpTime,deviceConditionToMonitor,deviceTrappedConditionValue] 
+--devices(2) 
| 
+--paradiseDevice(1) 
| | 
| +--settings(1) 
| | | 
| | +--settingsEntry(1) [settingIndex] 
| | | 
| | +-- rwn Integer32 settingIndex(1) 
| | +-- rwn Integer32 settingValue(2) 
| | +-- r-n OctetString settingTextValue(3) 
| | 
| +--thresholds(2) 
| | | 
| | +--thresholdsEntry(1) [thresholdIndex] 
| | | 
| | +-- rwn Integer32 thresholdIndex(1) 
| | +-- r-n Integer32 thresholdValue(2) 
| | +-- r-n Enumeration thresholdStatus(3) 
| | +-- r-n OctetString thresholdText(4) 
| | 
| +--conditions(3) 
| | 
| +--conditionsEntry(1) [conditionsIndex] 
| | 
| +-- rwn Integer32 conditionsIndex(1) 
| +-- r-n Integer32 conditionsValue(2) 
| +-- r-n Counter conditionsEventCount(3) 
| +-- r-n OctetString conditionsText(4) 
| 
+--paradiseDeviceA(2) 
| 
+--paradiseDeviceB(3) 
| 
+--paradiseDeviceC(4) 



| 
+--modem(5)

Extended SNMP MIB Tree Elements in Detail

deviceRevision - Octet string type; maximum length 60; field specifies device firmware revision; read only access; OID
-1.3.6.1.4.1.20712.1.3

deviceUpTime - Device total up time in hundredths of a second; OID - 1.3.6.1.4.1.20712.1.5.1

deviceFaultTime - Time elapsed since last state change of deviceLastFault parameter in hundredths of second; OID -
1.3.6.1.4.1.20712.1.5.2

deviceSFaultCounter - Counts number of Summary alarms since device power up; OID - 1.3.6.1.4.1.20712.1.6.1

deviceSummaryFault - Enumerated value of device last detected fault condition. The following enumerated values are
possible: coldStart(1), overTemp(2), badRegltr(3), lowDCCur(4), aux(5), buc(6), lna(7), hpa(8), lowFwdRF(9), highRefRF(10),
nPlusOne (11), badPS(12), timeOut(13), other(14), noFaults(15). OID - 1.3.6.1.4.1.20712.1.7.1

deviceTrappedConditionValue - Condition value trapped by deviceConditionTrap; OID - 1.3.6.1.4.1.20712.1.8.1

deviceManagerIP - Trap recipient IP address; OID - 1.3.6.1.4.1.20712.1.9.1

deviceFaultsTrapResend - Defines how many times deviceFaultsTrap will repeat the message. 0 - Disables trap triggering;
OID - 1.3.6.1.4.1.20712.1.9.2

deviceConditionTrapResend - Defines how many times condition trap will repeat the message. 0 - Disables trap triggering;
OID - 1.3.6.1.4.1.20712.1.9.3

deviceConditionToMonitor - Enumerated value. Object defines which condition to trap. The following enumerations are
possible: fwdRF(1), dcCurrent(2), voltagePS(3), temperature( 4), lnaCur(5), refRF(6); OID - 1.3.6.1.4.1.20712.1.9.4

deviceConditionULimit - Conditions upper trap limit. Trap will be sent when the condition exceeds this limit. OID -
1.3.6.1.4.1.20712.1.9.5

deviceConditionLLimit - Conditions lower trap limit. Trap will be sent when condition falls below this limit. OID -
1.3.6.1.4.1.20712.1.9.6

deviceConditionLocation - Parameter specifying condition measuring location in device containing multiple location of the
same type (multiple PS, HPAs, LNAs etc.). Set to 0 for system-wide conditions, 1 .. n for relevant unit. For devices with single
condition location parameter is "don't care", for system wide parameters (System RF power, Ambient temperature etc. select
4). OID - 1.3.6.1.4.1.20712.1.9.7

deviceFaultsTrap - Trap fires deviceFaultsTrapResend times when deviceLastFault or deviceSummaryFault state changes.
OID - 1.3.6.1.4.1.20712.1.10.0.11
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Ethernet Interface Quick Set-Up

This section describes the procedure for setting up the RM SSPA Ethernet IP interface through the front panel interface. It
also describes basic network setup of a Windows-based host PC for a peer-to-peer network connection with the RM SSPA.

  Important! Do not use a crossover cable to connect to the network hub, use crossover only for direct PC-
to-RM SSPA connection!

Using a crossover null-modem network cable, connect the Ethernet Port (J9) of the RM SSPA to a host PC. See the 10/100
Base-T Ethernet Cable Wiring section for wiring details.

If the PC NIC card has not previously been set, do so now using the following procedure; otherwise skip to the Configure
Unit to Use IPNET Protocol section.

  Note: For PCs running earlier versions of Windows, go to the Control panel and open the Network
settings and open the TCP/IP properties of your LAN card. Pick up the procedure with Step 8.

1. On a PC running Windows 10, click on the Start icon.
2. Type "Settings" and open the Settings window.
3. Click on the Network & Internet icon.
4. Click Ethernet.
5. Click Change Adapter Options.
6. Right-click on the connection that you want to configure and select Properties from the menu.
7. Select Internet Protocol Version 4 (TCP/IPv4) and click on the Properties button.
8. Select "Use the following IP Address" and enter the parameters shown in Figure 1 in the IP Address and Subnet

Mask fields.

Figure 1: TCP/IPv4 Properties Window

IP Address.....:192.168.0.3
Subnet Mask.....:255.255.255.0

After you press "OK", depending on the operating system, you may need to reboot the workstation.

After optional reboot, open the Command Prompt console window and enter:



C:\>IPCONFIG

This will display the IP settings:

0 Ethernet Adapter:
IP Address: 192.168.0.3
Subnet Mask: 255.255.255.0
Default Gateway:

You can now try to Ping your PC. In Command Prompt window enter the following:

C:\>ping 192.168.0.3

This will display:

Pinging 192.168.0.3 with 32 bytes of data:
Reply from 192.168.0.3: bytes=32 time < 10ms TTL=128
Reply from 192.168.0.3: bytes=32 time < 10ms TTL=128
Reply from 192.168.0.3: bytes=32 time < 10ms TTL=128
Reply from 192.168.0.3: bytes=32 time < 10ms TTL=128
Ping statistics for 192.168.0.3:

Packets: Sent=4, Received=4, Lost=0 (0%loss),
Approximate round trip times I milli‐seconds:
Minimum=0ms, Maximum=0ms, Average=0ms

Your network LAN card is now set up.



Configure Unit to Use IPNET Protocol

Use the following procedure to configure your unit to operate using the IPNET protocol.

1. On the RM SSPA unit front panel, tap the Home icon to return to the Main Menu;
2. Tap the Communications button;
3. Tap the IP Setup button;
4. Tap the IP Address button;
5. Enter IP address 192.168.0.0;
6. Tap the OK button to accept the entered values.

Follow the same menu route to select the Subnet, Gateway, IP Port and IP Lock items, and set those parameters to:

Subnet:255.255.255.0;
Gateway:0.0.0.0; 
IPLock:255.255.255.255;
IPPort:1038. 

Verify that the values entered above are displayed in the Communications > IP Setup menu.

1. On the RM SSPA unit front panel, tap the Home icon to return to the Main Menu;
2. Tap the Communications button;
3. Tap the Interface button;
4. Tick the IPNET checkbox.

The RM SSPA is now set up to work with Ethernet Interface. You may now ping the SSPA unit from host PC:

C:\>ping 192.168.0.0

This will display:

Pinging 192.168.0.0 with 32 bytes of data:
Reply from 192.168.0.0: bytes=32 time < 10ms TTL=128
Reply from 192.168.0.0: bytes=32 time < 10ms TTL=128
Reply from 192.168.0.0: bytes=32 time < 10ms TTL=128
Reply from 192.168.0.0: bytes=32 time < 10ms TTL=128
Ping statistics for 192.168.0.3:

Packets: Sent=4, Received=4, Lost=0 (0%loss),
Approximate round trip times I milli‐seconds:
Minimum=0ms, Maximum=0ms, Average=0ms

Run the Paradise Datacom Universal M&C software on a host PC to check all M&C functions. When prompted, select an
Internet connection to the unit using IP Address 192.168.0.0, local port address to 1039 and remote port address to 1038.
The SSPA now connected to your host workstation for remote M&C.



10/100 Base-T Ethernet Cable Wiring

This section briefly describes the basic theory related to the physical layer of 10/100Bas-T networking, as well as proper
wiring techniques.

There are several classifications of cable used for twisted-pair networks. Recommended cable for all new installations is
Category 5 (or CAT 5). CAT 5 cable has four twisted pairs of wire for a total of eight individually insulated wires. Each pair is
color coded with one wire having a solid color (blue, orange, green, or brown) twisted around a second wire with a white
background and a stripe of the same color. The solid colors may have a white stripe in some cables. Cable colors are
commonly described using the background color followed by the color of the stripe; e.g., white-orange is a cable with a white
background and an orange stripe.

The straight through and crossover patch cables are terminated with CAT 5 RJ-45 modular plugs. RJ-45 plugs are similar to
those you'll see on the end of your telephone cable except they have eight versus four or six contacts on the end of the plug
and they are about twice as big. Make sure they are rated for CAT 5 wiring. (RJ means "Registered Jack"). A special Modular
Plug Crimping Tool (such as that shown in Figure 2) is needed for proper wiring.

Figure 2: Modular Plug Crimping Tool

The 10BASE-T and 100BASE-TX Ethernets consist of two transmission lines. Each transmission line is a pair of twisted
wires. One pair receives data signals and the other pair transmits data signals. A balanced line driver or transmitter is at one
end of one of these lines and a line receiver is at the other end. A simplified schematic for one of these lines and its
transmitter and receiver is shown in Figure 3.

Figure 3: Transmission Line

The main concern is the transient magnetic fields which surrounds the wires and the magnetic fields generated externally by
the other transmission lines in the cable, other network cables, electric motors, fluorescent lights, telephone and electric
lines, lightning, etc. This is known as noise. Magnetic fields induce their own pulses in a transmission line, which may literally
bury the Ethernet pulses.

The twisted-pair Ethernet employs two principle means for combating noise. The first is the use of balanced transmitters and
receivers. A signal pulse actually consists of two simultaneous pulses relative to ground: a negative pulse on one line and a
positive pulse on the other. The receiver detects the total difference between these two pulses. Since a pulse of noise
(shown in red in the diagram) usually produces pulses of the same polarity on both lines one pulse is essentially canceled by
out the other at the receiver. In addition, the magnetic field surrounding one wire from a signal pulse is a mirror of the one on
the other wire. At a very short distance from the two wires, the magnetic fields are opposite and have a tendency to cancel
the effect of each other. This reduces the line's impact on the other pair of wires and the rest of the world.

The second and the primary means of reducing cross-talk between the pairs in the cable, is the double helix configuration
produced by twisting the wires together. This configuration produces symmetrical (identical) noise signals in each wire.
Ideally, their difference, as detected at the receiver, is zero. In actuality, it is much reduced.

Pin-out diagrams of the two types of UTP Ethernet cables are shown in Figure 4.

Figure 4: Ethernet Cable Pin-outs



Note that the TX (transmitter) pins are connected to corresponding RX (receiver) pins, plus to plus and minus to minus. Use
a crossover cable to connect units with identical interfaces. If you use a straight-through cable, one of the two units must, in
effect, perform the crossover function.

Two wire color-code standards apply: EIA/TIA 568A and EIA/TIA 568B. The codes are commonly depicted with RJ-45 jacks
as shown in Figure 5.

If we apply the 568A color code and show all eight wires, our pin-out looks like Figure 6.

Figure 5: Ethernet Wire Color Code Standards

Figure 6: Wiring Using 568A Color Codes

Note that pins 4, 5, 7, and 8 and the blue and brown pairs are not used in either standard. Quite contrary to what you may
read elsewhere, these pins and wires are not used or required to implement 100BASE-TX duplexing.

There are only two unique cable ends in the preceding diagrams, they correspond to the 568A and 568B RJ-45 jacks and
are shown in Figure 7.

Figure 7: Wiring Using 568A and 568B Color Codes

Again, the wires with colored backgrounds may have white stripes and may be denoted that way in diagrams found
elsewhere. For example, the green wire may be labeled Green-White. The background color is always specified first.

To properly configure the cables, all you need to remember are the diagrams for the two cable ends and the following rules:

A straight-thru cable has identical ends.
A crossover cable has different ends.



It makes no functional difference which standard you use for a straight-thru cable. You can start a crossover cable with either
standard as long as the other end is the other standard. It makes no functional difference which end is which. A 568A patch
cable will work in a network with 568B wiring and a 568B patch cable will work in a 568A network.

Here are some essential cabling rules:

Try to avoid running cables parallel to power cables.
Do not bend cables to less than four times the diameter of the cable.
If you bundle a group of cables together with cable ties (zip ties), do not over-cinch them. It's okay to snug them
together firmly; but don't tighten them so much that you deform the cables.
Keep cables away from devices which can introduce noise into them, such as: copy machines, electric heaters,
speakers, printers, TV sets, fluorescent lights, copiers, welding machines, microwave ovens, telephones, fans,
elevators, motors, electric ovens, dryers, washing machines, and shop equipment.
Avoid stretching UTP cables (tension when pulling cables should not exceed 25 lbs.).
Do not run UTP cable outside of a building. It presents a very dangerous lightning hazard!
Do not use a stapler to secure UTP cables. Use telephone wire/RG-6 coaxial wire hangers, which are available at
most hardware stores.
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Introduction

This section describes the control of a remote unit using Teledyne Paradise Datacom's free Windows-based Universal
Monitor and Control software.



Download/Install Software

Teledyne Paradise Datacom provides a free version of its Universal Monitor and Control (M&C) Software available for
download from its web site. Install the software on a PC running Windows 7 or later.

Navigate to the Support > Downloads page and click on the latest version of the software to download the zip file.

Unzip the package and run the setup.exe file. This launches the Universal M&C Software installer. Follow the prompts and
agree to the license agreement to install the application. When complete, close the installer.

  By default the installer saves the software to C:\Program Files (x86)\Paradise Datacom. When running
the installer, you can change the destination of the installation.

The software may be used to remotely monitor and control any of the following Teledyne Paradise Datacom products:

• Rack mountable (RM) Amplifiers (3RU, 5RU, 7RU)

• Compact Outdoor (CO) Amplifiers

• High Power Outdoor (HPO) Amplifiers

• Indoor PowerMAX Amplifier Systems

• Outdoor PowerMAX Amplifier Systems

• System Controllers
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Add RM Unit to Universal M&C

Launch the Teledyne Paradise Datacom Universal M&C software from the Programs Menu of your PC. During installation, a
shortcut to the software may have been added to your desktop.

To add a new rack mountable amplifier, click the 'Action' menu and select 'Add Unit' from the pull-down menu. Select
'Rackmount' from the menu choices. See Figure 1.

Figure 1: Universal M&C > Action > Add Unit > Rackmount

An 'Add Rackmount SSPA' dialog window will appear.

Enter a Unit ID (not required although it is recommended). If a Unit ID isn't entered the Unit ID will be assigned by the M&C.

To add a unit connected to a serial port you must supply a Port and a Baud Rate. See Figure 2.

Figure 2: Select a COM Port and Baud Rate for Serial COMs

To add a unit connected via UDP (TCP/IP) you must supply either a Hostname or an IP Address. See Figure 3.
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Figure 3: Enter IP Address and Port Address for UDP COMs

Specify the Unit's unique address in the Amplifier Address box. If you don't know the address of the unit you may search for
it. Be aware that this search feature is only useful when you have only one unit connected to your PC at a time.

Choose a log file location by clicking the 'Browse...' button. The default is the "My Documents" folder. The log file name will
be the UnitID and the extension ".log" appended to it. i.e. "Unit1.log".

Click on the 'Create' button to connect to the unit. The Universal M&C software will open a new window from which you can
control and review the status of the connected unit.
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Overview of RM SSPA M&C

Each SSPA in the Rackmount M&C has six screens:

• Status Tab

• Settings Tab

• Faults Tab

• IP Setup Tab

• N+1 Settings Tab

• SNMP Tab

Status Tab

The first screen is the "Status" tab, shown in Figure 4. The Status tab shows the current conditions (or state) of the
connected SSPA. In addition, the Status tab allows the operator to change the Mute state of the carrier and allows
adjustment of the on-board attenuator for gain control.

Figure 4: Universal M&C Software > Status Tab

Settings Tab

The second screen is the "Settings" tab, shown in Figure 5. It shows the user all available settings on the SSPA. All user-
adjustable settings are allowed to be modified to suit the specific needs of the customer. However, it should be noted that the
SSPA is configured for the customer at the factory.

If modification of any settings is necessary, details of each setting, condition and threshold are available in the Settings,
Conditions and Thresholds description of the Remote Control Protocol section of any rack mountable amplifier manual.
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Figure 5: Universal M&C Software > Settings Tab

Operation Mode [1]

Select between Standalone Mode, (single unit), 1:1 Mode, 1:2 Mode, 1:1 Phase Combined or 1:2 Phase Combined.

If the amplifier will be configured in a redundant system and controlled with an external controller, each system amplifier
should be set to Standalone Mode.

If the amplifier will be configured in a redundant system but will be controlled using internal control logic, each system
amplifier should be set to the appropriate redundant mode. All amplifiers in the redundant system should be set to the same
mode.

For more information on settings used for internal 1:1 redundancy mode, see the Internal 1:1 Redundant System
Operation section.

For more information on settings used for internal 1:2 redundancy mode, see the Internal 1:2 Redundant System
Operation section.

Switch Mode [2]

Select between Automatic switching, Manual switching or Switch Lock.

Control Mode [3]

Select between Local or Remote control.

Fan Speed [4]

Select between Low, High or Auto.

Mute Enable [5]

Select Muted or Unmuted.

Protocol Select [6]

Select Normal or Terminal. The operator will be asked to verify any to change to the Protocol Select setting. Communication
with the amplifier may be affected.

Baud Rate [7]
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Select a baud rate of 2400, 4800, 9600 (the default), 19200, or 38400. The operator will be asked to verify any to change to
the Baud Rate setting. Communication with the amplifier may be affected.

Serial Interface [8]

Select the type of serial communications interface to use: RS232, RS485, IPNET or SNMP. The operator will be asked to
verify any to change to the Serial Interface setting. Communication with the amplifier may be affected.

Buzzer Enable [9]

Enable or Disable the audible buzzer on the unit.

Standby Mode [10]

Select Hot Standby or Cold Standby. In Cold Standby mode, the RF module is muted when its Standby Select setting is set
to Standby.

HPA Status [11]

Select HPA1, HPA2 or HPA3. For use in redundant systems.

RF Power Units [12]

Select the type of unit displayed on the front panel: dBm or Watts.

Standby Select [13]

Select the disposition of the amplifier in a redundant system: Standby or Online.

SSPA Attenuation [14]

The Gain Adjustment of the unit is adjustable here, from 0 to 20 in 0.1 dB steps.

Amplifier Address [15]

Sets a network address for the unit. Range is 0 to 255. Click the 'Change' button to change the address. The operator will be
asked to verify any to change to the Amplifier Address setting. Communication with the amplifier may be affected.

User Password [16]

Sets a password for the unit. Range is 0 to 255.

Menu Password Protection [17]

Enable or Disable password protection for the unit.

Priority Select [18]

For use in 1:2 Mode only. Assign whether the standby unit will be switched to Pol1 or Pol2 if the amplifiers transmitting to
both polarities exhibit failures and the standby unit must switch to one of the polarities. All units in a 1:2 configuration must
use the same Priority Select setting.

Fault Setups [19]

The user may Enable or Disable fault latching, and set the fault logic and handling for RF Switch faults, Auxiliary faults, BUC
faults, Forward RF faults and High Reverse RF faults. Logic settings are Logic Low or Logic High.

RF Switch Fault Handling settings include Ignore, Minor Fault, Major Fault, and Switchover Mute.

Auxiliary Fault Handling settings include Ignore, Minor Fault, Major Fault, Minor Fault with Mute, and Major Fault with Mute.

Forward RF Fault Handling settings include Ignore, Low RF Major Fault, Low RF Minor Fault, ALC On, High RF Major Fault,
High RF Minor Fault, and High RF Major Fault with Mute.

High Reverse RF Fault Handling settings include Ignore, Major Fault, and Minor Fault.

The user can also set the threshold levels for Forward RF and High Reverse RF.

Faults Tab



The third screen is the "Faults" tab, shown in Figure 6. It shows the user the status of all faults on-board the SSPA. These
include: Summary, Module # faults, Standby State (green = Online; red = Standby); Power Supply, Low DC Voltage and
Current, Fans, BUC, High Temperature, Forward RF and High Reflected RF, Auxiliary, switch faults (for units configured in a
redundant system), and optional faults.

Figure 6: Universal M&C Software > Faults Tab

Each RF Module in the SSPA is monitored for faults in addition to the SSPA itself. If the SSPA does not include a module,
non-existent modules will show up with a status of 'N/A' in the Module Status box, and the indicator will turn yellow.

IP Setup Tab

The fourth screen is the "IP Setup" screen, shown in Figure 7. It displays all of the TCP/IP settings on the SSPA.

Figure 7: Universal M&C Software > IP Setup Tab

When the IP Address is modified, the SSPA must be reset for it to use the new IP Address. Until the SSPA is reset, it will use
the old IP Address. The Local Port is the port that the SSPA uses for UDP requests. The SSPA also answers requests using
the same port. If the Local Port is changed, the SSPA must be reset.
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The Gateway Address and Subnet Mask are standard settings for TCP/IP communications. If either of these settings is
changed, the SSPA must be reset for the new settings to take effect.

The IP Lock Address is used for security. If it is set to something besides 0.0.0.0 or 255.255.255.255 it will only answer the
address it is set to. For example, if the IP Lock Address is 192.168.0.50, then a request from 192.168.0.100 will not be
accepted. The IP Lock Address may be changed without resetting the SSPA.

N+1 Settings Tab

The fifth window is the "N+1 Settings and Conditions" tab, as shown in Figure 8. This screen is used for setting N + 1 system
parameters, and monitoring N+1 system conditions. Note that only the master module in an N+1 system will show the N+1
Master settings.

Figure 8: Universal M&C Software > N+1 tab

See the Overview of the PowerMAX M&C section for more information on Master/Slave functions using the N+1 Settings
Tab.

SNMP Tab

The sixth window is the "SNMP Settings" tab, as shown in Figure 9. This screen is used for setting SNMP communication
parameters, and for assigning trap conditions.
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Figure 9: Universal M&C Software > SNMP tab
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Add CO Unit to M&C

Launch the Teledyne Paradise Datacom Universal Monitor and Control software from the Programs Menu of your PC. Upon
installation, a shortcut to the software may have been added to your desktop.

Click the 'Action' menu and select 'Add Unit' from the pull-down menu. Select 'Compact Outdoor SSPA' from the menu
choices. See Figure 10.

Figure 10: Universal M&C > Add Unit > Compact Outdoor SSPA

A new dialog window will open. Enter the following information where applicable: Unit ID; if using a RS-232 Connection, the
Serial Port and Baud Rate. See Figure 11.

Figure 11: Add Compact Outdoor SSPA > Serial Connection

If using an Ethernet Connection, enter the unit's IP Address and Port number. See Figure 12.
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Figure 12: Add Compact Outdoor SSPA > Internet Connection

Specify the unit's Address in the Amplifier Address box. If you don't know the address of the unit you may search for it. Be
aware that this search feature is only useful when you have only one unit connected to your PC at a time.

If you wish to change the log file location, click on the 'Browse' button and navigate to the desired location.

Click on the 'Create' button to generate the operation window for this unit.
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Overview of the CO M&C

The operational status, settings and conditions of the connected Compact Outdoor amplifier are displayed in the Universal
M&C application's four tabs:

• Status Tab

• Settings Tab

• IP Setup Tab

• SNMP Settings Tab

Status Tab

The Universal M&C Software will initialize and open to the Status tab, the main monitoring display. See Figure 13. The
Status tab shows the current conditions (or state) of the Compact Outdoor SSPA. In addition, the status screen allow the
user to alter the Mute condition of the carrier and adjust the on-board Attenuator for gain control.

Figure 13: Compact Outdoor SSPA > Status Tab

Upon connection with a unit, the M&C application obtains and displays the unit ID, the amplifier's model number and serial
number. The SSPA module's firmware version number is also displayed here for convenience.

The unit's network address and serial COM or IP address are also listed, which can be helpful in optimizing serial
communications.

Signal Indicators

Three rows of indicators show the connection status of the connected amplifier. Top-most is an indicator that displays a
green square when Connected, or a red square when Disconnected. Immediately below are two indicators for the TX and RX
paths. The third row displays the mute state (Carrier Enable). The operator may click on the indicator to toggle between
enabling or muting the amplifier. See Figure 14.
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Figure 14: Status Tab > Signal Indicators

Fault Status Indicators

The Fault Status frame in the lower left side of the Status tab contains a 3x4 grid of SSPA fault lights. See Figure 15.

Figure 15: Status Tab > Fault Status Indicators

• Summary Alarm: The Summary Alarm is simply a logical 'OR' of any major alarm indicators.
• Unit Online: This is a status indicator that illuminates green when the unit is online.
• External Mute Alarm: The External Mute line gives an indication that the SSPA has been externally muted by J4-

Pin B. This alarm can be configured to trigger a summary alarm if desired. Factory default is to signal a External
Mute fault but no summary alarm.

• Auxiliary & Spare Alarms: The Auxiliary and Spare Alarms are configurable from the Settings Window.

These alarms can be configured to trigger a summary alarm. See the Settings Tab section.

• Low DC Current Alarm: The Current Fault is factory preset to alarm if the SSPA module current falls below 60% of
its nominal value. This alarm will also trigger a summary alarm.

• Low DC Voltage Alarm: The Voltage Alarm is factory preset to alarm if the SSPA module current falls below 80% of
its nominal value. This alarm will also trigger a summary alarm.

• High Temperature Alarm: The Temperature Fault indicator is factory preset to alarm at 80°C. The amplifier will
continue to operate up to 90°C. Beyond 90°C the DC power will be interrupted to the SSPA module. This measure
will protect the sensitive microwave transistors from catastrophic failure. The fans and monitor and control circuitry
will continue to operate normally. This function has approximately a 5°C hysteresis window which will allow the
amplifier to re-enable itself when the ambient temperature is reduced by 5°C. This alarm will also trigger a
summary alarm.

• Forward RF Alarm: The Forward RF Fault Alarm indicates when the RF output of the amplifier falls below the
threshold set in the Settings Window.

• BUC Alarm: The BUC fault is only active in units that are supplied with an optional L-Band Block Up Converter
module. If the Up Converter's phase locked local oscillator loses lock, a BUC alarm is set and the amplifier is
muted so that spurious RF cannot be transmitted. This alarm can be configured to trigger a summary alarm.

• EEPROM Alarm: The EEPROM Alarm is primarily used as a Fiber RX Link alarm for Compact Outdoor SSSPA
units configured with a fiber-optic interface.

• RF Switch Alarms: The RF Switch 1 Alarm is only active if a 1:1 Redundant System has been configured in the
M&C program. The RF Switch 2 Alarm is only active is a 1:2 Redundant System has been configured. These
configurations are covered in Section 7.

Voltage, Current and Temperature Display

On the right side of the Status window is a thermometer display that reports the present baseplate temperature of the
amplifier. The baseplate temperature typically experiences a 20-30 degree rise above ambient on the highest power
Compact Outdoor amplifiers and 15-20 degree rise on lower power units. See Figure 16.
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Figure 16: Status Tab > Signal Indicators

To the left of the thermometer display are several indicators that show various operating conditions of the Compact Outdoor
Amplifier in real time. These indicators are helpful for any diagnostic procedures and consist of: Power Supply Voltage
monitor SSPA DC Current monitor Regulator Voltage monitor Gate Voltage monitor.

The Power Supply voltage indicator displays the primary 12 volt power supply output. SSPA DC Current is the total current
drawn by the microwave transistors. Regulator Voltage is the DC voltage of the drain circuitry that feeds the GaAs
transistors. The Gate Voltage indicator monitors the DC voltage of the gate circuitry of the microwave GaAs transistors.
These indicators provide direct access to the active device operating characteristics.

Gain Adjustment (Attenuation Control)

The Gain Attenuation Control is located above the Fault Condition Indicators and below the Carrier Enable status. See
Figure 17.

Figure 17: Status Tab > Attenuation Control

The gain can be adjusted by setting the Attenuation Control. An Attenuation Control of 0 dB is the maximum gain (typically
75 dB) setting on the amplifier. By setting the Attenuation Control to 20 dB; the gain is set to 55 dB. The Attenuation Control
can be varied using the up/down arrows to the right of the displayed value or by typing a value between 0 and 20 in the field
and hitting the Enter key.

Forward/Reflected RF Power Display

The Forward RF Power is displayed in the central part of the Operation window. This indicator reports the approximate
forward output power of the amplifier. It uses the voltage from the RF Power Detector to determine a corresponding power
level in dBm. The accuracy of the power indicator is ±1 dB at the mid-point of the specified band, with a single CW or QPSK
carrier.

Units with the reflected power meter option also display the Reflected RF Power. See Figure 18.

Figure 18: Status Tab > Forward/Reflected RF Power Display

Settings Tab

Figure 19 shows the Settings tab of the Universal M&C software. The Settings tab contains many of the global settings that
are available in the SSPA.

http://stc-ppapp-web02/Intranet/xml/216594/images/mc-status-power-temp-display.png
http://stc-ppapp-web02/Intranet/xml/216594/images/mc-status-power-temp-display.png
http://stc-ppapp-web02/Intranet/xml/216594/images/mc-status-attenuation.png
http://stc-ppapp-web02/Intranet/xml/216594/images/mc-status-attenuation.png
http://stc-ppapp-web02/Intranet/xml/216594/images/mc-status-fwd-refl-pwr-display.png
http://stc-ppapp-web02/Intranet/xml/216594/images/mc-status-fwd-refl-pwr-display.png


Figure 19: Compact Outdoor SSPA > Settings Tab

The Compact Outdoor amplifier will power up with the "last-state" settings before the unit was powered down. Whatever
attenuation setting or mute state the amplifier was in when powered down will be the restored settings when the amplifier is
powered back on.

Operation Mode [1]

Select between stand-alone (single unit), Dual 1:1 mode, 1:1 Redundant mode, or Maintenance Switch mode.

Hierarchical Address [2]

Identifies each amplifier in a redundant system as HPA 1, HPA2 or HPA 3.

Standby Select [3]

Selects whether the unit should start up as the online amplifier or the standby amplifier. When in a redundant system
configuration, if the amplifier Standby Select state is changed from the Online state to the Standby state, the system will
drive the switch so that another amplifier in the system is in the Online state. Only the Online amplifier can give away its
Online state. This setting is saved upon unit shut-down, and the unit will start up in the last saved state.

Mute State [4]

Determines if the unit should start up muted (transmit disabled) or mute cleared (transmit enabled).

Gain Control [5]

Select between serial communication control of the unit's gain or analog voltage gain control via J4.

Protocol Select [6]

The operator may select either the standard string protocol, Terminal mode, IPNET or SNMP (as well as legacy Binary Mode
and NDSatcom protocols). The operator will be asked to verify any change in protocol. Communication with the amplifier
may be affected.

Baud Rate Select [7]

Sets the baud rate of the unit. The supported baud rates include: 2400, 4800, 9600, 19200, and 38400 baud. The factory
default baud rate is 9600. The operator will be asked to verify any change to the baud rate. Communication with the amplifier
may be affected.
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Standby Mode [8]

Selects between Hot and Cold standby mode for units in redundant systems.

BUC Reference [9]

Selects between an Internal or External reference for an optional block up converter integrated with the unit, or allows the
unit to Auto-switch between Internal and External reference.

Fan Speed [10]

Selected GaN units are equipped with a Fan Speed Control option. The fan speed control circuit is shared with the RF power
detector analog output (pin R on M&C connector J4). This pin remains not connected on units with the fan speed control
option installed. Available control options: Auto, High, Low, Default/Off

• Auto - This setting allows the unit to control the cooling fan speed according to the internal RF module
temperature. If the module plate temperature remains below 50 °C, the fan speed will be set to minimum. If the
registered module plate temperature is above 50 °C, unit will gradually increase the fan speed. Fan speed will
reach maximum at a plate temperature of 65 °C.

• High - This option sets the fan speed to maximum. Air velocity will remain at the same level regardless of other
operation parameters.

• Low - This option sets the fan speed to minimum. Air velocity will remain at the same level regardless of other
operation parameters.

• Default/Off - This setting should be set on units without the fan speed control option. It will allow proper functioning
of the RF power monitor analog output. Applying this setting on units with the fan speed control option allows the
fan speed to be proportional to the output RF level. Fan speed will be set at the minimum when output RF is below
a detectable level. Fan speed will gradually increase when RF output increases within the detectable RF range.
Fan speed will be at maximum level when unit reaches saturated power (Psat).

Gain Calibration Mode [11]

This feature is disabled for most users. Should be set for Temp. Comp. (Temperature Compensation) Mode. Consult the
factory if set for Calibration Mode.

Attenuation Level [12]

The Gain Adjustment of the unit is adjustable here, from 0 to 20 in 0.1 dB steps.

Amplifier Address [13]

Sets a network address for the unit. Range is 0 to 255. Click the 'Change' button to change the address. The operator will be
asked to verify any to change to the Amplifier Network Address. Communication with the amplifier may be affected.

Low Current Fault (Slave) [14]

This feature is not available on all units. Consult the factory.

Switch Mute [15]

This is a read-only view of the Switch Mute setting. Higher power amplifiers which include a maintenance switch or are
configured in a system which includes a transfer switch may be set to mute on switch (setting = On) at the factory.

Spare Fault Wizard [16]

This feature allows the user to set the Spare Fault Trigger using the Spare Fault Wizard.

Click on the Spare Fault Wizard button, which opens a new window. See Figure 20. Select between the following fault
triggers: Analog Gain Adjust Voltage, Gate Voltage, Regulator Voltage, Power Supply Voltage, SSPA Current, External Mute,
or None.



Figure 20: Spare Fault Wizard

Set the range of thresholds (maximum and minimum) that would trigger the selected fault, and configure the fault handling
via a pull-down menu (Major Fault, Minor Fault, Major Fault plus Mute).

Click the OK button to set the fault trigger for the Spare Fault.

Fault Setups [17]

The user may also adjust the Spare, Auxiliary, BUC, and Forward RF Fault Status and Handling via the appropriate pull-
down menus on the Settings Window.

• Spare/Auxiliary/BUC/Forward RF Fault Handling: Selects whether the associated fault should be a major or minor
fault, and whether the fault should mute the unit. A minor fault will trigger a Spare/Auxiliary/BUC/Forward RF Fault
alarm but not trigger a Summary Fault. A major fault will trigger both an Spare/Auxiliary/BUC/Forward RF Fault and
a Summary Fault.

• Spare/Auxiliary/BUC Fault Status: Determines if the associated fault input should be ignored or enabled based on
the available selections.

• Forward RF Threshold: Allows the user to assign the threshold at which a Forward RF Fault will be triggered.

Fault Thresholds [18]

Allows the user to set the limit for triggering the unit's Current Fault or High Temperature Fault.

• High Temperature Alarm Threshold: Range is 0 to 125 °C.
• Low Current Fault Threshold: This setting is factory pre-set.

  Take care not to adjust the High Temperature Alarm Threshold within the temperature range of the
amplifier's normal operation. Doing so will trigger unneccessary high temperature alarm faults.

IP Setup Tab

If the user wishes to set up the networked Compact Outdoor SSPA with custom IP settings, the internal IP settings need to
be modified. Click on the IP Setup Tab. See Figure 21.
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Figure 21: Compact Outdoor SSPA > IP Setup Tab

In this window, the user may enter custom IP settings, including the IP Address of the unit, the Gateway Address, the Subnet
Mask and the Local Port.

The IP Lock Address allows the operator to set the IP address from which the amplifier will accept requests. This selection
gives the operator the ability to increase the security measure for the IPNet protocol. The SSPA will only answer a request
which comes from the assigned IP address.

To disable this feature in firmware versions prior to 6.00, set the Lock IP Address value to 0.0.0.0 or 255.255.255.255. The
Lock IP address function was updated in firmware version 6.00 to allow "Binding" and "Masking" functions. "Binding" means
that the first datagram re-trieved for this socket will bind to the source IP address and port number. Once binding has been
set, the SSPA will answer to the bound IP source until the unit is restarted or reset. Without binding, the socket accepts
datagrams from all source IP addresses. Address 0.0.0.0 allows all peers, but provides binding to the first detected IP
source; Address 255.255.255.255 accepts all peers, without binding. If the Lock IP Address is a multicast address, then the
amplifier will accept queries sent from any IP address of the multicast group.

Click on the 'Change IP Settings' button to save the entered settings into non-volatile memory.

The user may also modify the web password used when accessing the web-based remote M&C. Tick the 'Modify Web
Password' checkbox to enable the New Password field. Enter a new password and click on the 'Change' button to save.

Using Custom IP Settings with Quick Start Cable

If the Quick Start Cable is connected to Port J4 when power is applied to the amplifier, it will use the default settings.

Default Settings with Quick Start Cable Connected:

Interface: IPNET 
IP Address: 192.168.0.9 
Local Port: 1007 
Gateway: 192.18.0.1 
Subnet Mask: 255.255.255.0 
IP Lock: 255.255.255.255 
Web password: paradise 
Read Community: public 
Write Community: private 
Unit Starts Up: Unmuted

To use custom IP settings while using the Quick Start cable, remove power from the amplifier.

Unplug the Quick Start cable from the M&C connector, J4. (If the unit is restarted with the Quick Start cable connected, it will
always come up with default IP settings).
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Connect power to the SSPA.

Connect the Quick Start cable to J4, and check connectivity with the custom IP settings. Make sure that the Protocol setting
in the Settings tab of the Universal M&C is set to IPNet.

If custom IP settings will be used in normal operation, the user will need to construct an IP cable or modify the Quick Start
Cable by disconnecting the interface control pins (pins j and e, Baud Select 0 and Baud Select 1) from ground.

In this configuration, the SSPA will always use the saved communication control settings rather than the default
configuration.

SNMP Settings Tab

The SNMP Settings Tab allows the operator to change the Read/Write Community strings and the Trap settings (if
communicating over SNMP protocol). See Figure 22

Figure 22: Compact Outdoor SSPA > SNMP Settings Tab

The current Read/Write Community strings are displayed as read from the connected unit. Tick the Modify Read/Write
Community checkbox to enable the New Read/Write Community field. Enter a new password and click on the 'Change'
button to save.
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Add HPO Unit to M&C

Launch the Teledyne Paradise Datacom Universal Monitor and Control software from the Programs Menu of your PC. Upon
installation, a shortcut to the software may have been added to your desktop.

Click the 'Action' menu and select 'Add Unit' from the pull-down menu. Select 'High Power Outdoor SSPA' from the menu
choices. See Figure 23.

Figure 23: Universal M&C > Add Unit > High Power Outdoor SSPA

A new dialog window will open. Enter the following information where applicable: Unit ID; if using a RS-232 Connection, the
Serial Port and Baud Rate. See Figure 24.

Figure 24: Add High Power Outdoor SSPA > Serial Connection

If using an Ethernet Connection, enter the unit's IP Address and Port number. See Figure 25.
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Figure 25: Add High Power Outdoor SSPA > Internet Connection

Specify the unit's Address in the Amplifier Address box. If you don't know the address of the unit you may search for it. Be
aware that this search feature is only useful when you have only one unit connected to your PC at a time.

If you wish to change the log file location, click on the 'Browse' button and navigate to the desired location.

Click on the 'Create' button to generate the operation window for this unit.
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Overview of the HPO M&C

The H-Series High Power Outdoor SSPA uses the same protocol as the Compact Outdoor SSPA, and also the same
structure of Universal M&C.

See the Overview of the CO M&C section when using the software with a High Power Outdoor SSPA.



Add Indoor PowerMAX System to M&C

Launch the Teledyne Paradise Datacom Universal M&C software from the Programs Menu of your PC. Upon installation, a
shortcut to the software may have been added to your desktop. An Indoor PowerMAX system requires Universal M&C
version 4.4.8b or later.

Add Each RM SSPA to M&C

Each individual amplifier in the PowerMAX System should first be added to the Universal M&C. Follow the instructions
detailed in the Add RM Unit to Universal M&C section.

PowerMAX systems are typically configured with four, eight or 16 amplifiers.

Set the N+1 Settings for each individual unit to include the Array Size (four, eight or 16) for the PowerMAX System and the
unique Priority Address for each unit. The amplifier assigned with the lowest Priority Address (typically 1) is granted the
Master status for the N+1 system, and controls the other (Slave) amplifiers in the system.

Add PowerMAX System to M&C

To add the PowerMAX System, click the 'Action' menu and select 'Add Unit' from the pull-down menu. Select 'N+1 System'
from the menu choices. See Figure 26.

Figure 26: Universal M&C > Add Unit > N+1 System

A new 'Add N+1 System' dialog window will appear, as shown in Figure 27. If the individual amplifier N+1 settings were
properly set, the Unit #s should automatically populate in ascending Priority Address order, using the Unit ID entered in the
M&C. Otherwise, select the Unit # for each unit in the system and enter a System Name in the field at the bottom of the
window. Click on the 'OK' button to initialize the system.
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Figure 27: Add N+1 System Selection Window

  The System window may take several moments to load as the software collects and compiles the data
from each unit in the system.
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Overview of the Indoor PowerMAX M&C

The N+1 System tab displays an overview of each unit in the system, and overall system performance. The Universal M&C
screen shown in Figure 28 displays the N+1 system tab (labeled PowerMAX System), as well as tabs for each of the eight
(8) SSPA units (labeled 1, 2, 3, 4, 5, 6, 7 and 8) being monitored.

Figure 28: N+1 System Tab

For each unit in the system, the PowerMAX System tab displays the unit's serial number, comms status, master/slave state,
N+1 priority in the system, mute state and fault state.

Also shown are the System Forward Power, Reflected Power, System Gain and number of System Faults. A checkbox at the
lower right of the window allows the user to quickly enable or disable the Auto Gain function. See the Auto Gain description
in the Touchscreen Menu Structure section.

By hovering the mouse over the individual unit buttons, as shown in Figure 29, the unit's conditions are detailed.

Figure 29: N+1 System Tab > Unit Info on Hover
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Clicking on the Unit # button to switch to the Status tab for that unit. You may also click on the unit's tab to navigate to the
M&C windows for that unit.

The N+1 tab for each unit shows the N+1 settings for that unit. Depending on whether the unit is assigned Master status or
Slave status, the N+1 screen will show slightly different information. Figure 30 shows the display for the Master unit.

Figure 30: N+1 Tab > Master Unit

Figure 31 shows the display for the Slave units.

Figure 31: N+1 Tab > Slave Unit

http://stc-ppapp-web02/Intranet/xml/216594/images/mc-nplus1-master.png
http://stc-ppapp-web02/Intranet/xml/216594/images/mc-nplus1-master.png
http://stc-ppapp-web02/Intranet/xml/216594/images/mc-nplus1-slave.png
http://stc-ppapp-web02/Intranet/xml/216594/images/mc-nplus1-slave.png


Add Outdoor PowerMAX System to M&C

The Outdoor SSPA Controllers in an Outdoor PowerMAX system can be monitored by the Universal M&C Application. All
information is read-only.

The operator must load each of the Outdoor SSPA Controllers individually. Refer to Table 1 for the default IP addresses to
use.

Table 1: Outdoor SSPA Controllers, IP Addresses for Universal M&C

Controller ID IP Address

Outdoor SSPA Controller 1 (Master) 192.168.0.11

Outdoor SSPA Controller 2 (Slave) 192.168.0.12

Launch the Teledyne Paradise Datacom Universal Monitor and Control software from the Programs Menu of your PC. Upon
installation, a shortcut to the software may have been added to your desktop.

With the system operating, select the Action pull-down menu, select Add Unit, and select Outdoor PowerMAX Controller Box.
See Figure 32.

Figure 32: Universal M&C > Add Unit > Outdoor PowerMAX Controller Box

A new dialog window will open. Select the Internet connection. See Figure 33.
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Figure 33: Add Outdoor PowerMAX Controller Box

Enter the Unit ID text that will be used to identify the unit in the M&C application. For example, "Master SSPA 1" for
Controller 1.

Enter the IP address of the Master or Slave unit . Refer to Table 1.

Use the default port 1007, or change to reflect the local network.

Enter the global address (255) in the Amplifier Address field, and click on the [Search for Unit] button. The utility will locate
the unit on the network. See Figure 34. Click on the [OK] button.

Figure 34: Dialog Window, Search for Outdoor Controller Box

Click on the [Create] button to open the M&C windows.

Repeat for each Outdoor SSPA Controller.
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Overview of the Outdoor PowerMAX M&C

This section describes the information available in each of the Universal M&C screens for the Outdoor SSPA Controllers
used in Outdoor PowerMAX systems.

Status Window for Outdoor SSPA Controllers

The Status Window for the Outdoor SSPA Controllers (Controller 1, typically the Master controller) shows the operational
status of the array of four (4) SSPA modules for that system. See Figure 35.

Figure 35: Status Window, Outdoor SSPA Controllers

This window displays the Mute status (Carrier Enable, indicated by "Enabled", if unmuted, or "Muted"), Attenuation and
Summary Fault status LED. Also included is information about the System Forward RF Power, Reverse RF Power, SSPA
Core Temperature, Main Supply Voltages, DC Current and Booster Supply Voltages.

  Note: Changes to Mute Status and Attenuation made in this window will be overwritten by the system.

Settings Window for Outdoor SSPA Controllers

The Settings Window, shown in Figure 36, is common for all controllers, and is used to select the operation settings for the
unit.
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Figure 36: Settings Window, Outdoor SSPA Controllers

See your system manual for the required settings for each controller.

  Note: All settings are read-only. Changes made to settings in this window will be overwritten by the
system.

Faults Window for Outdoor SSPA Controllers

The Faults Window, shown in Figure 37, is common for all controllers, and is used to monitor the various fault conditions for
the SSPA Modules connected to the unit.

Figure 37: Faults Window, Outdoor SSPA Controllers

Table 2 shows how the fault LEDs in this window correspond with the SSPA Modules for the indicated Outdoor Controller.

Table 2: Identifying SSPA Module Faults in Universal M&C Faults Window

Module # Fault LED SSPA Module
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Module 1 for the Faults Window of Controller 1 SSPA 1.1

Module 2 for the Faults Window of Controller 1 SSPA 1.2

Module 3 for the Faults Window of Controller 1 SSPA 1.3

Module 4 for the Faults Window of Controller 1 SSPA 1.4

Module 1 for the Faults Window of Controller 2 SSPA 2.1

Module 2 for the Faults Window of Controller 2 SSPA 2.2

Module 3 for the Faults Window of Controller 2 SSPA 2.3

Module 4 for the Faults Window of Controller 2 SSPA 2.4

IP Setup Window for Outdoor SSPA Controllers

The IP Setup Window is common for all controllers, and is used to adjust the IP settings for the connected unit. The IP
Address, Gateway Address, Subnet Mask, Local Port and IP Lock Address may all be modified. See Figure 38. Changes to
these settings require a unit restart before they are applied.

Figure 38: IP Setup Window, Outdoor SSPA Controllers

In addition, the operator may modify the read/write community and web passwords. The operator must check the box to
unlock the field for the new password, then click on the [Change] button to implement the change.
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Add RCP Unit to M&C

Launch the Universal M&C software. Click on the Action menu and select "Add Unit", then choose "Controller" from the pull-
down menu. See Figure 39.

Figure 39: Universal M&C, Add New Controller Unit

A new dialog window will appear. See Figure 40. Select the method of communication (Serial Connection, Internet
Connection, or SNMP).

Figure 40: Add Controller (Serial, Internet or SNMP Connection)

For Serial Connections, select the Serial Port and Baud Rate, and select the amplifier address. If you don't know the address
of the unit you may search for it. Click the Search for Unit button.

For Internet Connection, enter the IP address of the unit, and select the port and amplifier address. Click the Search for Unit
button if you don't know the address of the unit.

  Note: The Search for Unit feature is only useful when you have only one unit connected to your PC at a
time.

For SNMP, enter the IP address of the unit and the community read/write passwords.

The default Community Read password is public.

The default Community Write password is private.

A Unit ID is not required although it is recommended. If a Unit ID isn't entered the Unit ID will be assigned by the M&C. Click
the Create button to open the M&C windows.

Choose a log file location by clicking the Browse... button. The default is the "My Documents" folder. The log file name will be
the UnitID and the extension ".log" appended to it. i.e. "Unit1.log".

Click on the Create button to open the M&C windows.
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Overview of the RCP2 M&C

The Universal M&C user interface features five screens which are used to monitor and control the system.

• Status

• IP Setup

• Conditions

• Settings

• HPA Control Panel

Status Tab

The first screen is the "Status" window shown in Figure 41.

Figure 41: Universal M&C, Status Tab

The status screen reflects the Online/Standby status of each amplifier in the system, and the switch position of each
waveguide switch in the system. In addition, Internal and Device fault indicators are displayed. When there is no fault
condition on a given unit, the indicator illuminates green. When a fault condition exists, the indicator illuminates red.

  Note that in Figure 41 above, there is an RF Switch Fault. The RF Switch fault indicator is illuminated red
in the Internal Faults panel, and the RF Switch State in the mimic panel shows "Faulted". In addition, the
baseball switch icons are colored red to indicate a switch fault.

The user may click on one of the triangular amplifier icons to set that amplifier as the Standby unit in the system.

IP Setup Window

The second screen is the "IP Setup" window, shown in Figure 42.

http://stc-ppapp-web02/Intranet/xml/216594/216594-2.xml#216594-2.14.1
http://stc-ppapp-web02/Intranet/xml/216594/216594-2.xml#216594-2.14.1
http://stc-ppapp-web02/Intranet/xml/216594/216594-2.xml#216594-2.14.2
http://stc-ppapp-web02/Intranet/xml/216594/216594-2.xml#216594-2.14.2
http://stc-ppapp-web02/Intranet/xml/216594/216594-2.xml#216594-2.14.3
http://stc-ppapp-web02/Intranet/xml/216594/216594-2.xml#216594-2.14.3
http://stc-ppapp-web02/Intranet/xml/216594/216594-2.xml#216594-2.14.4
http://stc-ppapp-web02/Intranet/xml/216594/216594-2.xml#216594-2.14.4
http://stc-ppapp-web02/Intranet/xml/216594/216594-2.xml#216594-2.14.5
http://stc-ppapp-web02/Intranet/xml/216594/216594-2.xml#216594-2.14.5
http://stc-ppapp-web02/Intranet/xml/216594/images/mc-status.png
http://stc-ppapp-web02/Intranet/xml/216594/images/mc-status.png


Figure 42: Universal M&C IP Setup Window

It shows the user all of the TCP/IP settings on the unit. When the IP Address is modified the unit must be reset for it to use
the new IP Address. Until the unit is reset it will use the old IP Address. The Amplifier Local Port is the port that the unit
monitors for UDP requests. The unit also answers requests using the same port.

If the Amplifier Local Port is changed the unit must be reset. The Gateway Address and Subnet Mask are standard settings
for TCPI/IP communications. If either of these settings is changed the unit must be reset for the new settings to take effect.
The IP Lock Address is used for security. If it is set to something besides 0.0.0.0 or 255.255.255.255 it will only answer the
address it is set to. For example, if the IP Lock Address is 192.168.0.50 then a request from 192.168.0.100 will not be
accepted. The IP Lock Address may be changed without resetting the unit.

Conditions Window

The third screen displays the Conditions of the units connected to the controller, as shown in Figure 43.

Figure 43: Universal M&C, Conditions Window

The system forward power, reflected power, power supply voltages and LNA/LNB currents and temperatures are all
monitored. In addition, the calibration points of each LNA/LNB are displayed.
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Settings Window

The fourth screen is the "Settings" screen, shown in Figure 44.

Figure 44: Universal M&C, Settings Window

It shows the user all available settings on the unit. All user-adjustable settings may be modified to suit the specific needs of
the customer. However, it should be noted that the units are pre-configured for the customer at the factory. If modification of
any settings is necessary, refer to the Table 7 of the Remote Control Interface section.

HPA Control Panel Window

The fifth screen is the "HPA Control Panel" screen, shown in Figure 45.

Figure 45: Universal M&C, HPA Control Panel Window

From this window, the user may select the type of amplifier used in the system, choose the RF power units displayed, mute
or unmute the system, and set the attenuation levels of the system or individual amplifier offsets. The user may also monitor
the forward RF, temperature and DC current conditions of the HPA subsystem.
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Universal M&C Advanced Features

Universal M&C Preferences

The user can adjust certain preferences of the Universal Monitor and Control software. Click on the Action pull-down menu
and select Preferences. See Figure 46.

Figure 46: Universal M&C > Action > Preferences

Queries

Click on the Queries icon at left to open the Query Settings menu. Select the PC Source Address. Adjust the interval that the
software queries the unit. Tick the Queries Enabled checkbox to begin sending queries to the connected unit. Note that if
queries are disabled, there will be no communication with the unit at startup. Untick the bottom checkbox to disable
commands on units set to Local Control Mode. See Figure 47.

Figure 47: Universal M&C Preferences > Queries

Logs

Click on the Logs icon at left to open the Log Settings menu. Adjust the interval that selected parameters are recorded (in
minutes or seconds). Tick the checkbox to enable logging. See Figure 48.

http://stc-ppapp-web02/Intranet/xml/216594/images/mc-action-preferences.png
http://stc-ppapp-web02/Intranet/xml/216594/images/mc-action-preferences.png
http://stc-ppapp-web02/Intranet/xml/216594/images/mc-pref-queries.png
http://stc-ppapp-web02/Intranet/xml/216594/images/mc-pref-queries.png


Figure 48: Universal M&C Preferences > Logs

TCP/IP

Click on the TCP/IP icon at left to open the TCP/IP Settings menu. Select the Local UDP Port (the software must be
restarted to take effect). Note that each UDP address must be unique. Default Unit UDP Port is 1007. See Figure 49.

Figure 49: Universal M&C Preferences > TCP/IP

Appearance

Click on the Appearance icon at left to open the Appearance menu. Set the transparency of the M&C Windows. A setting of 0
indicates no transparency. Maximum value is 80. See Figure 50.

Figure 50: Universal M&C Preferences > Appearance

Startup
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Click on the Startup icon at left to open the Startup menu. Tick the checkbox to enable auto-loading of the last-used device
configuration. See Figure 51.

Figure 51: Universal M&C Preferences > Startup

Using the Device Logger

The Universal Logger may be used to show a real-time log of selected parameters. Before opening the logger, at least one
unit must be connected and added to the Universal M&C. To open the Logger, click on the Action pull-down menu and select
'Logging...' as shown in Figure 52.

Figure 52: Universal M&C Action > Logging...

The Device Logger will open, as seen in Figure 53.
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Figure 53: Universal M&C Device Logger Window

Click on the 'Add/Remove' button, which opens a new window as shown in Figure 54. Select the desired device in the
Available Devices pull-down menu. Individually select which parameters to log (or remove unwanted parameters).

Figure 54: Universal M&C Device Logger > New Log Items Window

After choosing the parameters, the Logger window will be similar to Figure 55. Click on the Done button to accept the list of
selected parameters.
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Figure 55: Universal M&C Device Logger > New Log Items > Items Selected

You may modify the log interval by entering the number of seconds between each record. Default interval is 1 second. Click
on the Start Logging button to begin logging the selected parameters.

Figure 56: Universal M&C Device Logger > Start Logging

Click on the 'File' menu and select 'Print' to print the graph and legend as shown in Figure 56. You may stop, start, and clear
the data at any time.

  While running the Logger, you may continue to use the Universal M&C to monitor the status of or make
settings modifications to any connected unit.

Saving M&C Configurations
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The Universal M&C allows users to save multiple configurations to a variety of units. In addition, the software features a
'Load Last Configuration' option that will reload the last configuration used by the M&C.

Save a Single Configuration

To save a single configuration, add the desired units to the Universal M&C and select 'Save Configuration' from the 'File'
menu. See Figure 57. After saving, a confirmation message will appear that states the success of the save. This saved
configuration may be reloaded even after a computer restart. It is important to note that the Universal M&C will occasionally
perform this save automatically.

Figure 57: Universal M&C File > Save Configuration

To be certain the proper configuration is saved, select 'Save Configuration As...' from the 'File' menu, and navigate to a
directory to which the file will be saved. You may wish to name the file with descriptive text about the connected unit.

Load the Last Configuration

To load the last configuration, select 'Load Last Configuration' from the 'File' menu. See Figure 58. The M&C will load
whatever unit(s) were previously loaded. You may set the Universal M&C Preferences to automatically load the last
configuration used by the Universal M&C software when the software is run. See the Startup Preferences section.

Figure 58: Universal M&C File > Load Last Configuration

Load a Configuration from a File

To load a specific configuration from a file, select 'Load Configuration from File...' from the 'File' menu. Select the location of
the file as shown in Figure 59. Click the Open button to load the configuration to the Universal M&C.
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Figure 59: Universal M&C File > Load Configuration from File
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Use and Disclosure of Data

This product is classified as EAR99 and is subject to U.S. Department of Commerce regulations. Export, reexport or
diversion contrary to U.S. law is prohibited.



Proprietary and Confidential

The information contained in this document is the sole property of Teledyne Paradise Datacom. Any reproduction in part or
as a whole without the written permission of Teledyne Paradise Datacom is prohibited.

Information in this document is subject to change without notice.

All other company names and product names in this document are property of the respective companies.



Data Security

Teledyne Paradise Datacom amplifiers and controllers do not inherently provide encryption to transmitted data, and have
limited security measures to protect it. If the unit will be accessible over the Internet, exercise appropriate data security
protocols. Teledyne Paradise Datacom strongly recommends placing the equipment behind a protective Firewall or setting up
a VPN link with dual authentication for remote access.



About Teledyne Paradise Datacom

Teledyne Paradise Datacom, a division of Teledyne Defense Electronics LLC, is a single source for high power solid state
amplifiers (SSPAs), Low Noise Amplifiers (LNAs), Block Up Converters (BUCs), and Modem products. Operating out of two
primary locations, Rancho Cordova, CA, USA, and Chelmsford, England, Teledyne Paradise Datacom has more than a 20
year history of providing innovative solutions to enable satellite uplinks, battlefield communications, and cellular backhaul.

Teledyne Paradise Datacom
11361 Sunrise Park Drive
Rancho Cordova, CA 95742 USA
(814) 238-3450

Teledyne Paradise Datacom Ltd
106 Waterhouse Lane
Chelmsford, Essex, England, CM1 2QU
+44(0)1245 847520
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